INTRODUCTION

This document is for Consultant and State Employees responsible for the production or review of digital contract plans, specifications, supplemental contract documents, and contractor submittals. This document covers the development, review and commenting, and submission of digitally signed contract plans in PDF format including revisions, the delivery of specifications in Microsoft Word format, the delivery of supplemental contract documentation in PDF format, and the delivery of contractor submittals in PDF format. This manual also includes sections on the usability of these PDF documents.

Questions or inquiries regarding the subject matter can be forwarded to the following contacts:

William Pratt P.E.
Transportation Principal Engineer
AEC Applications
william.pratt@ct.gov
860.594.3320

Bruce Bourgoin P.E.
Transportation Supervising Engineer
AEC Applications
bruce.bourgoin@ct.gov
860.594.2760

Mathew Calkins P.E.
Transportation Engineer
AEC Applications
mathew.calkins@ct.gov
860.594.2988

Revision History
Table of Contents

| DEFINITIONS | DIGITAL DOCUMENT REQUIREMENTS .................................................................................................................. 6 |
| SECTION 1  | Document Deliverable ........................................................................................................................................ 7 |
|            | Projectwise Project Container ......................................................................................................................... 8 |
|            | Prerequisites and Policies ................................................................................................................................. 8 |
|            | Form ................................................................................................................................................................. 9 |
|            | 1.4.1 Contract Plans ...................................................................................................................................... 9 |
|            | 1.4.2 Contract Specifications ........................................................................................................................... 11 |
|            | 1.4.3 Environmental Permits – Under Development ....................................................................................... 12 |
|            | 1.4.4 Supplemental Documents ........................................................................................................................ 12 |
|            | 1.4.5 Contractor Submittals .............................................................................................................................. 12 |
|            | 1.4.6 Engineering Reports ............................................................................................................................... 12 |
|            | 1.4.7 GIS Project Location Documents ........................................................................................................ 13 |
|            | 1.4.8 ROW (Rights of Way) Documents ........................................................................................................... 13 |
|            | 1.4.9 Project Correspondence .......................................................................................................................... 13 |
|            | 1.5 This Section Intentionally Left Blank ........................................................................................................ 13 |
|            | 1.6 Contract Plan Drawing and Sheet Numbering ........................................................................................... 13 |
|            | 1.6.1 Drawing Number .................................................................................................................................... 13 |
|            | 1.6.2 Final Plan Page Labels and Sheet Numbers ........................................................................................ 14 |
|            | 1.6.3 Addendum and Design Initiated Change Order Page Labeling and Sheet Numbers ................................ 18 |
|            | 1.7 CTDOT For Information Only Sheets ......................................................................................................... 20 |
|            | 1.8 CTDOT Standard Sheets ............................................................................................................................ 21 |
|            | 1.9 Contract Plan Sheet Publishing ................................................................................................................ 22 |
|            | 1.10 Example: Typ. Single Volume Digital Contract ..................................................................................... 23 |
|            | 1.11 Example: Multiple Volume Digital Contract .......................................................................................... 24 |
|            | 1.11.1 Combining Multiple Projects ................................................................................................................ 25 |
|            | 1.12 Consolidating Contract Plan Discipline Subsets ...................................................................................... 25 |
|            | 1.12.1 When a Set File is Created and Updated ................................................................................................ 25 |
|            | 1.12.2 Creating a Set File .................................................................................................................................. 26 |
|            | 1.12.3 Updating a Set File .................................................................................................................................. 32 |
| SECTION 2  | DIGITAL SIGNATURES FOR CONTRACT AND OTHER ENGINEERING DOCUMENTS .............................................. 37 |
|            | 2.1 Graphic Image of Signature ........................................................................................................................ 38 |
|            | 2.1.1 Contract Plans ....................................................................................................................................... 38 |
|            | 2.1.2 Engineering Reports ............................................................................................................................... 39 |
|            | 2.1.3 Working Drawings .................................................................................................................................... 41 |
|            | 2.1.4 Other Documents .................................................................................................................................... 42 |
|            | 2.2 Creating Graphic Image of Signature: ......................................................................................................... 43 |
|            | 2.2.1 In House CTDOT or Non-Professional Engineering Signature: ............................................................. 43 |
|            | 2.2.2 For Consultant Staff PE Stamp: .............................................................................................................. 43 |
|            | 2.3 Setting Digital Signature Appearance Preferences: .................................................................................. 44 |
|            | 2.4 Watermarking Plans with Graphic Image of Signature: ............................................................................. 46 |
|            | 2.5 Digital Signature Fields ............................................................................................................................ 48 |
|            | 2.5.1 Bluebeam - Creating Digital Signature Form Fields ............................................................................... 49 |
|            | 2.6 Applying Digital Signatures ....................................................................................................................... 50 |
|            | 2.6.1 Applying Digital Signatures to 01_General Subset (FDP and Addendum Subsets) .................................... 51 |
|            | 2.6.2 Applying a Digital Signatures to 02_Revisions Subset ........................................................................ 53 |
|            | 2.6.3 All Other Discipline Subsets - Single Signature .................................................................................. 54 |
|            | 2.6.4 Standard Drawing Subsets – Single Signature ...................................................................................... 54 |
|            | 2.6.5 All Other Discipline Subsets – Multi-Signatures ................................................................................ 54 |
|            | 2.6.6 Working Drawings .................................................................................................................................... 55 |
|            | 2.6.7 Engineering Reports ............................................................................................................................... 55 |
|            | 2.7 Applying Digital Signature Workflows ...................................................................................................... 56 |
| SECTION 3  | PROJECTWISE AND SUBMITTING DOCUMENTS TO CTDOT .............................................................................. 60 |
|            | 3.1 Discipline Subset PDF Checker ................................................................................................................ 60 |
|            | 3.1.1 Installing the PDF Checker ...................................................................................................................... 61 |
|            | 3.1.2 Typical Workflow for using the PDF Checker ....................................................................................... 61 |
|            | 3.1.3 Using the PDF Checker ............................................................................................................................ 62 |
|            | 3.2 Projectwise ................................................................................................................................................ 64 |
|            | 3.2.1 ProjectWise .......................................................................................................................................... 64 |
|            | 3.2.2 Projectwise Folders for Contract Documents ...................................................................................... 65 |
|            | 3.2.3 Uploading Documents - ProjectWise (Thin Client) ................................................................................ 67 |
|            | 3.2.4 Uploading Documents – Projectwise (Thick Client) .............................................................................. 69 |
|            | 3.2.5 Combining and Uploading Contract Specifications and CSI Special Provisions .................................... 71 |
|            | 3.2.6 Uploading Supplemental Contract Documents ..................................................................................... 72 |
|            | 3.2.7 CTDOT Contracts Finalizing of Contract Specifications ........................................................................ 73 |

Issued 04-2016 3 Version 3.13
DEFINITIONS

ACD – The attribute applied to a revision requested by the Processing unit to an ADP discipline subset.

ACD2 – The attribute applied to a revision requested by the Processing unit to an ACD discipline subset.

ADP – The attribute applied to an Addendum discipline subset.

Bluebeam – PDF software similar to Adobe Acrobat. Bluebeam software will be required to package and markup all Shop Drawing Submittals.

CSI – Construction Specifications Institute

DCD – The attribute applied to a revision requested by the Processing unit to an FDP discipline subset.

DCD2 – The attribute applied to a revision requested by the Processing unit to a DCD discipline subset.

Discipline Subset – A multi-page PDF document that includes all the contract plan sheets for a discipline. Example would be all the structures sheets would be packaged in (1) multi-page PDF document.

DCO – The attribute applied to a design initiated change order discipline subset.


Engineer of Record – The engineer’s digital signature that is applied to the discipline subsets. For CTDOT staff this would be the Principal Engineer.

FDP – The attribute applied to a final design plans discipline subset.

FIO – The attribute applied to a “for information only” discipline subset.

FPL – The attribute applied to an advertised FDP discipline subset

Project Manager – Lead designer on the project. For CTDOT staff this would be the TE 3 or Supervisor of the lead discipline or consultant liaison TE3 or Supervisor.

ProjectWise - CTDOT is currently using Bentley’s ProjectWise as a data management software for digital projects. Projectwise allows the CTDOT, and authorized business partners to access its data anywhere internet access is available. Projectwise shall be used by all consultant engineers delivering digital contract documents.

Set File – Is a consolidated viewer file that is created using Bluebeam. When this file is opened all of the contract plans, FDP, Addendum, Change Orders, are sorted by their page labels and the correct order.

STD – The attribute applied to the “CTDOT Standard Drawings” discipline subsets.

WDP – The attribute applied to working drawing for permanent structures submittals. This includes the plans, calculations, or any supplemental documents in the submittal.
## Section 1 Digital Document Requirements

### 1.1 Document Deliverable

The following documents shall be submitted into Projectwise when delivering a digital project, see Section 3 of this document for submittal procedures for the documents below: For CTDOT designed projects each discipline is responsible for uploading their own documents into Projectwise.

<table>
<thead>
<tr>
<th>Document</th>
<th>Projectwise Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPI Form – Link for Video of Process: <strong>PPI Video</strong> or <strong>Document Workflow</strong></td>
<td>04.00 - Engineering Libraries\PPI Requests</td>
</tr>
<tr>
<td>Final Contract Plans</td>
<td>100_Contract Plans</td>
</tr>
<tr>
<td>Final Signed Contract</td>
<td>110_Contract Documents</td>
</tr>
<tr>
<td>Contractor Submittals:</td>
<td>120_Contractor Submittals</td>
</tr>
<tr>
<td>• Working Drawings (Permanent and Temporary Structures)</td>
<td></td>
</tr>
<tr>
<td>• Shop Drawings</td>
<td></td>
</tr>
<tr>
<td>• Product Data</td>
<td></td>
</tr>
<tr>
<td>• RFI</td>
<td></td>
</tr>
<tr>
<td>• RFC</td>
<td></td>
</tr>
<tr>
<td>Engineering Reports:</td>
<td>130_Engineering Reports</td>
</tr>
<tr>
<td>• Hydraulic</td>
<td></td>
</tr>
<tr>
<td>o Hydraulic Report and Hydraulic Report Data</td>
<td></td>
</tr>
<tr>
<td>o Scour Report and Scour Report Data</td>
<td></td>
</tr>
<tr>
<td>o Floodway Report and Floodway Report Data</td>
<td></td>
</tr>
<tr>
<td>o Final Drainage Report and Final Drainage Report Data</td>
<td></td>
</tr>
<tr>
<td>• Geotechnical Report</td>
<td></td>
</tr>
<tr>
<td>• Environmental Compliance</td>
<td></td>
</tr>
<tr>
<td>o Task 110</td>
<td></td>
</tr>
<tr>
<td>o Task 220</td>
<td></td>
</tr>
<tr>
<td>o Underground Storage Tank System Closure Reports</td>
<td></td>
</tr>
<tr>
<td>• Bridge</td>
<td></td>
</tr>
<tr>
<td>o Load Ratings</td>
<td></td>
</tr>
<tr>
<td>Executed Agreements:</td>
<td>140_Project Administration</td>
</tr>
<tr>
<td>• Sidewalk Maintenance Agreement</td>
<td></td>
</tr>
<tr>
<td>• Lighting Agreement</td>
<td></td>
</tr>
<tr>
<td>Bridge</td>
<td></td>
</tr>
<tr>
<td>• Rehabilitation Study Reports</td>
<td></td>
</tr>
<tr>
<td>• Structure Type Studies</td>
<td></td>
</tr>
<tr>
<td>Project Schedule</td>
<td>140_Project Administration</td>
</tr>
<tr>
<td>Project Correspondence – Signed Copies of the Files</td>
<td>140_Project Administration</td>
</tr>
<tr>
<td>ROW Documents</td>
<td>150_GIS</td>
</tr>
<tr>
<td>• Property Map (.dgn)</td>
<td></td>
</tr>
<tr>
<td>• Property Map (PDF)</td>
<td></td>
</tr>
<tr>
<td>• ROW Parcel Files (.dgn and KML)</td>
<td></td>
</tr>
<tr>
<td>Project Photos (Engineering and Construction)</td>
<td>151_Project Photos</td>
</tr>
<tr>
<td>Design Quantity Computations</td>
<td>210_Construction&gt;Office of Construction</td>
</tr>
<tr>
<td>Supplemental Contract Documents</td>
<td>240_Contract Development</td>
</tr>
<tr>
<td>• Proposal Estimate</td>
<td></td>
</tr>
<tr>
<td>• Federal Estimate</td>
<td></td>
</tr>
</tbody>
</table>
1.2 Projectwise Project Container

CTDOT uses Bentley's Projectwise as a document management system for all of our capital projects. A project container will be created in Projectwise when a project is initiated. CTDOT employees will have access to all projects, but access for consultants, municipalities or other agencies must be requested by the Consultant Liaison Engineer. The Consultant Liaison Engineer can request access for these groups by emailing: Julie.Annino@ct.gov.

1.3 Prerequisites and Policies

1. All contract plans, working drawings, and applicable engineering reports submitted to the Department shall be digitally signed by a CT licensed Engineer or CT licensed Architect in accordance with this manual. All contract plans, specifications, and supplemental contracts documents will only be accepted by the CTDOT if they meet all the requirements of this manual. Approval for additional development and testing of digital documents and procedures shall come from the AEC Applications.

2. Digital contract plans, in the following stages: Final Design Plans (FDP), Design Completion Data (DCD), Addenda, Addenda Completion Data (ACD), Design Initiated Change Order (DCO), and Working Drawing (WDP) and all engineering reports shall be digitally signed in conformance with this manual.
   a. Digital signatures must meet the requirements of Adobe's Certified Document Services (CDS) or Adobe Approved Trusted List (AATL).
   b. CDS, and CDS vendor information is provided at the following website: [http://www.adobe.com/security/partners_cds.html](http://www.adobe.com/security/partners_cds.html)
   c. AATL and AATL vendor information is provided at the following website: [https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html](https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html)
   d. Trial CDS/AATL Signatures will not be accepted by the Department, a signature must be purchased from one of the CDS/AATL Vendors.
   e. Bluebeam Revu or Extreme is required for all digital signature processes.

3. After contract plans have been advertised, the digital signature is not allowed to be removed.


5. Use of digital signatures not conforming to the requirements of this manual must be approved by both the Office of Quality Assurance, and the Office of Legal Services.
6. This manual is designed to be used with the latest CTDOT Digital Design Environment.
7. Digital Contract Specifications shall be prepared in accordance with the Departments policies and procedures for Contract Development.
8. Supplemental contracts documents shall be submitted digitally in PDF format. See Section 3.2.8 for supplemental contract document list and submission procedures.
9. The Consulting Engineer acknowledges and agrees that Contract Plans submitted using the [Digital Submission Procedure set forth in this Manual] has the same force and effect for the purposes of the Consulting Engineer’s agreement with the State as a signature and seal of a Connecticut Licensed Professional Engineer or Architect as set forth in § 20-300-10 of the Regulations of Connecticut State Agencies or § 20-293 of the Connecticut General Statutes, as applicable. Nothing in this DPD serves as an authorization for, or endorsement of, the use of this [Digital Submission Procedure] generally by the Consulting Engineer, its subcontractor(s), or any Connecticut Licensed Professional Engineer or Architect with respect to other work it performs for the State or work it performs for other clients.
10. Bluebeam Revu was used in the production of all figures and procedures in this manual. A license of Bluebeam Revu version 12 or higher must be purchased to perform all the procedures in this manual.
11. Bluebeam shall be the only PDF software supported by the Connecticut Department of Transportation for the processes set forth in this manual. Import the Bluebeam profile as shown in Appendix A. This will place all the tools and tool bars in the correct location.
12. When on call consultants are used for CTDOT projects, the title sheet shall be digitally signed by CTDOT following the procedure in Section 2.6.1 of this manual.
13. All documents detailed in the processes in the following manual are uploaded to CTDOT’s Projectwise site. To gain access to CTDOT’s Projectwise site fill out the following form: CTDOT Projectwise New User Form.
14. See section 3.2.1 for instructions on how to set up Projectwise the first time logging in.

1.4 Format

1.4.1 Contract Plans

1. Digital contract plans (preliminary, semifinal, FDP, etc.) shall be in PDF format; PDF Plans must be sized either 36” x 24” for projects created before 6/2007 or sized 34” x 22” for projects created after 6/2007; PDF plans shall be measurable to scale in the PDF; PDF plans shall be able to be printed to paper and scaled appropriately; text must be searchable; and all levels must have the ability to be displayed on or off, unless approved otherwise. All information on the digital contract PDF plans shall have been created from MicroStation or an approved alternate. The only information that shall be added to the plans using a PDF editing software are as follows:

- Page labels (see Section 1.6.2)
- Sheet numbers (see Section 1.6.2)
- Watermarks and flatten comments (see Section 2.4)
- Any digital signature fields (see Section 2.5)
- Digital Signature (see Section 2.6)

2. Contract plans shall be grouped, by discipline into individual multiple page PDF files called discipline subsets. Discipline subsets are not to be combined in a PDF Package/Portfolio. Examples of discipline subsets are: 01_General, 02_Revisions, 03_Highway, 04_Bridge, etc. See Section 1.11 & 1.12 for more examples of discipline subsets.

Using a discipline subset format streamlines both the development of contract plans and the administration of the plans during preliminary design, FDP, DCD, Addenda, DCO and As-Built
submissions. Moreover, it also leverages the ability to digitally sign the individual discipline based contract plan subsets per designer.

![Image of digital project development manual](image)

**Figure 1** Discipline Subset Bookmarks, Index of Drawings, and Signature fields

3. See [Section 2.5](#) for digital signature form field place holder cells.

4. Plans *For Information Only* (FIO) shall be submitted digitally, in individual subsets based on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc. These subsets do not require a digital signature, but each sheet in the subset shall be labeled; “For Information Only”. The subset numbers shall be selected by the lead designer so that the FIO subsets are last. Each sheet shall be numbered correctly, see [Section 1.6.2](#).

5. Utility drawings shall be submitted in accordance with the following:
   - Utility plans *For Information Only* (FIO) shall be submitted in a utility subset based on the utility company, AT&T subset, CL&P subset, etc. These subsets do not require a digital signature, but each sheet shall be labeled; “For Information Only”. FIO utility subsets shall be numbered so that they are the last subsets. Example Labels; 10_CL&P_FIO, 11_AT&T_FIO. These subsets must have page labels assigned, see [Section 1.6.2](#).
   - Utility company designed plans that include work being done by the State’s Contractor shall be submitted in a utility subset based on the utility company, AT&T subset, CL&P subset, etc. These subsets do not require a digital signature. Example Labels; 10_CL&P, 11_AT&T. These subsets must have page labels assigned, see [Section 1.6.2](#).
   - Utility plans that are designed by a Consultant firm that include work being done by the States Contractor shall be submitted in a utility subset based on the utility company, AT&T subset, CL&P subset, etc., and shall be digitally signed in accordance with this manual. Example Labels; 10_CL&P, 11_AT&T. These subsets must have page labels assigned, see [Section 1.6.2](#).

6. See [Section 3.2](#) for uploading and attributing Utility Plans. See [Section 1.11 & 1.12](#) for more examples of discipline subsets.

7. CTDOT Standard sheets shall also be delivered digitally. See [section 1.8](#) for how to prepare and submit CTDOT Standard Sheets.

8. The first and second subsets in the project must always be the 01_General and 02_Revisions respectively. The Project Manager is responsible for determining the order of all other discipline subsets, [Sections 1.11 and 1.12](#) show examples.

9. Discipline subsets shall contain a maximum of 150 sheets.

10. Discipline subsets shall be published directly from a CAD application. Scanned images or raster image formats will not be accepted with the exception of For Information Only sheets, these can be scanned.
11. Footers, displaying the sheet number, shall be placed on each page of each PDF subset. See Section 1.6.2, “Sheet Numbering”

12. Each subset shall contain bookmarks; one for each page. Figure 1 displays an example of bookmarks. See Publishing_MicroStation_Content_to_PDF_Format.pdf for more instructions.
   - Figure 1 also displays examples of subgroup folders. While publishing, subgroups may be created to contain similar sheets. See Publishing_MicroStation_Content_to_PDF_Format.pdf for more instructions.

13. Levels with the appropriate CTDOT names shall have the ability to be displayed on or off within the PDF document.

14. The first page of the subset 01_General shall be the CTDOT digital project title sheet which includes an index of the subsets contained within the project, sheet count totals for all subsets, a list of drawings for the 01_General Subset, and an area(s) reserved for applying the digital signature(s) (see section Section 2.5).
   Link to digital title sheet: Digital Title Sheet

Consultants will need to delete the CTDOT signature blocks on the title sheet and place a digital signature placeholder as detailed in section Section 2.5. CTDOT engineers can find the digital title sheet in the seed files on our W: drive.

15. The 01-General subset shall include all detailed estimate sheets.

16. The 02_Revisions subset must be included in each digital project and there shall only be (1) revisions subset.

17. Subset 02_Revisions shall contain only revision sheet(s), titled “Index of Revisions”, See Section 4.3. These revision sheets are used for tracking all sheet changes due to addenda and design initiated change order (DCO) with respect to the entire project. These sheets are originally blank and unsigned, and shall be managed and updated as needed by the Project Manager. The CTDOT Revision Contract Sheets can be obtained here:
   - CTDOT Designed Projects - 02-Revisions Subset
   - Consultant Designed Projects - 02-Revisions_CE_Subset

18. The first page of each subset shall be a subset cover sheet, this includes FIO subsets. This cover sheet shall contain both; an index of drawings contained within the subset that includes both drawing numbers and drawing titles and the form field placeholder(s) which receives the digital signatures. The following cell has a table for the index of drawings and the digital signature cell placeholder BDR_Discipline_Cover Sheet cell. This table must include the subset name and number displayed as a heading in the table. See Figure 1 for an example.

19. As-built information shall be digitally applied to the contract subsets by District Personnel after the job is complete using Bluebeam. See section 4.5.

20. Preliminary Contract Plans shall be submitted to CTDOT in accordance with this section, but do not need to be digitally signed. These review documents shall be uploaded into the 310_Review Documents folder in Projectwise.

21. A Bluebeam set file shall be created at FDP and updated for any addendums or change orders in accordance with section 1.12.

22. The Contract Plan subsets must be checked by the Discipline Subset PDF Checker in accordance with section 3.1.

**1.4.2 Contract Specifications**

23. Digital Contract Specifications shall be submitted in MS Word format and in accordance with the Departments policies and procedures for Contract Development. CSI special provisions shall be submitted in pdf format.
a. For projects where a consultant is the Project Manager on the project, the Specification and CSI special provisions submittals shall be submitted in (1) zipped folder, see section 3.2.6.

b. For projects where a CTDOT design unit is the Project Manager on the project, the Specification and CSI special provisions shall be submitted in individual zipped folders per discipline, see section 3.2.6.

c. Design Initiated Change Orders shall be placed in (1) pdf document, with “C#” and the date in the header. An example would be “Rev. C1 - mm/dd/yy”.

1.4.3 Environmental Permits – Under Development

1.4.4 Supplemental Documents

24. Supplemental documents shall be 8.5” x 11” pdf documents, except the proposal estimate which shall be in “.est” format. These documents should be uploaded into Projectwise in accordance with Section 3.2.6.

1.4.5 Contractor Submittals

25. See Section 6 for format, submittal and review requirements for Contractor Submittals: Working Drawings, Shop Drawings, Product Data, RFI, and RFC.

1.4.6 Engineering Reports

26. **Hydraulic, Scour, Floodway, and Final Drainage reports**: Shall be formatted in accordance with the following:
   - Shall be native PDF whenever possible.
   - Scanned sheets in the reports must have a maximum resolution of 200 dpi and a minimum of 125 dpi.
   - All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized up to 34” x 22”.
   - Shall be digitally signed and watermarked in accordance with Section 2 of this manual.
   - Any data files that must accompany the PDF report shall be uploaded into Projectwise in a zipped folder.
   - The reports and zipped folder for any data files shall be submitted into the 130_Engineering Reports folder under the applicable project in accordance with Section 3 of this manual.
   - Preliminary reports shall be uploaded into the 310_Review Documents folder in Projectwise.

27. **Task 110, Task 220, Underground Storage Tank System Closure Reports**: Shall be formatted in accordance with the following. The content of the report shall be in accordance with the Scope defined by the Division of Environmental Compliance:
   - Shall be native PDF whenever possible.
   - Scanned sheets in the reports must have a maximum resolution of 200 dpi and a minimum of 125 dpi.
   - All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized up to 34” x 22”.
   - Shall be digitally signed in accordance with Section 2 of this manual.
   - These reports shall be submitted into the 130_Engineering Reports folder under the applicable project in accordance with Section 3 of this manual.
   - Preliminary reports shall be uploaded into the 310_Review Documents folder in Projectwise.
28. **Rehabilitation Study Reports. Type Study Reports, and Load Ratings**: Shall be formatted in accordance with the [Bridge Manual](#) and Load Rating Manual respectively.
   - Final reports shall be uploaded into the 130_Engineering Reports folder in Projectwise.
   - Preliminary reports shall be uploaded into the 310_Review Documents folder in Projectwise.

### 1.4.7 GIS Project Location Documents

29. Project location for all projects shall be submitted to CTDOT. See [Section 8](#) for the format and submission requirements.

### 1.4.8 ROW (Rights of Way) Documents

30. Property Maps and Parcel Polygon files for acquired property shall be submitted to CTDOT. See [Section 9](#) for the format and submission requirements.

### 1.4.9 Project Correspondence

31. Final project correspondence shall be stored in the 140_Project Administration folder under the project in Projectwise in accordance with the following:
   - Shall be in PDF Format
   - The document must be attributed in accordance with [Appendix E](#), table 7.

Note: The discipline attribute must match the author of the document. For example, if the Highway design unit sends out a memo for a design review, the discipline attribute on this document shall be HW.

- Draft correspondence can also be created and worked on in Projectwise. These file shall be located under the user’s applicable 330_Design_Data folder under the project in Projectwise.

### 1.5 This Section Intentionally Left Blank

### 1.6 Contract Plan Drawing and Sheet Numbering

#### 1.6.1 Drawing Number

The drawing number is used primarily for sheet to sheet referencing, typically in, but not limited to; section details, section cuts, and detail callouts. Drawing numbers in digital contracts shall consist of the discipline designator followed by a hyphen and the sheet number. Examples of discipline designators are HWY, PRO, IND, XSC, S, TR, A, E, etc.

The CTDOT efficiently maintains the drawing numbers in MicroStation using the model properties and project explorer, See the following workflow [Project Explorer to Manage Drawing Numbers](#)

The first sheet in a discipline subset shall have “01” in the drawing number as shown below:
1.6.2 Final Plan Page Labels and Sheet Numbers

Page labels and sheet numbers are applied to the discipline subset after the contract plans are published to PDF.

Page labels and sheet numbers shall be managed and placed on the discipline subsets, using the number pages and header and footer tools within Bluebeam. Page labels and sheet numbers shall be applied to all submissions of contract plans.

The first sheet in every subset shall start out at 01. For example the first sheet in the 05-Traffic subset shall be 05.01.

The page label and sheet number place holder shall be determined by the total estimated sheet count. For less than 100 sheets two place holders is adequate. For greater than or equal to 100 sheets three place holders are necessary. For subsets less than 10 sheets, two placeholders shall be used i.e. 01.01 thru 01.04 for a four sheet subset.

The page labels and sheet numbers must be placed correctly because it is used to correctly assemble the contract plans into a properly ordered consolidated set that District Construction takes advantage of during construction of the project.

**Single Volume Projects:**

The page labels and sheet numbers, for single volume projects shall be a concatenation of the discipline subset number, a decimal point, and the sheet number. For example; the page labels and sheet numbers for subset “4” would be as follows; less than 100 sheets 04.01, 04.02, 04.03, etc or Greater than 100 sheets 04.001, 04.002, 04.003 etc.

The Project Manager should determine the total number of subsets and give each discipline their corresponding subset number, see section 1.11.
Multi Volume Projects:
For a multi volume project the page labels and sheet numbers shall be a concatenation of the volume number, a decimal point, the discipline subset number, a decimal point, and finally the sheet number. Example: Volume 2, Subset 5; 02.05.01, 02.05.02, 02.05.03.

Volume numbers shall be used on large projects. They are effective because the Project Manager only has to deliver to the other engineers their perspective volume numbers, allowing them to manage their subset numbers independently of the other discipline volumes and subset counts, see section 1.1.2.

Subset numbers shall start at 01 for all volumes.

**BLUEBEAM - Applying Page Labels and Sheet Numbers**
To apply page labels and sheet numbers in Bluebeam follow the figures below:

1. First page labels must be applied to the discipline subset. Go to the thumbnail pane as shown below, right click on a thumbnail and select Number Pages:

   ![Figure 4 - Adding Page Labels](image)

   **Figure 4 - Adding Page Labels**

   For subsets that contain less than 10 sheets the page labels can be applied to all the sheets at once. In the case where there are 10 or more sheets in the subset the following will have to be done twice in order to get the correct number of place holders.
2. Select the correct style, insert correct prefix for the sheets being numbered, and apply to the correct pages. For example, if the 04 subset has 99 sheets the prefix shall be “04.0” for sheets 1-9 and “04.” For sheet 10 through 99.

(1) Select this style
(2) Insert correct prefix
(3) Start at 1 for sheets 1-9 and 10 for sheets 10-99
(4) Apply to correct pages
(5) Click OK

Figure 5- Page Labeling

3. Now the pages will be labeled:

Figure 6 - Labeled Pages
4. Next we will apply the sheet numbers. From Bluebeam select the Document tab and then “Header & Footer”.

5. Place the sheet numbers, as shown below: Note the margins may have to be adjusted as necessary. After you select the font, set the margins, and type in <<PageLabel>> as shown below. Then click save for save settings. The next time you are going to apply sheet numbers to a subset, you can simply select the saved settings. Then click OK.
1.6.3 Addendum and Design Initiated Change Order Page Labeling and Sheet Numbers

Page labels and sheet numbers for an Addendum need to have “.A#” at the end and Change Orders need to have “.C#” at the end (see section 4 for addendum and change order sheet numbering requirements).

To apply page labels and sheet numbers in Bluebeam follow the figures below:

1. First page labels must be applied to each sheet in the addendum or change order. This can only be done one sheet at a time.
2. Go to the thumbnail pane as shown below, right click on a thumbnail and select Number Pages:

![Figure 9 - Adding Page Labels](image)

(1) Select thumbnail icon
(2) Right Click on a thumbnail
(3) Select Number Pages
3. Select None for a style, type in the sheet number of the addendum or change order sheet in the prefix line. Then select which sheet you are labeling. This has to be done for each sheet in the addendum or change order separately. See below:

(1) Choose None
(2) Type in the sheet number of this sheet
(3) Select the correct sheet
(4) Select OK

Figure 10 - Applying Addendum Page Labels

4. After all page labels have been applied, the sheet numbers can be applied. From Bluebeam select the Document tab and then “Header & Footer”

(1) Select Document
(2) Select Pages
(3) Select header & footers

Figure 11 - Header Footer Tool
5. Select your sheet numbers saved settings from before and click OK. Note the margins and size may have to be adjusted as necessary.

![Select save settings and click OK](image)

(1) Select your save settings

(2) Click OK

1.7 CTDOT For Information Only Sheets

Plans provided For Information Only (FIO) shall be submitted digitally, in individual subsets based on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc. These subsets do not require a digital signature, but each sheet in the subset shall be labeled; “For Information Only”. The first sheet of each FIO subset shall be a subset cover sheet. These sheets shall be placed on a border and numbered in accordance with section 1.6.2.

The subset numbers shall be selected by the Project Manager so that the FIO subsets are last. See Section 3.2 for uploading and attributing FIO Plans. See Section 1.11 & 1.12 for more examples of discipline subsets. Information only sheets may be scanned, but must conform to the following specifications; Minimum Size 22”x34”, Minimum dpi = 300.

This link shows a procedure that can be used to create a For Information Only subset using Bluebeam: Preparing a For Information Only Subset
1.8 CTDOT Standard Sheets

Standard sheets shall also be delivered digitally into Projectwise. The following shows how to obtain the latest version of the CTDOT Standard Sheets and how to prepare them for a digital project.

1. Download the latest standards from the following link for the project: CTDOT Standard Drawings Website

2. Upload the standard subset into Projectwise in accordance with section 3.2.

3. Next open up the standards from Projectwise by double clicking on it. Once it opens click on the index sheet.

4. Then enter the project number and check the standards to be included in the project.
5. Delete the standards that are not included in the project as shown below:

6. Next digitally sign all index sheets in accordance with section 2.6.
7. Then upload the standards into the 100_Contract Plans folder in Projectwise in accordance with section 3.2 of this manual.

1.9 Contract Plan Sheet Publishing

CTDOT currently uses MicroStation V8i Print Organizer to publish contract plans to a PDF format.

The workflow Publishing_MicroStation_Content_to_PDF_Format.pdf shows the fundamentals of publishing contract plans to PDF from MicroStation.
1.10 Example: Typ. Single Volume Digital Contract

Single volume digital contracts are used when each discipline or consulting firm designing the project is responsible for 3 subsets or less. The following is an example of a single volume project. Note: The first and second subsets shall always be 01-General and 02-Revisions. The 03 subset does not always need to be 03-Highways, the 04 does not always need to be 04-Structure, etc. The FIO subsets shall be placed at the end of a project right before the STD subsets.

<table>
<thead>
<tr>
<th>Label (Discipline Subset)</th>
<th>File contents (but not limited to)</th>
</tr>
</thead>
<tbody>
<tr>
<td>01-General</td>
<td>Title Sheet</td>
</tr>
<tr>
<td></td>
<td>Detail Estimate Sheet</td>
</tr>
<tr>
<td>02-Revisions</td>
<td>Index of Revisions Sheets</td>
</tr>
<tr>
<td>03-Highways**</td>
<td>Index of Plans</td>
</tr>
<tr>
<td></td>
<td>Survey Data</td>
</tr>
<tr>
<td></td>
<td>Alignments</td>
</tr>
<tr>
<td></td>
<td>ROW</td>
</tr>
<tr>
<td></td>
<td>Typ Sections</td>
</tr>
<tr>
<td></td>
<td>Misc Details</td>
</tr>
<tr>
<td></td>
<td>Intersect Grading</td>
</tr>
<tr>
<td>04-Structure</td>
<td>Index of Drawings</td>
</tr>
<tr>
<td></td>
<td>All Structure Sheets</td>
</tr>
<tr>
<td></td>
<td>Note: Multiple subsets may required for multiple Sites  Ex: 04_Structure_Br.No.1266</td>
</tr>
<tr>
<td>05-Traffic</td>
<td>Index of Drawings</td>
</tr>
<tr>
<td></td>
<td>Signing</td>
</tr>
<tr>
<td></td>
<td>Pavement Markings</td>
</tr>
<tr>
<td></td>
<td>MPT</td>
</tr>
<tr>
<td></td>
<td>Traffic Signal Plans</td>
</tr>
<tr>
<td></td>
<td>Etc.</td>
</tr>
<tr>
<td>06-Environmental</td>
<td>Index of Drawings</td>
</tr>
<tr>
<td></td>
<td>All Environmental Compliance Sheets required</td>
</tr>
<tr>
<td>07-“Utility”</td>
<td>Utility Design plans. For example 07_AT &amp; T, 07_CL &amp; P, 07_MDC, etc.</td>
</tr>
<tr>
<td>08-CL&amp;P FIO***</td>
<td>CL &amp; P For Information Only plans</td>
</tr>
<tr>
<td>09-AT&amp;T FIO***</td>
<td>AT &amp; T For Information Only plans</td>
</tr>
<tr>
<td>CTDOT Highway STD</td>
<td>* CTDOT Highway Design Standard Index and Sheets required</td>
</tr>
<tr>
<td>CTDOT Traffic STD</td>
<td>* CTDOT Traffic Engineering Standard Index and Sheets required</td>
</tr>
</tbody>
</table>

* For using CTDOT Standard Sheets see 1.8 CTDOT Standard Sheets
** If a discipline has to be broken up into more than one subset See Section 1.11 for splitting up the discipline subsets.
*** For Information only discipline subset shall be submitted as individual pdf files based on the entity providing the information only.
1.11 Example: Multiple Volume Digital Contract

Multiple volumes are used if the project has 1 or more of the following characteristics:

1. The majority of the discipline/firm designers are responsible for more than 3 subsets each. This allows the individual designers to number their subsets independently of the other disciplines.
2. There are multiple sites on the project. Splitting these sites up into volumes will provide better organization of the project.
3. Combining multiple projects into one project.

The larger the project is, typically the more subsets will be required and their labels will be more specific. The Project Manager will need to organize the discipline volumes. The subsets shall be split up by volume and each volume shall be controlled by its assigned designer. For example, all the subsets designed by the highway designer shall be in the same volume (02) and each subset shall have a unique subset number.

<table>
<thead>
<tr>
<th>Label ( Discipline Subset)</th>
<th>File contents (but not limited to)</th>
<th>Designer/ Firm</th>
</tr>
</thead>
<tbody>
<tr>
<td>01.01-General</td>
<td>Title Sheet, Detail Estimate Sheet</td>
<td>Lead</td>
</tr>
<tr>
<td>01.02-Revisions</td>
<td>Index of Revision Sheets</td>
<td>Lead</td>
</tr>
<tr>
<td>01.03-WtInd Re-establish</td>
<td>Wetland Reestablishment plans</td>
<td>Designer 1</td>
</tr>
<tr>
<td>01.04-Stg Acc.</td>
<td>Staging and Access Plans</td>
<td>Designer 1</td>
</tr>
<tr>
<td>02.01-Typ Sections</td>
<td>Typical Sections</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.02-Alignments</td>
<td>Alignment Geometry</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.03-Plan</td>
<td>Plans</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.04-Profiles</td>
<td>Profiles</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.05-ROW Brk</td>
<td>Right of Way Breakout</td>
<td>Designer 2</td>
</tr>
<tr>
<td>02.06-Drain</td>
<td>Drainage Plans</td>
<td>Designer 2</td>
</tr>
<tr>
<td>03.01-Retaining Wall 1</td>
<td>Retaining wall details</td>
<td>Designer 3</td>
</tr>
<tr>
<td>03.02-Retaining Wall 2</td>
<td>Retaining wall details</td>
<td>Designer 3</td>
</tr>
<tr>
<td>03.03-Bridge 00456</td>
<td>Bridge_456</td>
<td>Designer 3</td>
</tr>
<tr>
<td>03.04-Bridge 01983</td>
<td>Bridge_1983</td>
<td>Designer 3</td>
</tr>
<tr>
<td>03.05-Bridge 01984</td>
<td>Bridge_1984</td>
<td>Designer 3</td>
</tr>
<tr>
<td>04.01-Stage 1</td>
<td>Stage Construction Details 1</td>
<td>Designer 4</td>
</tr>
<tr>
<td>04.02-Stage 2</td>
<td>Stage Construction Details 2</td>
<td>Designer 4</td>
</tr>
<tr>
<td>04.03-Stage 3</td>
<td>Stage Construction Details 3</td>
<td>Designer 4</td>
</tr>
<tr>
<td>05.01-SPM</td>
<td>Signing and Pavement Marking Site 1</td>
<td>Designer 5</td>
</tr>
<tr>
<td>05.02-SPM</td>
<td>Signing and Pavement Marking Site 2</td>
<td>Designer 5</td>
</tr>
<tr>
<td>05.03-SPM</td>
<td>Signing and Pavement Marking Site 3</td>
<td>Designer 5</td>
</tr>
<tr>
<td>06.01-IMS</td>
<td>IMS Plans and Details Site 1,2,3</td>
<td>Designer 6</td>
</tr>
<tr>
<td>07.01-Env 1</td>
<td>Environmental Details Site 1</td>
<td>Designer 7</td>
</tr>
<tr>
<td>07.02-Env 2</td>
<td>Environmental Details Site 2</td>
<td>Designer 7</td>
</tr>
<tr>
<td>07.03-Env 3</td>
<td>Environmental Details Site 3</td>
<td>Designer 7</td>
</tr>
<tr>
<td>08.01-“Utility”</td>
<td>Utility Design plans. For example 07_AT &amp; T, 07_CL &amp; P, 07_MDC, etc.</td>
<td>Designer 8</td>
</tr>
<tr>
<td>09.01-CL&amp;P FIO</td>
<td>CL &amp; P For Information Only plans</td>
<td>Designer 8</td>
</tr>
<tr>
<td>09.02-AT&amp;T FIO</td>
<td>AT &amp; T For Information Only plans</td>
<td>Designer 8</td>
</tr>
<tr>
<td>CTDOT Highway STD</td>
<td>* CTDOT Highway Design Standard Index and Sheets required</td>
<td>Designer 1</td>
</tr>
<tr>
<td>CTDOT Traffic STD</td>
<td>* CTDOT Traffic Engineering Standard Index and Sheets required</td>
<td>Designer 5</td>
</tr>
</tbody>
</table>

Figure 17 – Multiple Design Firms CTDOT Project Subsets
1.11.1 Combining Multiple Projects

When 2 or more projects are combined into one project, the following shall be done:

- Each project shall be given its own volume.
- The lowest project shall always be volume 1.
- Each project shall have its own title sheet, which reference each other with a note.
- There shall only be (1) Revisions subset. This subset shall be in volume 1 and named 01.02 – Revisions.
- The Revisions subset shall be the responsibility of the project manager on the projects.
- Each project shall have its own detailed estimate sheets.
- There shall only be (1) set of Highway Standards and (1) set of Traffic Standards when the projects are combined.
- There shall not be any duplicate special provisions after the projects are combined.

1.12 Consolidating Contract Plan Discipline Subsets

The consolidation of the contract plan discipline subsets is accomplished using the Set feature in Bluebeam version 11 or newer. This feature creates a single viewer file called a “Set File” that allows users to take multiple digitally signed files, sort them by their sheet numbers, and view them in order without actually combining the files.

The project manager shall create a Set file for the project at FDP that contains all the discipline subsets, DO NOT include the highway and traffic standard subsets. When an Addendum or Change Order is required for the project, the set file shall be updated by the project manager to include the Addendum or Change Order subsets.

The following shows when and how a set file will be created and updated throughout the life of a project.

See Appendix C for general use of a set file.

1.12.1 When a Set File is Created and Updated

Set File Creation
1. The lead designer shall create a set file of all the discipline subsets at FDP, see section 1.12.2

Set File Updates
2. If any FDP subsets need to be revised during the DCD process, the set file shall be updated to remove the FDP subsets that were changed and add the DCD subsets.
3. If any Addendum subsets are required for the project, these Addendum subsets shall be added to the set file.
4. If any Design Imitated Change Order subsets are required for the project, these Design Imitated Change Order subsets shall be added to the set file.

See section 1.12.3 for updating the set file.
1.12.2 Creating a Set File

After all the discipline subsets have been submitted into Projectwise for FDP the lead designer shall create the project’s set file in accordance with the following:

1. Launch Bluebeam from the desktop icon on your computer.
2. Next Click on the Set Icon and select New Set as shown below:

![Image of Bluebeam interface showing set creation process]

(1) Click on the Set icon
(2) Click on the arrow and select new Set

Figure 18 - Creating a Set File
3. Then click Add and then Projectwise and OK as shown below:

4. Next browse out to your project’s 100 Contract Plans folder and select all plans except the standard subsets. Then click Open: After you click Open it may take a minute for Bluebeam to load all the files into the set, please be patient.
5. Next click on Relative Paths and make sure the options are selected as shown below:

- Use Relative Paths

![Set File Options](image)

**Figure 21 - Set File Options**

6. Next click on Advanced and select and unselect the options as shown below:

- **(1) Click Advanced**
- **(2) Select Wildcard, unselect these options and click OK**

![Advanced Options](image)

**Figure 22 - Configuring the Set File**
7. Next click Save, this may take a while depending on how big the project is, please be patient. When the box pops up choose Projectwise and click OK:

(1) Click Save

(2) Choose Projectwise and click OK

Figure 23 - Saving the Set File
8. Select the Advanced Wizard, and then on the Select target folder browse out to your project’s 100_Contract_Plans folder. Then click next until you get to the attributes page. Attribute the Set File as shown below:

![Figure 24 - Attributing the Set File](image)

(1) Select these attributes
(2) Type these attributes
(3) Click Next until the document uploads

9. Click OK after the set file has been saved into Projectwise:

![Figure 25 - Creating a Set File](image)

Click OK
10. Now the set file has been created for use of the Set File see Appendix C:

Figure 26 - Set File

All the files will be shown here in the correct order
1.12.3 Updating a Set File

The following will show how to update a set file.

1.12.3.1 Adding a File to the Set File

1. Double click on the set file from Projectwise and open as shown below: This may take a while depending on how big the project is, please be patient.

![Figure 27 - Opening a Set File](image-url)
2. Next click on the Set icon and click Add as shown below:

![Figure 28 - Modifying a Set File](image)

3. Next browse out to your project and select the files to add to the set and click Open. This may take a minute to add the additional file to the set so please be patient. After it finishes click OK.

![Figure 29 - Adding Files to the Set File](image)
4. Now the file will be added to the set, scroll down and you will see it.

Figure 30 - Set File
1.12.3.2 Deleting a File from the Set

1. Double click on the set file from Projectwise and open as shown below: This may take a while depending on how big the project is, please be patient.

![Figure 31 - Opening a Set File]
2. Next click on the Set Icon. Then select the file to remove from the set and click delete:

Note: You can make the width of the file name column wider by dragging the column here.

Select file to delete and select delete, then click OK.

Figure 32 - Deleting a File from the Set File
Section 2 Digital Signatures for Contract and Other Engineering Documents

The following contract documents must be digitally signed when submitted to the Department in accordance with the following section:

- Contract Plans – FDP, Addendum, Change Orders
- Engineering Reports
  - Hydraulic Report
  - Scour Report
  - Floodway Report
  - Final Drainage Reports
  - Bridge Inspection Reports
  - Task 110
  - Task 220
  - Underground Storage Tank System Closure Reports
- Working Drawings for Permanent and Temporary Structures – Plans and Calculations

This manual refers to digital signatures in two ways: certifying signatures, and signing signatures. The Engineer of Record or document signer will always digitally sign using a visible certifying signature. If multiple signatures are required per document, the second signer or sub-engineers shall always digitally sign using a visible signing signature after the primary signer or engineer has applied his certifying signature. Certifying signatures allow controlled changes, to the now certified document. These controlled changes include; allowing PDF digital comments, and the application of additional signatures. Signing signatures should always be accompanied by a note listing the sheets the signer is responsible for within a subset.

In order to digitally secure a PDF document the signer(s) applies a digital signature(s) to only the first sheet of the document, regardless of the number of pages the document contains. This digital signature secures the entire document.

A graphic image of the signer’s signature must be created, and shall be used for the following purposes:

- It shall be attached to the digital signature and displayed when the digital signature is applied.
- It shall be placed as a watermark on all contract plan sheets a particular engineer of record is responsible for (digitally signing for).
- It shall be placed on the first sheet by the preparer and checker of an engineering report.
- The watermark shall be placed on all contract plan sheets and all plan sheets contained in a working drawing submittal.

A digital ID must be purchased in order to apply a digital signature. Digital ID’s must meet the specifications of Adobe’s Certified Document Services (CDS) or Adobe Approved Trusted List (AATL). The necessary hardware and software needed to apply the required digital signatures may be purchased from the vendor list provided at the following website: http://www.adobe.com/security/partners_cds.html, additional information on Adobe’s CDS is also available at this website and https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html for information on AATL.

Before digitally signing any document Bluebeam must be set up as detailed in Appendix A.
2.1 Graphic Image of Signature

2.1.1 Contract Plans

The following figures display an example of both a state designer and a consultant designer’s digital signatures, and their accompanying graphic image(s) of their signature(s). See section 2.2, for instructions on how to create a graphic image.

The consultant engineer’s graphic image must contain his companies name and address; his signature, his Professional Engineers stamp, or his Professional Architecture Stamp. The state employee’s graphic image must contain only his signature. See Below.

Figure 33 - Graphic Image of Signature

In addition to a digital signature being placed on the first sheet of any contract plan, working drawing plans, and working drawing calculations, CTDOT also requires that all subsequent pages be watermarked with a copy of the engineer of records graphic signature before they are digitally signed. Watermarks containing these signatures are applied using Bluebeam and are always placed in the border of contract plans and working drawings for permanent structures. This is to prove validation of a digital document if printed.

Figure 34 – Watermarks
2.1.2 Engineering Reports

Hydraulic, Scour, Floodway, and Final Drainage Reports

The following shows the watermarks that need to be placed on the first sheet of a Hydraulic, Scour, Floodway, or Final Drainage Report by the Preparer and the Checker and the digital signature of the Approved Hydraulic Engineer. The digital signature must include the graphic image of the signer’s PE stamp and signature as shown below, section 2.2, for instructions on how to create a graphic image. These reports shall be digitally signed in accordance with section 2.6.7.

Figure 35 - Engineering Reports
Bridge Inspection Reports

The following shows how Bridge Inspection reports are to be digitally signed in the bottom right hand corner of the report. The digital signature must include the graphic image of the signer’s PE stamp and signature as shown below, section 2.2, for instructions on how to create a graphic image. These reports shall be digitally signed in accordance with section 2.6.7.

Inspection Type: Routine and Fracture Critical

BRIDGE NO. 08069R

08070 - BRIDGEPORT
MAINLINE
over
KOSSUTH STREET

Routine and Fracture Critical Inspection
5/27/2015

Inspected by: TranSystems

Digital Signature

Mathew J.
Calkins, P.E.
2015.08.20
10:37:09-04'00'

Figure 36 - Bridge Inspection Reports
Environmental Compliance Reports
The digital signature for the Task 110, Task 220, and Underground Storage Tank System Closure Reports must include a graphic image of the Professional engineer’s signature or a graphic image of the signer’s signature where applicable, see section 2.2, for instructions on how to create a graphic image. These reports shall be digitally signed in accordance with section 2.6.7.

2.1.3 Working Drawings

Working Drawings for Permanent and Temporary Structures
The following shows the digital signature and Professional Engineering watermark requirements for the engineer who prepares the working drawing submittal. These types of submittals shall be digitally signed in accordance with section 2.6.6. Note: Working Drawing for Temporary Structures only require that the first sheet in the submittal be digitally signed, watermarks are not necessary. See section 2.2, for instructions on how to create a graphic image.

Working Drawing Plans
The first plan sheet in the submittal shall have a digital signature and a watermark placed on it as shown below. All others sheets will only have the watermark. A place in the border of the plan sheets shall have a spot for this watermark.

Figure 37 - Working Drawing for Permanent Structures
Working Drawing Calculations

The first sheet of the calculations shall have a digital signature as shown below:

![Digital Signature](image)

**Figure 38 - Working Drawing for Permanent Structures**

2.1.4 Other Documents

Documents that do not require to be signed by a Professional Engineer shall have a graphic image of the signer’s signature attached to their digital signature. See section 2.2, for instructions on how to create a graphic image.
2.2 Creating Graphic Image of Signature:

2.2.1 In House CTDOT or Non-Professional Engineering Signature:
The graphic signature will be used by CTDOT employees and signers that are not signing as a Professional Engineer.

CTDOT graphic signatures shall be created as follows:

1. Signer must sign a blank piece of paper.
2. Scan this signature.
3. Crop the image so that the image is approximately 300 pixels wide by 100 pixels high.
4. Save the images, in PDF to an area on your PC.

![Signature Image](image1.jpg)

Figure 39 (Example of CTDOT Graphic Image of Signature – Used with Digital Signature and as a Watermark)

2.2.2 For Consultant Staff PE Stamp:
Consultant Engineers shall create two different graphic signature images: one that shall accompany their digital signatures and a different one that shall be placed as a watermark on all the plan sheets the engineer is signing for.

This section shows an example of a Professional Engineer preparing their graphic image of their signature; Architect’s shall follow this section when they are preparing their digital signature.

**Graphic Appearance Attached to Digital Signature**
The graphic signature that accompanies the digital signature only needs to include the designer’s signature and P.E. Stamp, and shall be created as follows:

1. Stamp and Sign a blank piece of paper.
2. Scan this signature.
3. Crop the image to approximately 250 pixels wide by 250 pixels high.
4. Save the image, in PDF to an area on your PC or server, where you can easily access it for later use in the signature set-up procedure.

![Signature Image](image2.jpg)

Figure 40 (Example of Consultant Engineer Graphic image of Signature – Applied to 1st page only with digital signature)
In addition to the designer’s signature and P.E. Stamp, the graphic signature that is placed as a watermark shall also include the designer’s company name and address, and shall be created as follows:

1. On blank paper – Print company name and address.
2. Place P.E. stamp next to company name and address.
4. Scan the image created in steps 1 thru 3 above.
5. Crop the image to approximately 500 pixels wide by 250 pixels high.
6. Save the image, in PDF to an area on your PC or server, where you can easily access it for later use in the watermarking procedure.

Figure 41 (Example of Consultant Engineer Graphic image of Signature – applied to all pages as a watermark)

Once the graphic images have been properly created and saved, the digital signature appearance preferences must be set as follows:

2.3 Setting Digital Signature Appearance Preferences:

Once the graphic signatures are created the digital signature appearance settings must be defined as follows:

**Bluebeam Digital Appearance**

1. Make sure your digital signature USB token is inserted into the computer then in Bluebeam go to the Document tab and select Signatures>Digital ID’s:

   ![Bluebeam Digital Appearance](image)

   **Figure 42 - Digital Appearance**

2. Next click on your ID and click Manage Appearances:
3. Next follow the figure below:

4. Now the digital appearance will be saved and can be used to digitally sign.
2.4 Watermarking Plans with Graphic Image of Signature

The Engineer of Record (Principal Engineers for State Design), for each discipline, shall place a copy of their graphic signature as a watermark on each sheet of each discipline subset, or working drawing submittal (Plans and Calculations) that they are responsible for. For Engineering Reports the preparer and checker of the report shall place a copy of their graphic signature as a watermark only on the cover of the report.

Bluebeam - Watermarking Plans with Graphic Image of Signature (CTDOT and Consultant Designed)

There are two ways to apply watermarks using Bluebeam, see below for options 1 and 2. The following shows an example of a CTDOT signature, but the procedure is the same for a consultant when they are placing their PE stamp in the border or on the first sheet of an engineering report.

Watermarking Workflow:
Option 1

1. The watermark in Bluebeam is placed using the stamp function. First go to the Markup tab and select Stamp and then choose your stamp. If your Principal’s or PE stamp is not in the list follow Appendix A. If your stamp is in the list go to step 2.

2. Next place the stamp in the border on the first sheet.

Figure 45 - Placing Watermark
3. Next right click on the stamp and select “Apply to all pages”. If you are watermarking an engineering report you do not need to apply to all pages.

![Figure 46 - Placing Watermark on All Pages](image)

If more than one group has to watermark this subset, browse to the pages the other group is responsible for and delete the watermark. Then they can come in and place their watermark on these sheets.

**Flatten Markups**

4. After the watermarks have been placed, the watermarks must be “flattened” to the PDF document. Go to Document>Flatten Markups. Use the default settings and click OK.

**Option 2**

1. Go to the Document tab and Pages>Apply Stamp.

![Figure 47 - Applying Stamps](image)
2. Select stamp, input scale and coordinates as necessary, and page range as shown below.

![Select stamp, input scale and coordinates as necessary, and page range as shown below.](image)

**Figure 48 - Applying Stamps**

**Flatten Markups**

3. After the watermarks have been placed on the subset, the watermarks must be “flattened” to the PDF document. Go to Document>Flatten Markups. Use the default settings and click OK.

2.5 Digital Signature Fields

**Contract Plans**

Digital signature fields are form fields created using Bluebeam, and are used to house the digital signatures. Digital Signature form fields shall be placed within the form field place holders. The form field place holders are cells that are placed in the MicroStation file on the title sheet and the subset cover sheets and on any Addendum or Change Order Subset. The figure below shows a CTDOT designed project with the form field place holders (circled) on the title sheet and the discipline subset cover sheet.

![Digital Signature Fields](image)

**Figure 49 - Digital Signature Fields**
The figure below shows a consultant designed project’s title sheet and discipline subset cover sheet with their form field place holders.

Place holders determine the location and size of the digital signature form field.

Form field place holding cell library: CT_Digital_Sigs.zip

The digital signature place holder and form fields shall be created on the first page of each discipline subset for each required digital signature.

**Note:** All signature form fields need to be created for both certifying and signing signatures before any digital signatures is applied to the document.

**Contractor Submittals**
Contractor submittals will not be required to have a digital signature place holder.

**Engineering Reports**
Engineering reports will not be required to have a digital signature place holder.

### 2.5.1 Bluebeam - Creating Digital Signature Form Fields

The following example shows how to place the (3) digital signature form fields on the 01-General title sheet of a CTDOT designed project. For a discipline subset or a consultant designed 01-General title sheet, only one digital signature form field needs to be placed.

1. Go to the Document tab and select Signatures>Add Signature Field.
2. Next place three signature fields in the appropriate location and hit save as shown below:

![Signature Fields Image]

Figure 52 - Placing Signature Fields

### 2.6 Applying Digital Signatures

This section describes how to apply digital signatures for contract plans, engineering reports, working drawing plans, and working drawing calculations.

**Contract Plans**

Contract plan discipline subsets 01-General and 02-Revisions and the Highway and Traffic Standard drawing subsets have unique requirements as described in the following sections.

CTDOT projects shall have their discipline subsets digitally signed after they have been uploaded into projectwise because the Principal Engineer will be looking in projectwise to digitally sign documents.

Discipline subsets designed by a single engineer shall be digitally signed, by the engineer of record, using a single visible **certifying** signature, applied to the signature form field located on the first page of each subset.

Discipline subsets designed by multiple engineers shall first be digitally signed by the Engineer of Record who is responsible for the most sheets in the subsets. This engineer will apply a visible **certifying** signature in the top most form field. The next Engineer of Record shall apply their **signing** signatures in the subsequent form fields. This Engineer shall also include a reason, when applying their digital signatures, listing the pages they are responsible for.

Digital signatures must be applied to digital form fields, previously created. [See Section 2.5](#).

**Engineering Reports**

Engineering Reports shall be digitally signed, by the Engineer of Record using a **certifying**. See [section 2.7](#) for instructions on how to apply a certifying signature to an engineering report.
2.6.1 Applying Digital Signatures to 01_General Subset (FDP and Addendum Subsets)

CTDOT DESIGNED PROJECTS:
The following procedure applies to both the 01_General subset at FDP and any 01_General_A# subset.

The project title sheet of the 01_General subset shall first be digitally signed by the lead discipline’s Principal Engineer, using a certifying signature. The Principal Engineer should make sure that all three digital signature form fields (blue boxes in the signature block) are placed before signing, as these forms cannot be added after the document is digitally certified. After processing has approved the 01_general subset for Advertising, the Manager, and the Transportation Engineering Administrator shall digitally sign the same sheet directly below the principal’s signature, using a signing signature while the plans are in the Manager and Engineer Admin. Sign state.

Processing shall notify the lead designer when the 01-General subset is placed in the Manager and Engineer Admin. Sign state. The lead designer shall then coordinate the digital signing by the Manager and Engineering Administrator of the 01_General subset. When both signatures are applied to the plans, the lead designer shall then notify processing that the 01-General subset has been signed.

See Section 2.7 Applying Digital Signature Workflows
Note: When digitally signing the 01_General subset all signers shall leave the reason code blank.
The following image shows a typical project title sheet from the 01_General subset that is digitally signed:

![Figure 53 - Title Sheet Digital Signatures](image-url)
CONSULTANT DESIGNED PROJECTS:
The project title sheet of the 01_General subset shall be digitally signed by the lead consultant, using a certifying signature.

See Section 2.7 Applying Digital Signature Workflows

When more than one consultant works on a CTDOT digital project the project manager (prime consultant) shall apply a visible certifying signature to the first page of the 01_General subset. By applying this signature the prime consultant is accepting responsibility for the entire set of digital contract plans. However the individual subsets shall be signed by the corresponding firms.

Note: When applying certifying or signing signatures leave the reason code blank.
2.6.2 Applying a Digital Signatures to 02_Revisions Subset

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a CTDOT signature, but the workflows are the same.

This subset does not need to be signed at FDP. This subset must be signed when the sheet is filled out for an Addendum or design initiated change order, whichever comes first.

The first index of revision sheet(s) located in the 02_Revisions subset shall be digitally signed by the lead designer, using a certifying signature.

1. The lead designer shall apply a certifying signature as described in section 2.7 Applying Digital Signature Workflows with the following EXCEPTION; the option “No Changes Allowed” must be selected to eliminate unauthorized changes after certifying the document. See the figure below:
2.6.3 All Other Discipline Subsets - Single Signature

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a consultant signature, but the workflow is the same.

Each discipline subset shall be digitally signed with a visible certifying signature, by ONLY the responsible design engineer. As shown below.

See section 2.7 Applying Digital Signature Workflows

![Signature Image]

Figure 56 CTDOT Certified Plan Subset

2.6.4 Standard Drawing Subsets – Single Signature

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a consultant signature, but the workflow is the same.

Only the standard drawing subset index sheets, Highways and Traffic Standard Drawings, need to be digitally signed with a visible certifying signature, by the responsible design engineer that submits the subset to Projectwise. For example, in the case where the Traffic unit is submitting a Highway standards subset, the Traffic Principal Engineer is responsible for digitally signing the index sheets, not the Highway Principal Engineer.

See section 2.7 Applying Digital Signature Workflows

2.6.5 All Other Discipline Subsets – Multi-Signatures

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a consultant signature, but the workflow is the same for CTDOT designed projects.

Multiple signatures per a single subset are required where two or more disciplines/firms are responsible for one subset.

The lead designer that is responsible for most of the pages within a discipline subset shall digitally sign the subset using a certifying signature, and leave the reason code blank. See Section 2.7 Applying Digital Signature Workflows
Once certified by the subset lead, the remaining designer(s) shall digitally sign the same subset using a signing signature, and complete the reason code with a note stating which pages, contained in this subset, that they are responsible for. See table 2-1 below:

**Table 2-1 Reason Codes for Prime and Sub Consultants**

<table>
<thead>
<tr>
<th>Designer</th>
<th>Certify or Sign</th>
<th>Responsible Sheet Numbers</th>
<th>Reason Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lead Designer</td>
<td>Certify</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sub-Designer 1</td>
<td>Sign</td>
<td>03.78 Thru 03.88</td>
<td>I am Signing for Sheet Nos. 03.78 thru 03.88</td>
</tr>
<tr>
<td>Sub-Designer 2 –  etc.</td>
<td>Sign</td>
<td>03.88 Thru 03.98</td>
<td>I am Signing for Sheet Nos. 03.88 thru 03.98</td>
</tr>
</tbody>
</table>

2.6.6 Working Drawings

Working drawing submittals shall be digitally certified in accordance with section 2.7 Visible Digital Signature using a Certifying signature, of this manual.

2.6.7 Engineering Reports

Engineering Reports shall be digitally signed, by the applicable person using a certifying. See section 2.7 for instructions on how to apply a certifying signature to an engineering report. If a report needs to be digitally signed by more than one person, the first person must apply a certifying signature as shown in section 2.7 and any subsequent signature will be a signing signature as shown in section 2.7.
2.7 Applying Digital Signature Workflows

This section applies to both CTDOT designed projects and Consultant designed projects. The figures contained in this section show a CTDOT signature where the document is located in Projectwise, but the workflows are the same.

Certifying Signature:

1. Left click on the signature field and then update the settings as shown below. Examples below are for a CTDOT designed project’s title sheet and the first sheet of an Engineering Report:

**Certifying Discipline Subsets**

![Figure 57 - Certifying Discipline Subsets](image)

**Engineering Reports or Documents that Require (1) Digital Signature**

**FINAL HYDRAULIC REPORT**
**FOR SOUTH MAPLE STREET BRIDGE**
**OVER SCANTIC RIVER**
**(Bridge No. 03972)**

Enfield, Connecticut

PREPARED BY: Tectonic Engineering & Surveying Consultants PC
March 8, 2010

Prepared By: ______________________ Date: 1/21/14

Checked By: ______________________ Date: 1/21/14

and

![Figure 58 - Certifying Engineering Reports](image)
2. Next for document in located in Projectwise click Projectwise V8i as shown below and then click OK. If the document is located on your computer click My Computer list below:

![Figure 59 - Certifying Signature](image)

3. Then select yes to overwrite existing file as shown below for projectwise or if the document is located on your computer overwrite the existing file or save to a new location:

![Figure 60 - Certifying Signature](image)

4. If using Projectwise check the document back into Projectwise.
Digital Signing Signature:
Once the prime engineer applies his certifying signature the additional signing signatures can be applied by the sub-consultants as follows:

1. Left click on the signature field and then update the settings as shown below:

![Signature Input](image1)

![Signature Settings](image2)

**Figure 61 - Signing Signature Bluebeam**

2. Next for document in located in Projectwise click Projectwise V8i as shown below and then click OK. If the document is located on your computer click My Computer list below:

![Save To](image3)

**Figure 62 - Open from Projectwise**
3. Then select yes to overwrite existing file as shown below for projectwise or if the document is located on your computer overwrite the existing file or save to a new location:

![Overwriting a File](image)

**Figure 63 - Overwriting a File**

4. If using Projectwise check the document back into Projectwise.
Section 3  Projectwise and Submitting Documents to CTDOT

This section details Projectwise and the procedures for submitting and checking documents that are submitted to CTDOT.

3.1 Discipline Subset PDF Checker

The Discipline Subset PDF Checker software was developed to check that Contract Plan Discipline Subsets are formatted and delivered to CTDOT correctly. This checker replaces the old requirements of attaching the discipline subset checklist to each subset and stamping each subset with the green QA/QC stamp. These two things are no longer required.

This checker is an add-on to Projectwise Thick Client and can only be run using Projectwise Thick Client. See section 3.1.2 for the typical workflows for using the PDF Checker. This section provides details for Projectwise Thin Client users.

The following details what is checked with this software:

1. CAD Requirements have been completed correctly:
   a. Page Size (see section 1.4.1)
   b. Searchable Text (see section 1.4.1)
   c. Levels (see section 1.4.1)

2. PDF post processing steps have been completed correctly:
   a. Page labels (see Section 1.6.2)
   b. Sheet numbers (see Section 1.6.2)
   c. Watermarks and flatten comments(see Section 2.4)
   d. Any digital signature fields (see Section 2.5)
   e. Digital Signature (see Section 2.6)

3. The subset was uploaded and attributed correctly in Projectwise.

After the PDF checker is run, an Excel report is created detailing what is incorrect on each subset. Things that are incorrect will show up red and include a note on what is incorrect. Also an attribute in Projectwise call Format Compliance will be set to PASS or FAIL when a document is run through the checker:

![Figure 64 - Format Compliance Attribute](image)

The PDF checker must be run on all discipline subsets that are submitted to CTDOT, which includes the following submittal types: FDP, DCD, DCD2, ADP, ACD, or DCO submittals.
3.1.1 Installing the PDF Checker

This is step is for consultants only, DOT staff already have the checker installed.

1. Download the PDF checker executable from this link: Discipline Subset PDF Checker
2. Close Projectwise if it is open.
3. Run the executable.

3.1.2 Typical Workflow for using the PDF Checker

CTDOT Designed Projects
The following details the typical workflow for a CTDOT designed project.

1. Each discipline prepares their subset(s) and uploads their unsigned subsets into Projectwise in accordance with this manual.
2. Then the PDF Checker is run on the unsigned subset(s). By running the checker on the unsigned subsets, any errors can be found before the Principal digitally signs. Note: An error will be returned that a signature was not found and the Projectwise attribute will show FAIL.
3. If there are any other errors, other than the signature error, they shall be fixed. If the only error in the report is the signature error, then the plans can be digitally signed by the principal.
4. After the plans are digitally signed, run the PDF Checker again on the subset(s) to check the digital signature was applied correctly. If there are no errors then the check is complete. If there are any errors they shall be fixed and the PDF Checker rerun.
5. The project lead should check in Projectwise that all subsets have PASS in the Format Compliance attribute column.
6. The Processing unit will be looking for the Format Compliance attribute column to be set to PASS before they process the subset.

Consultant Designed Projects
The following details the typical workflow for a Consultant designed project:

1. Each consultant prepares their subset(s) and uploads their subsets into Projectwise in accordance with this manual.
2. Then the PDF Checker is run on the subset(s). If the consultant or sub-consultant does not have Projectwise Thick Client, contact your CTDOT Consultant Liaison or the lead consultant on the project to run the PDF Checker on those discipline subsets. Any error shall be fixed and the checker rerun until the report does not have any red errors.
3. The CTDOT Consultant Liaison or the lead consultant should check in Projectwise that all subsets have PASS in the Format Compliance attribute column.
4. The Processing unit will be looking for the Format Compliance attribute column to be set to PASS before they process the subset.
3.1.3 Using the PDF Checker

This software has the capability to check one subset at a time or multiple subsets. The following shows how to check multiple discipline subsets, but the procedure is the same for checking one subset.

1. Log into Projectwise.
2. Browse out to your project and open the 100_Contract_Plans folder.
3. Select a discipline subset(s) or all the subsets, right click and select DMSconform>PDF Check. Hold control or shift to select multiple subsets.

4. Click OK on the dialog box shown below:

Figure 65 - Selecting the Subsets and Running the Checker

Figure 66 - PDF Checker
5. After the PDF Checker runs click Yes Report on the dialog box shown below. Note: The PDF Checker may take a few minutes to process depending on the size of the files it is checking.

![Figure 67 - PDF Checker Report](image)

6. In the report, errors will show up in red and if you hover over a red piece of text it will show the details of what is incorrect. If any false errors show up in the report, please notify DOT.AECApplications@ct.gov with the project and document(s) you are having issues with. Example of false errors could be the page labels were applied to the subset but the report details they were not.

![Figure 68 - PDF Checker Report](image)

The Format Compliance attribute will also be set when the checker is run. It will return a PASS or FAIL value as shown below:

![Format Compliance Attribute](image)

7. If there are no errors in the report and all document have PASS in the Format Compliance attribute, this process is complete. If there are errors, the errors shall be fixed and the checker rerun.
3.2 Projectwise

CTDOT is currently using Bentley’s ProjectWise as a data management software for digital projects. Projectwise allows the CTDOT, and authorized business partners to access its data anywhere internet access is available. Projectwise shall be used by all consultant engineers delivering digital contract documents. The following link is an introduction to CTDOT’s Projectwise Site: Projectwise Presentation - April 2015

3.2.1 ProjectWise

Consultant engineers may use either Projectwise thin client or Projectwise Explorer Client (thick client).

Thin client is a web based version of Projectwise, which does not require any software installations. All that is required to login to the appropriate webpage is a user name and password supplied by CTDOT. Thin client allows access to the CTDOT dataset anywhere internet access is available. To use Thin Client a few internet settings must be set the first time a user logs in, see this document for setting up Thin Client for the first time: Thin Client First Time Set Up

The thick client conversely requires the installation of the Projectwise client software. In addition to performing all the functions of thin client; thick client has the addition functionality:

- Delta file transfer – Improves speed of downloads
- Managed workspaces – Eliminates the need to install the CTDOT DDE
- Attributing multiple documents at once

Users can get Projectwise thick client for free if they have an active license of Microstation. Download Projectwise Explorer Client from Bentley using your select ID. Once Projectwise is installed on your computer use this document to connect to the datasource:

Connecting to Datasource Using Thick Client

Users can get to our Projectwise Datasource using the following various applications. The table below lists the server URL for each application:

<table>
<thead>
<tr>
<th>Applications</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Projectwise</td>
<td>ctdot-ws.projectwiseonline.com/pwmobileaccess</td>
</tr>
<tr>
<td>WorkSite</td>
<td><a href="https://Cdot-ws.projectwiseonline.com/ws">https://Cdot-ws.projectwiseonline.com/ws</a></td>
</tr>
</tbody>
</table>

The following workflow shows how to log in and change your password: Projectwise Log in

If you do not have a Projectwise User name and password fill out the following form: ProjectWise New User Form

Consultant firms are usually given (2) user names that can be used by the whole firm. More than one person can use the user name at a time. It is the firm’s responsibility to manage the user name and password in cases where employees leave and work at another firm. This way the employee that leaves cannot use their old company’s user name and password.
3.2.2 Projectwise Folders for Contract Documents

This section gives directions on which folder contract documents will be submitted in Projectwise.

If two or more projects are being combined into (1) project, all contract documents for these projects will be submitted into the lowest numbered project in Projectwise.

100_Contract Plans (PDF) – This folder contains only final Contract Plan Discipline Subsets. This includes all Final plans, Addendum plans, Design Initiated Change Order, As-Builts, and FIO Plans. There shall not be any working documents uploaded into these folders.

110_Contract Documents (PDF) – This folder contains final signed Contract and other related documents such as: SOM (Source of Materials), Insurance documents, DBE, Bonds, etc. This folder also contains any revisions to the contract such as Change Order specifications.

120_Contractor Submittals (PDF) – This folder contains all working and shop drawings submittals. There shall not be any working documents uploaded into these folders.

130_Engineering Reports – This folder contains all the final engineering reports that are to be made available for the Contractor. There shall not be any working documents uploaded into these folders.

- Hydraulic
  - Hydraulic Report and Hydraulic Report Data
  - Scour Report and Scour Report Data
  - Floodway Report and Floodway Report Data
  - Final Drainage Reports and Final Drainage Report Data

- Environmental Compliance
  - Task 110
  - Task 220
  - Underground Storage Tank System Closure Reports
  - Executed Agreements
    - Sidewalk Maintenance Agreement
    - Lighting Agreement
  - Proprietary Item Approval
  - Standalone Transportation Management Plan Document, taken from the final design report

- Bridge
  - Rehabilitation Study Report
  - Load Rating

140_Administration – This folder is for final correspondence such as agreements, letters, memos, etc. and the design phase schedule.

- Design Phase Microsoft Project Schedule
- Sidewalk Maintenance Agreement
- Lighting Agreement

150_GIS – This folder contains the project polygon and parcel polygon files and their associated kml files.

210_Construction Folders
- Construction Survey – This folder is still in development.
Connecticut Department of Transportation – Digital Project Development Manual

- **Office_Of_Construction** – This folder is still in development.

**220_FHWA** – This folder is used for FHWA documents.

**230_Contract Administration** – This folder is used by CTDOT Contracts.

**240_Contract Development** – Designer shall submit the following supplemental contract documents into this folder:

- All contract specifications and Notice to Contractors (NTC), in word format, both final and addendum specifications
- Proposal Estimate
- Federal Estimate
- Calendar Day Estimate
- Final Design Report
- Categorical Exclusion
- Design Approval Letter
- Environmental Permits
- DBE/SBE Approval with percentage
- Commitment list
- Agreements
- Proprietary Item Approval
- Standalone Transportation Management Plan Document, taken from the final design report

**310_Review_Documents** – The designer shall submit all non-final design documents into this folder. This includes plans, specifications, reports, estimates, Property Maps (pdf), etc.

**320_Permit_Development** – This folder is still in development.

**330_Design_Data** – Under this folder is a sub-folder for each discipline that is used for all their design documents.

**500_Pre_Design Folders**

- **01_Planning** – This folder is still in development.
- **02_Concepts** – This folder is still in development.
- **03_Central_Surveys** – This folder is still in development.
- **04_District_Surveys** – This folder is still in development.
- **05_Property_Maps** - CTDOT or Consultant Surveyors shall upload the following files into this folder:
  - Polygon ROW Parcel Microstation File (.dgn) for each affected parcel on a project.
  - Property Map (.dgn)
  - Final Property Map (pdf)
3.2.3 Uploading Documents - ProjectWise (Thin Client)

The following shows how to upload Contract plans into the 100 Contract Plan folder in ProjectWise, but this procedure can be followed for uploading documents into any folder in ProjectWise.

1. Once logged into ProjectWise browse out to project and folder you need to upload into. Then go to View>Interfaces and select the “CTDOT_Doc_Code” Interface.
2. Next select Document>Upload as shown below:

![Figure 70 - Uploading Document into ProjectWise (Thin Client)](image)

3. Next browse out to the document you want to upload.

![Figure 71 - Uploading a File to ProjectWise](image)
4. After the file uploads, right click on the file and select Properties:

![Right Click on the file and select Properties]

5. Then assign the applicable attributes from the tables in Appendix E: If you cannot assign attributes, the interface was not selected as detailed in step 1 or this section.

![Select these attributes]

![Type in these attributes]

![Select these asset attributes if necessary]

![Click Save]

**Figure 72 - Select Properties**

**Figure 73 - Thin Client Attributes**
3.2.4 Uploading Documents – Projectwise (Thick Client)

The following shows how to upload Contract plans into the 100 Contract Plan folder in Projectwise, but this procedure can be followed for uploading documents into any folder in Projectwise.

1. Select the Interface “CTDOT_Doc_Code” as shown below, if the interface box is not shown go to View>Toolbars and select interface.

2. Drag and Drop files into the correct folder in the Project.

---

Figure 74 - Uploading Into Projectwise (Thick Client)
3. Select the “Advanced Wizard”
4. Click “Next” until you reach the figure below:
5. Then assign the applicable attributes from the tables in Appendix E: If you cannot assign attributes, the interface was not selected as detailed in step 1 or this section.

```
Figure 75 - Attributing (Thick Client)
```

7. On the create document page click next and the document will be uploaded into Projectwise.
8. Once the document is uploaded the user may need to click F5 (refresh) to see the file name update.
3.2.5 Combining and Uploading Contract Specifications and CSI Special Provisions

For projects that are led by a consultant designer, FDP and Addendum Contract specifications and CSI Special Provisions shall be placed in (1) zipped folder. For projects that are led by a CTDOT design unit, FDP and Addendum Contract specifications and CSI Special Provisions shall be placed in individual zipped folders per discipline.

Addendum specifications shall be placed in (1) zipped folder and submitted into the 240 Contract Development Folder. Each page of the specification section shall be marked in the bottom right corner of the footer with “Addendum No. Y”, where “Y” equals the addendum number. Also a line shall be placed on the right side indicating where language was changed in the specification.

Design Initiated Change Orders specifications shall be placed in (1) PDF document and uploaded into the 110_Contract Documents folder. Each page of the specification shall have a “C#” and the date in the bottom right corner of the footer. An example would be, “C1 - 01/01/13”. Also a line shall be placed on the right side indicating where language was changed in the specification.

The following shows an example of a consultant designed project, but the process shall also be followed for a CTDOT designed project.

See the figures below for how to zip a folder:
1. Place all specifications (word documents) in one folder.
2. Right click on the folder and select “Compress to” option shown below:

![Figure 76 - Compress Spec. Folder](image)

Specifications shall be submitted in a zipped folder for every submittal into Projectwise. Submittals include FDP, revised FDP specifications, Addendum specifications, and revised addendum specifications. Revised FDP and addendum submissions shall only include the revised specifications.
Submitting Contract Specifications
Once logged into Projectwise the final contract specifications shall be submitted as follows:
1. Make sure the Interface “CTDOT_Doc_Code” is selected.
2. Drag and Drop the zipped specifications folder into the 240_Contract Development Folder or the pdf of the change order specs into the 110_Contract Specifications folder.
3. Use the advanced wizard and then assign the applicable attributes from the tables in Appendix E: If you cannot assign attributes, the interface was not selected as detailed in step 1 or this section.
4. Click next until the document is uploaded. The document name and file name will be automatically updated to match the CTCode when Projectwise is refreshed.

3.2.6 Uploading Supplemental Contract Documents
Once logged into Projectwise, the Final Design Supplemental Contract Documents shall be submitted and attributed into the 140 Project Administration or 240_Contract Development folder as follows:

<table>
<thead>
<tr>
<th>Document</th>
<th>Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proposal Estimate, with signed checklist</td>
<td>240</td>
</tr>
<tr>
<td>Federal Estimate</td>
<td>240</td>
</tr>
<tr>
<td>Calendar Day Estimate</td>
<td>240</td>
</tr>
<tr>
<td>Final Design Report</td>
<td>240</td>
</tr>
<tr>
<td>Categorical Exclusion</td>
<td>240</td>
</tr>
<tr>
<td>Design Approval Letter</td>
<td>240</td>
</tr>
<tr>
<td>DBE/SBE Approval with percentage</td>
<td>240</td>
</tr>
<tr>
<td>Commitment list</td>
<td>240</td>
</tr>
<tr>
<td>Executed Agreements</td>
<td>140</td>
</tr>
<tr>
<td>• Sidewalk Maintenance Agreement</td>
<td>240</td>
</tr>
<tr>
<td>• Lighting Agreement</td>
<td></td>
</tr>
<tr>
<td>Proprietary Item Approval</td>
<td>240</td>
</tr>
<tr>
<td>Standalone Transportation Management Plan</td>
<td>240</td>
</tr>
<tr>
<td>Document, taken from the final design report</td>
<td></td>
</tr>
</tbody>
</table>

1. Make sure the Interface “CTDOT_Doc_Code” is selected.
2. Drag and Drop the document into the 140_Project_Administration or 240_Contract Development Folder.
3. Use the advanced wizard and then assign the applicable attributes from the tables in Appendix E: If you cannot assign attributes, the interface was not selected as detailed in step 1 or this section. All agreements must have the applicable asset tags filled out.
4. Click next until the document is uploaded. The document name and file name will be automatically updated to match the CTCode when Projectwise is refreshed.

Revised Document
For documents uploaded into the 240_Contract Development folder, if a document needs to be revised, a new revised document shall be uploaded into projectwise with the addition of “Revised” being included in the Label.

For documents uploaded into the 140_Project Administration folder, if a document needs to be revised, the old document shall be deleted and a new document shall be uploaded. Do not include revised in the label. Contact AEC Applications to delete the file: DOT.AECApplications@ct.gov.
3.2.7 CTDOT Contracts Finalizing of Contract Specifications

CTDOT Contracts shall finalize the specifications working in the 110_Contracts_Specifications Folder following this workflow CTDOT Contracts Workflow.

3.2.8 Notification of Submittals

When Contract Plans, Specifications, and supplemental contract documents are submitted into Projectwise the applicable personnel must be notified as follows as applicable:

1. For consultant designed projects, the consultant will notify their Liaison Engineer, who will then notify, by memorandum, processing that contract plans or specifications have been submitted for review.
2. For state design projects, the project manager will notify, by memorandum, processing that contract plans and specifications have been submitted.

3.2.9 Contract Plans Workflow (FDP - Advertise)

Table 3-3 below shows how final digital design plans (FDP) flow from delivery through processing to their final state in advertising. Processing personnel shall use the following workflow: Projectwise for Processing

<table>
<thead>
<tr>
<th>Step</th>
<th>Group</th>
<th>Responsibilities of Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Designer</td>
<td>-Submits FDP subsets into the 100_Contract Plans folder 2 weeks prior to FDP.</td>
</tr>
<tr>
<td>2</td>
<td>Project Lead</td>
<td>-Changes FDP subsets to the LEAD DESIGNER State. This will lock the documents so the project lead can review the subsets prior to FDP.</td>
</tr>
</tbody>
</table>
| 2    | Processing (CTDOT)    | - Change FDP subsets to the Processing State and digitally mark up with comments and save FDP plans. Keep FDP Plans in the Processing State. If there are no comments proceed to step 7.  
- Create a comment report of these comments and save on your computers desktop. Then upload and attribute this report correctly into the 240_Contract_Development folder. |
| 3    | Designer               | - Change subsets to reflect comments made by Processing  
- Submits DCD subsets |
| 4    | Processing (CTDOT)    | - Change DCD subsets to Processing state  
- Perform a document compare on the FDP and DCD plans using Bluebeam.  
- Digitally markup DCD subsets with comments and save. If there are no comments proceed to step 7.  
- Create a comment report of these comments and save on your computers desktop. Then upload and attribute this report correctly into the 240_Contract_Development folder. |
| 5    | Designer               | - Change subsets to reflect comments made by Processing on DCD Plans  
- Submits DCD2 subsets |
- Changes DCD2 subsets to Processing state
- Perform a document compare on the DCD and DCD2 plans using Bluebeam.
- Digitally markup DCD2 subsets with comments. If there are no comments proceed to step 7.
- Create a comment report of these comments and save on your computers desktop. Then upload and attribute this report correctly into the 240_Contract_Development folder.

- Change the Sub Category Attribute of the approved subset from FDP or DCD(1,2..etc.) plans to FPL plans. STD and FIO plans shall not be change to FPL.
- Copy the CTCode and make the document and file name the CTCode. Make sure the file name has a ".pdf" on the end.
- If is a CTDOT Design project, change all discipline subsets to the Manager and Engineering Admin. Sign State. Notify Designer they have to have Manager and Engineering Admin sign the title sheet. When the Designer notifies processing these signatures have been applied to the title sheet, change all discipline subsets to the Advertise state.
- If is a Consultant Designed Project, change discipline subsets to Advertise State.
- Delete all previous versions of plans, FDP, DCD, DCD2, etc.
- Keep Comment reports in the 240_Contract_Development folder for records if necessary
- Formally notify Contracts when all subset have been approved for Advertising

**Table 3-1 Workflow for CTDOT Processing Unit (Contract Drawings)**

### 3.2.10 ProjectWise Project folder Security

Through the use of Workflows and States, Projectwise can provide dynamic securities to a folder or document. Dynamic security allows a different level of security to each document at various phases of its life cycle. This allows a document to reside in one location, in Projectwise, throughout the project life cycle.

### 3.2.11 100_Contract_Plans (PDF) Folder (Dynamic Security)

During the design submittal process the Projectwise workflow, “Contract Plans Processing”, shall be applied to this folder. This workflow allows three different states (securities settings) to be applied to documents within this folder. Each state provides a unique security. The CTDOT Contracts Processing Unit shall determine which state a document in this folder shall be in.

The “Contract Plans Processing” workflow contains the following security states:

**Document Transfer State** – allows either the Consultant or State Designer to upload, read and alter a document.

**Lead Designer State** – Allows the project lead to lock the documents so they can review the project discipline subsets prior to FDP.

**Processing State** – Allows only the processing unit read, write access, allowing them to review the documents in a secluded area. All other users shall have read access.

**Manager and Engineering Admin. Sign** – Allows the Manager and Engineering Administrator to sign the project Title sheet.

**Advertise State** - Allows all users file read access, allowing any user to open and read the document.
Once the contract is awarded to the low bidder (Contractor), the documents will move into a new workflow called "Contract Plans Construction" which hands control of the documents to the CTDOT Office of Construction (all offices).

The “Contract Plans Construction” workflow contains the following security states:

**Construction State** – allows construction to upload, read and alter a document. All other users shall only have file read.

**Perform As-Built** – allows construction to place as-built information on the plans. All other users shall only have file read.

**As-Built Complete** – All users will have read only when the documents are put in this state.

### 3.2.12 Changing the State of a Document

The designer and district construction will be required to change the state of documents for contractor submittals during the review process. To change the state of a document, follow the figure below:

1. Right click on the document that you want to change the state of, then select change state>change, as shown below:

![Figure 77 - Changing the State](image)

Right Click on a document and select "Change State" then "Change"
2. Next drag the file(s) from one state to another as shown below:

![Image of Changing the State]

Figure 78 - Changing the State

3. Click OK when the comment window opens up and the documents state will change. Next close the change workflow state window.

4. Notice the “State” column, the state of the documents has been changed.

![Image of State has been changed]

Figure 79 - State has been changed

3.2.13 Paper Plan Order Form

The Paper Plan Order Form was created to allow each unit in the Department to order contract plans and specifications for DOT Projects. This form is located in each project in Projectwise and each unit in the Department that needs paper copies of contract plans and specifications is required to update this form for their paper needs. This form is then used by the Department’s Engineering Records unit to make the prints and send them out.

Any Addendum or Change Order that is submitted for a project will be printed and sent out using the information indicated on the form. Addendums will be printed and sent out automatically. When a Change Order is submitted, the designer must notify Engineering records that a Change Order has been submitted and that paper copies of the Change Order need to printed and sent to the applicable units indicated on the Paper Plan Order Form.
This following shows the procedure for how the Paper Plan Order Form is filled out and the prints are made.

Contact Information for Engineering Records:
Print Shop: 860-594-3086 Plan and Specification Printing

<table>
<thead>
<tr>
<th>Step</th>
<th>Project Stage/Submittals</th>
<th>Group</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FDP</td>
<td>Processing</td>
<td>After the contract plans and specifications have been submitted for FDP an email is sent to each unit in the Department that requires paper copies of contract plans and specifications.</td>
</tr>
<tr>
<td>2</td>
<td>FDP</td>
<td>Units</td>
<td>Open the Paper Plan Order Form from Projectwise and fill out the form for their unit’s needs. Save the form and check the form back into Projectwise.</td>
</tr>
<tr>
<td>3</td>
<td>DCD</td>
<td>Processing</td>
<td>At DCD, lock the form by placing it in the Processing state.</td>
</tr>
<tr>
<td>4</td>
<td>Advertise</td>
<td>Contracts</td>
<td>Notify Engineering Records that the project is going to be advertised and they can print the required paper copies indicated on the Paper Plan Order Form.</td>
</tr>
<tr>
<td>5</td>
<td>Advertise</td>
<td>Engineering Records</td>
<td>Print the required paper copies indicated on the Paper Plan Order Form.</td>
</tr>
<tr>
<td>6</td>
<td>All Addendums</td>
<td>Contracts</td>
<td>Notify Engineering Records that an Addendum is going to be advertised and they can print the required paper copies indicated on the Paper Plan Order Form for this Addendum. Make sure to tell Engineering Records which subsets are included in the Addendum.</td>
</tr>
<tr>
<td>7</td>
<td>All Addendums</td>
<td>Engineering Records</td>
<td>Print the required paper copies indicated on the Paper Plan Order Form for the Addendum. Make sure to print all the subset that were affected by the Addendum including the 02-Revisions subset.</td>
</tr>
<tr>
<td>8</td>
<td>All Change Orders</td>
<td>Lead Designer</td>
<td>Notify Engineering Records that a Change Order has been submitted and they can print the required paper copies indicated on the Paper Plan Order Form. Make sure to tell Engineering Records which subsets are included in the Change Order. If a unit is not listed on the Paper Plan Order Form, give Engineer Records those units’ contact information so those units’ can receive a copy of the Change Order.</td>
</tr>
<tr>
<td>9</td>
<td>All Change Orders</td>
<td>Engineering Records</td>
<td>Print the required paper copies indicated on the Paper Plan Order Form for the Change Order and for any other units’ requested by the Lead Designer. Make sure to print all the subsets that were affected by the Change Order including the 02-Revisions subset.</td>
</tr>
</tbody>
</table>
Section 4  Contract Plan and Specification Revisions (Addenda and Design Initiated Change Order)

4.1 Addenda

Contract plans that are revised or added due to addenda shall be submitted in digitally signed PDF discipline subsets containing only the changed sheets. The sheets being revised or deleted shall not be included in the Addenda submittal. The first sheet of each addendum subsets shall be digitally signed in a digital signature place holder, that is placed in Microstation as described in Section 2.0 of this manual, DO NOT ADD an index of drawings sheet. Once digitally signed, the addendum subsets shall be submitted to CTDOT using Projectwise, as described in Section 3.0 of this manual.

Addenda sheets from different subsets cannot be combined and submitted as one subset, they must be submitted per their respected subsets.

The discipline Addenda subsets shall be attributed as follows, when uploaded into Projectwise (See Section 3.0): The addenda subset shall have the same Projectwise label as the original final plan subset with the addition of (_A##) added to the end, where the ## equals the addenda number. The sub-category attribute shall be ADP and ACD if the ADP plans are revised. See example below:

PROJECTWISE LABEL ATTRIBUTE

<table>
<thead>
<tr>
<th>Original Discipline Subset:</th>
<th>04-Traffic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addenda Discipline Subset:</td>
<td>04-Traffic_A01</td>
</tr>
<tr>
<td>2nd Addenda</td>
<td>04-Traffic_A02</td>
</tr>
<tr>
<td>6th Addenda</td>
<td>04-Traffic_A06</td>
</tr>
</tbody>
</table>

The contract sheets (previously submitted final plans or earlier addenda plans), being revised by addenda shall NOT be modified except; the Engineer of Record shall place an addenda stamp on the affected sheets. This addenda stamp crosses out the entire sheet with a red X and adds the following note; “THIS SHEET REPLACED BY ADDENDUM NO.”Y”; where “Y” equals the addendum number. This stamp is placed over digital signatures therefore; removal of the signatures is not required prior to placing the addenda stamp. For this process see Section 4.4.

WARNING – When placing the stamps, removing the digital signature is not allowed.

The Index of Revisions Sheet(s) located in the 02-Revisions subset(s) shall be managed by the project manager for all addenda, and submitted as described in Section 4.3.1. A new subset must be updated for each addendum.

A watermark of the signer’s signature; signature only for (CTDOT), or PE Stamp for (Consultants) shall be placed on all added or revised sheets. See Section 2.2

Paper copies for all Addendums will be requested by the Department’s Contracts unit and sent to all applicable units following section 3.2.13.
4.1.1 Revised Plans - Addenda

Microstation Processes
A note shall be placed, directly above the bottom right hand corner of the title block, on the replacement sheets stating “ADDITION NO. “Y”, where “Y” equals the addenda number. This note is a level in Microstation that needs to be turned on and edited.

For revised sheets the drawing numbers shall not be modified.

The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be placed within this clouded area. A like numbered triangle shall be placed in the revision block of the changed sheet, accompanied by a description of the revision itself. The revision number is specific to a particular sheet, and increases in consecutive order per revision and per addenda. If a sheet is changed for the first time under addenda five the revision number is 1 NOT 5. If it is changed again under addenda 7 the revision number becomes 2.

Note: If there are a lot of changes to a sheet and it is not possible to cloud all the changes in a clear manner, do not void out the existing sheet and create a new sheet. In these instances, the designer shall place a cloud just inside the border of the revised addendum sheet.

Note: When preparing an Addendum that will change quantities on a project that includes a "Detailed Estimate Sheet", never revise the "Detailed Estimate Sheet." A "Detailed Estimate Sheet" is never included in an addendum. Also, the "Quantities" box shown on the General Plan sheet for any structure is never to be revised.

Bluebeam Processes
Sheet numbers for revised plans shall be as follows:
Original Final Plan Sheet;

<table>
<thead>
<tr>
<th>Original:</th>
<th>02.25</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addenda 1:</td>
<td>02.25.A1</td>
</tr>
</tbody>
</table>

Previous Addenda Sheet;

<table>
<thead>
<tr>
<th>Original:</th>
<th>02.25.A2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addenda 4:</td>
<td>02.25.A4</td>
</tr>
</tbody>
</table>

If a sheet requires further revisions by a subsequent addendum, the addendum shall be prepared, as detailed above. The previously revised sheet shall now be stamped using Bluebeam after addendum approval, see Section 4.4.

4.1.2 New Sheets - Addenda

Microstation Processes
Changes that require a new sheet(s) to be added to a discipline subset shall be formatted in one of two ways, as follows:

1. If the new sheet does not have to be placed in a specific location within the discipline subset, the new sheet shall be placed last, and numbered sequentially from the last sheet of the discipline subset. The total number of sheets noted on the project plans and discipline subsets stays the same. A note shall be placed on the new sheet stating, "NEW SHEET ADDED BY ADDENDUM NO."Y", where “Y” equals the addendum number. This note shall be located directly above the right hand corner of the title block. This
note is a level in Microstation that needs to be turned on and edited. The revision block on the added sheet, shall not be filled out.

2. If the designer determines that the new sheet must go in a specific location within the discipline subset, the new sheet number shall be the number of the previous sheet followed by (-1.A#), where # is the Addendum Number. For example, if the new sheet must be placed in a discipline subset right after sheet 02.57, the new sheet shall be numbered 02.57-1.A1, if an additional sheet needs to be added, in this case it would be 02.57-2.A1. The total number of sheets noted on the project plans stays the same. A note shall be placed on the new sheet stating, "NEW SHEET ADDED BY ADDENDUM NO."Y", where "Y" equals the addendum number. This note shall be located directly above the right hand corner of the title block. This note is a level in Microstation that needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. As with the sheet number the drawing number of the new sheet shall be the drawing number of the previous sheet plus a decimal and the sheet count. For example, if the new drawing must be placed in the project plans right after drawing number S-5, the drawing number shall be S-5-1.

**Bluebeam Processes**

Added sheet numbers, inserted NOT added to the end of Subset, shall be as follows:

Original Final Plan Sheet;

Original: 04.31  
Addenda 3: 04.31-1.A3

Previous Addenda - Added Sheet;

Original: 03.24.A1  
Addenda 4: 03.24-1.A4

Previous Addenda - Revised Sheet;

Original: 05.14-1.A1  
Addenda 2: 05.14-1.A2

Previous Addenda - Added Sheet;

Original: 05.14-1.A1  
Addenda 2: 05.14-2.A2

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the previous sheet number plus .A#, where # equals the addenda number.

Original Final Plan Sheet;

Original Last Sheet: 04.31  
Addenda 3: 04.32.A3
4.1.3 Adding New Subset – Addenda

The new subset shall be submitted by an Addendum and be prepared the same way as an FDP discipline subset, with the addition of an A# in the sheet numbers and a note shall be placed, directly above the right hand corner of the title block, on the sheets stating “NEW SHEET ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number. This note is a level in Microstation that needs to be turned on and edited. The label attribute on the new subset shall contain an “_A##”. The first sheet of a new subset to the contract will be a subset cover sheet and contain an index of drawings.

4.1.4 Voiding Sheets

Sheets submitted within final design plan subsets and addenda subsets shall NOT be deleted; but shall voided by the engineer of record with an addenda stamp, using Bluebeam. This addenda stamp crosses out the entire sheet with a red X and adds the following note; “VOIDED BY ADDENDUM NO.”Y”; where "Y" equals the addendum number. See Section 4.4

4.1.5 Addenda Plans Workflow

Table 4-1 Contract Processing Addenda File Workflow for Contract Drawings below shows how addenda subsets are delivered and processed for advertisement.

<table>
<thead>
<tr>
<th>Step</th>
<th>Group</th>
<th>Responsibilities of Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Designer</td>
<td>Submits ADP subsets into the 100_Contract Plans folder.</td>
</tr>
</tbody>
</table>
| 2    | Processing (CTDOT) | Changes document to the Processing State and digitally mark up with comments and save. Keep ADP Plans in the Processing State. If there are no comments proceed to step 7.  
|      |                | - Create a comment report of these comments and save on your computers desktop. Then upload and attribute this report correctly into the 240_Contract_Development folder. Notify the designer when this is finished. |
| 3    | Designer       | Change subsets to reflect comments made by Processing  
|      |                | - Submits ACD Subsets                                              |
| 4    | Processing (CTDOT) | Changes ACD subsets to Processing state  
|      |                | - Perform a document compare on the ADP and ACD plans using Bluebeam.  
|      |                | - Digitally markup ACD subsets with comments. If there are no comments proceed to step 7.  
|      |                | - Create a comment report of these comments and save on your computers desktop. Then upload and attribute this report correctly into the 240_Contract_Development folder. Notify the designer when this is finished. |
| 5    | Designer       | Change subsets to reflect comments made by Processing on ACD Plans  
|      |                | - Submits ACD2 Subsets                                             |
| 6    | Processing (CTDOT) | Change ACD2 Subsets to Processing state  
|      |                | - Perform a document compare on the ACD and ACD2 plans using Bluebeam.  
|      |                | - Digitally markup ACD2 subsets with comments. If there are no comments proceed to step 7.  
|      |                | - Create a comment report of these comments and save on your computers desktop. Then upload and attribute this report correctly into the 240_Contract_Development folder. Notify the designer when this is finished. |
4.1.6 Addenda Specifications

Contract Specifications that are revised or added due to addenda shall be submitted digitally in accordance with section 3.2.5.

4.1.7 Addenda Report

Addenda report shall contain all the changes to the plans and specifications and any contractor questions and answers. This report shall be submitted in Word format into the 240_Contract_Development in Projectwise with the following attributes:

- Discipline = CT
- Main Category = DOC
- Sub Category = RPT
- Label = “Addn. No. # Report”, where # is the addendum number. If a report is revised the label shall include “Rev.” at the end. If the report is revised a second time the label shall include “Rev. 2” at the end, etc.
- Description = Give a brief description of the submission.

4.1.8 Addendum CTDOT Standard Drawing Subsets

The designer shall prepare an addendum to a CTDOT Standard Drawing subset in accordance with the following.

The Addendum for a standard subset shall only include the added sheets, do not include all the standards for the project. Follow section 1.8 to prepare the standard subset, only include the added sheets and check off only those sheets on the index sheets.

When uploading to Projectwise, add an “A##” to the end of the label attribute.

Update the 02-Revision subset to record this change.

4.2 Design Initiated Change Order (DCO)

Design Initiated Change Orders (DCO) are change order requests in which the designer alters the original contract by:

- A revision to an existing plan sheet(s) or specification(s)
- The addition of a new plan sheet(s) or specification(s)
- The deletion of an existing plan sheet(s) or specification(s)

The creation and management of DCO’s shall be as specified in this section.
Contract plans changed or added due to DCO’s shall be submitted in a digitally signed PDF discipline subset(s) containing only the added or changed sheets. The sheets being revised or deleted shall not be included in the Change Order submittal. The first sheet of each DCO subset shall be digitally signed in a digital signature place holder, that is placed in Microstation as described in Section 2.0 of this manual, DO NOT ADD a cover sheet. Once digitally signed the DCO subset(s) shall be submitted, to the CTDOT, using Projectwise as described in Section 3.2 of this manual.

DCO sheets from different subsets cannot be combined and submitted as one subset.

The discipline DCO subsets shall be coded as follows, when uploaded into Projectwise (See Section 3.0): The DCO subset shall have the same Label Attribute as the original final plan subset with the addition of (C###) added to the end, where the ### equals the DCO number. The sub-category attribute shall be DCO (Design Initiated Change Order) See Examples below:

<table>
<thead>
<tr>
<th>PROJECTWISE LABEL ATTRIBUTE</th>
<th>04-Traffic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Discipline Subset:</td>
<td>04-Traffic</td>
</tr>
<tr>
<td>DCO Discipline Subset:</td>
<td>04-Traffic</td>
</tr>
<tr>
<td>6th DCO</td>
<td>04-Traffic</td>
</tr>
<tr>
<td>Original Addenda Subset:</td>
<td>04-Traffic</td>
</tr>
<tr>
<td>DCO Discipline Subset:</td>
<td>04-Traffic</td>
</tr>
<tr>
<td>3rd DCO</td>
<td>04-Traffic</td>
</tr>
</tbody>
</table>

The contract sheets (previously submitted final plans, addenda plans, or DCO plans), being revised by DCO shall NOT be modified except; the Engineer of record shall place a DCO stamp on the revised sheets using Adobe Acrobat. This digital DCO stamp crosses out the entire sheet with a red X and adds the following note; "THIS SHEET REPLACED BY DESIGN INITIATED CHANGE ORDER NO."Y" –mm/dd/yy; where "Y" equals the Design Initiated Change Order number. This stamp is placed over digital signatures therefore; removal of the signatures is not required prior to placing stamp. For this process see Section 4.4

WARNING – When placing the stamps, removing the digital signature is not allowed.

The Index of Revisions Sheet(s) located in the 02-Revisions subset shall be updated by the project manager for all DCO, and submitted as described in Section 4.3.2.

A watermark of the signer’s signature, signature only for (CTDOT), or PE Stamp for (Consultants) shall be placed on all DCO sheets. See Section 2.2

Paper copies for all change orders will be requested and sent to all applicable units’ following section 3.2.13.
4.2.1 Revised Sheets – DCO

**Microstation Processes**
A note shall be placed, directly above the right hand corner of the title block, on the replacement sheets stating “DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy, where “Y” equals the Design Initiated Change Order number. This note is a level in Microstation that needs to be turned on and edited.

The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be placed within this clouded area. A like numbered triangle shall be placed in the revision block of the changed sheet, accompanied by a description of the revision itself. The revision number is specific to a particular sheet, and increases in consecutive order per revision and per change to the sheet. If a sheet is changed for the first time under addenda #5 then change for DCO #1 revision number is 2 NOT 1. If it is changed again under DCO 2 the revision number becomes 3.

Details shown on the original PDF, but no longer required, shall not be deleted on the revised PDF, but shall be crossed out. Any details to be deleted shall be crossed out with an “X” on the revised sheet. Engineering judgment must be used to produce clear and concise information for the contractor.

If the number of changes to the sheet cannot be clouded in a clear and concise manner, the existing sheet should be voided in accordance with Section 4.2.4 and a new DCO sheet created in accordance with Section 4.2.2

**Bluebeam Processes**
Sheet numbers for revised plans shall be as follows:

Original Final Plan Sheet;

- Original: 02.25
- DCO 1: 02.25.C1

Previous Addenda Sheet;

- Original: 02.25.A2
- DCO 4: 02.25.C4

Previous DCO Sheet;

- Original: 02.25.C2
- DCO 4: 02.25.C4

Drawing numbers shall not be modified on revised sheets.

Approval blocks on all new sheets shall be watermarked with a signature (CTDOT) or PE Stamp (Consultant) and the first sheet of the subset shall be digitally signed in accordance with Section 2 of this document.
4.2.2 New Sheets – DCO

Microstation Processes
Changes that require new sheet(s) to be added to a discipline subset shall be formatted in one of two ways, as follows:

1. If the new sheet does not have to be placed in a specific location within a discipline subset, the new sheet shall be numbered sequentially from the last sheet of the discipline subset. The total number of sheets noted on the project plans and discipline subsets stays the same. A note shall be placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy” where “mm/dd/yy” equals the month, day and year the change order request was submitted. This note shall be located directly above the title block. This note is a level in Microstation that needs to be turned on and edited.

2. If the designer determines that the new sheet belongs in a specific location within a discipline subset, the new sheet number shall be the number of the sheet it most closely relates to followed by (-1.C#). For example, if the new drawing should reside in the 03-Highway discipline subset right after sheet 03.57 but before sheet 03.58, the new sheet shall be numbered 03.57-1.C#.

The total number of sheets noted on the project plans stays the same. A note shall be placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy” where “mm/dd/yy” equals the month, day and year the change order request was submitted. This note shall be located directly above the bottom right hand corner of the title block. This note is a level in Microstation that needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. The drawing number of the new sheet shall be the drawing number of the sheet it most closely relates to followed by (-#). For example, if the new drawing must be placed in the project plans right after drawing number HWY-10, the drawing number shall be HWY-10-1.

Bluebeam Processes
Added sheet numbers, to a specific location, shall be as follows:

Original Final Plan Sheet;
   Original:  04.31
   DCO 3:  04.31-1.C3

Previous Addenda – Added Sheet;
   Original:  03.24.A1
   DCO 4:  03.24-1.C4

Previous DCO – Revised Sheet;
   Original:  02.45.C1
   DCO 2:  02.45.C2

Previous Addenda - Added Sheet;
   Original:  05.14-1A1
   DCO 2:  05.14-2.C2

Previous DCO – Added Sheet;
   Original:  02.45-1.C1
DCO 2: 02.45-2.C2
If adding sheets to the end of a subset, the new sheet number shall be a continuation of the previous sheet number plus C#, where # equals the Design Initiated Change Order Request number.

Original Final Sheet

Original Last Sheet: 04.35
DCO 4: 04.36.C4

4.2.3 New Subset – DCO
The new subset shall be submitted by DCO and be prepared the same way as an FDP discipline subset, with the addition of an C# in the sheet numbers and a note shall be placed, directly above the right hand corner of the title block, on the replacement sheets stating “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy, where “Y” equals the Design Initiated Change Order number. This note is a level in Microstation that needs to be turned on and edited. The label attribute shall contain “_C###”. The first sheet of a new subset to the contract will be a subset cover sheet and contain an index of drawings.

4.2.4 Voided Sheets
Sheets submitted within final design plan subsets, addenda subsets, or design initiated change order subsets shall NOT be deleted; but shall be voided by the engineer of record, with a DCO stamp using Adobe Acrobat or Bluebeam. This DCO stamp crosses out the entire sheet with a red X and adds the following note; "VOIDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy; where "Y" equals the Design Initiated Change Order number. See Section 4.4

4.2.5 DCO Specifications
Specifications shall be created in accordance with the Departments policies and procedures for Contract Development. The Engineer shall also combine all specifications into (1) PDF document and upload that into the 110_Contract Specifications (PDF) folder in Projectwise following section 3.2.5.

4.2.6 DCO CTDOT Standard Sheet Subsets
The designer shall prepare a DCO to a CTDOT Standard Drawing subset in accordance with the following.

The DCO for a standard subset shall only include the added sheets, do not include all the standards for the project. Follow section 1.8 to prepare the standard subset, only include the added sheets and check off only those sheets on the index sheets.

When uploading to Projectwise add an “C###” to the end of the label attribute.

Update the 02-Revision Subset to record this change.

4.3 02-Revisions Subset
The project manager is responsible for managing this subset. The subset can be downloaded from these links:

CTDOT Designed Projects - 02-Revisions Subset
Consultant Designed Projects - 02-Revisions_CE_Subset
Each project has a 02-Revisions subset and this subset only contains the, “Index of Revisions Sheet(s)”. These revision sheets are used for tracking all sheet changes due to addenda (ADP) and Design Initiated Change Order (DCO) with respect to the entire project. The 02-Revisions subset starts out as an un-signed blank place holder in the project. The figure below is an example of a blank 02-Revisions subset:

**ADDENDA:**

When the project requires an Addendum, the Project Manager must record these changes on a NEW 02-Revisions_A## subset, where A## equals the Addendum ##. New 02-Revisions subsets shall contain all previous Addendum information. For example, Addendum 4 shall include all changes made from Addendums 1, 2, 3 and 4.

Note: A New 02-Revisions subset is required for each addendum because there are times when multiple addendums are being submitted to processing for the same project. An example of this is if Addendum 1 and Addendum 2 are submitted to processing at the same time, two addendum revision sheets must be submitted.

**DESIGN INITIATED CHANGE ORDER:**

When a project requires a Design Initiated Change Order (DCO), the following process shall be followed:

For each DCO, the Project Manager shall AMMEND the 02-Revisions subset. The 02-Revision subset shall always contain all previous Addendum information and the new DCO information. For example, when DCO #1 is prepared, the 02-Revisions subset shall include all Addendum information as well as the changes made for DCO #1.

The following figures are an example of the “Index of Revisions Sheet(s)” completed up to Addendum #3:

Issued 04-2016 87 Version 3.13
Detail A from figure 1 shows the information typed in for a change to the contract plans. The project designer inputs the Addendum or DCO number, the sheet number, the date, a description of the change, the person who made the change, and checks the appropriate box for: new sheet added, revised sheet or deleted sheet.

Detail B from figure 1 shows the title block information.
4.3.1 02_Revisions Subset Workflow - Addenda

Each time an addendum is issued, the “Index of Revisions sheet” must be updated by the Project Manager as follows:

1. The user will export/download the latest 02-Revisions subset out of Projectwise to their local computer.

2. With your digital signature USB key inserted within the USB, right click on the Signature Box and select Clear Signature as shown below, this is the first Addendum this step can be skipped since the subset will not have a signature on it:

![Figure 84 Clearing the Digital Signature](image)

3. Enter the information into form fields as described in section 4.3.4.

4. Add note “ADDENDUM NO. Y” in the bottom right hand corner of the sheet above the title block, where Y = the Addendum number.

5. Add new revision sheet each time previous sheet becomes full. Add note “NEW SHEET ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number. Follow section 4.3.3 of this document.

6. When finished sign using a certifying signature as shown in Section 2.6.2

7. Upload the document into Projectwise.

8. Attribute the subset: Main Category = CON, Sub-Category = ADP, Label = 02-Revisions_A##

9. Make the document description 02-Revisions_A##.

4.3.2 02_Revisions Subset Workflow - DCO

The following workflow shall be used by the Project Manager for recording DCOs to the 02-Revisions subset. In this workflow the user edits the subset in Projectwise, they do not have to export the document out and submit a new subset:

1. Check out the 02-Revisions subset from Projectwise.

2. With your digital signature USB key inserted within the USB, right click on the Signature Box and select Clear Signature as shown below, this is the first Addendum this step can be skipped since the subset will not have a signature on it:
3. Enter the information into form fields as described in section 4.3.4.

4. Edit the note above the title block with “DESIGN INITIATED CHANGE ORDER NO. Y - mm/dd/yy”

5. If a new revisions sheet is added, add the note above the title block with “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy”

6. Resign the 02-Revision subset in accordance with Section 2.6.2

7. In step 7 “Check In” the document into Projectwise

4.3.3 Adding a New Revisions Sheet to the 02_Revisions Subset

1. Download a new “Index of Revisions sheet” from Section 1.4 step 16.

2. Insert the new sheet into the existing 02-Revisions subset pdf. Update the title block information and update the sheet accordingly.

4.3.4 Filling Out Revision Index Sheet

To fill out a form field simply click on the box and begin typing. The first column is the Addendum or Design Initiated Change Order. The second column is the revised or new sheet number. The third column is the date, followed by a brief description that is similar to the description on the actual sheet being revised. Finally click in the appropriate check box per row to describe the action taken, new sheet, revised sheet, or sheet deleted. Note: The Engineer is not required to input changes numerically by Sheet No. If another changed sheet is added to an Addendum in the eleventh hour, it can be placed at the bottom of the list on the “Index of Revisions Subset”.
4.4 Placing Stamps on Affected Sheets – Revised, or Deleted Sheets

A digital stamp that crosses out the entire sheet shall be placed on digital contract sheets that are affected by Addenda or Design Initiated Change Order. The stamp shall be placed using Bluebeam’s Stamp tools and can be found in the tool chest under the miscellaneous stamps or in Markup>Stamps as shown below:

If you do not have the stamp in the tool chest you need to download the CTDOT Bluebeam User Profile as shown in Appendix A. If you do not have the stamp in the Markups>Stamp area, see Appendix A – Bluebeam Stamps

WARNING – When placing the stamps, removing the digital signature is not allowed.

Table 4-1 below lists the notes that shall be used for addenda, construction order requests, and as built notes. These notes should be used in conjunction with the cross-out stamp.

The following shows how to apply the stamp to the sheet that needs to be crossed out for an Addendum or Change Order.

1. Select the stamp from the Tool chest or Markup>Stamps and place it:
2. After the stamp is placed a box will pop up. Enter the applicable note from table 4-1 below in **all caps** as shown below:

![Addendum and Change Order Stamp]

**Figure 89 - Enter Note for Addendum and Change Order Stamp**

<table>
<thead>
<tr>
<th>Addendum Notes</th>
<th>Description of Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>THIS SHEET REPLACED BY ADDENDUM NO. Y</td>
<td>The revised sheet is considered to replace, in total, the original sheet.</td>
</tr>
<tr>
<td>VOIDED BY ADDENDUM NO. Y</td>
<td>Sheet is voided by Addendum.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Design Initiated Change Order Notes</th>
<th>Description of Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>THIS SHEET REPLACED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy</td>
<td>Used for revisions to existing sheets. Changes must be noted only on the revised sheet.</td>
</tr>
<tr>
<td>VOIDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy</td>
<td>Use this for voiding of existing sheets.</td>
</tr>
</tbody>
</table>
3. The following shows a completed stamp.
Section 5  As-Built Comments - Final Plans

As stated in the CTDOT’s Construction Manual chapter 1-313 “Final Revisions of Plans and Cross Sections”, it is the responsibility of either the Contracting Engineers (Consultant Inspectors) or State Forces (Office of Construction) to perform final as-built revisions of Contract Plans. As-Built revisions shall be recorded in accordance with Chapter 1-313 of the Construction Manual, amended as follows:

Final as-built revisions will be applied to the digitally signed PDF plans as a digital comment, using Adobe or Bluebeam’s commenting tools. Digital comments are placed over the top of the digital signature and its security, therefore, the original content of the PDF plans can never be altered. Because as-built comments are digital and placed over the top of the plans they are easily recognizable, searchable, and may be turned off if necessary.

As-built comments shall be applied to the latest sheet, whether it’s the original, addenda, or construction order plans, located in ProjectWise within the project’s 100_Contract Plans folder.

If additional As-Built information has been created, (information that cannot be placed on the digitally signed contract plans), these sheets shall be combined by subset number and uploaded into the 100_Contract Plans folder in Projectwise.

CAD drawings may be updated, at the discretion of each design office, to reflect any addenda, change orders, and as-built revisions for use in the future; however the original digitally signed as-built PDF plans shall not be replaced and shall be the PDF set for permanent records.

5.1 As-Built Revisions (Digital Comments) Workflow

Two methods for applying as-built revisions to the digital PDF plans are provided in the following sections; 5.1.1 and 5.1.2.

The first method, Section 5.1.1 Post Construction, district staff shall record as-built revisions on their record set (paper copies) during construction. Once construction is completed these revisions shall then be applied as comments to the digital PDF per the workflow in section 5.1.1.

The second method, using Section 5.1.2 Active As-Built, district staff shall record as-built revisions on their record set (paper copies), and shall apply them as comment to the final set of digital PDF plans on an intermittent bases, during construction. By using this method as-built information becomes available to all parties that have access to ProjectWise during the construction process, improving communication and transparency.
5.1.1 Post Construction As-Built

<table>
<thead>
<tr>
<th>Step</th>
<th>Personnel</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chief Inspector</td>
<td>Notify the Contracting Engineer or Designated District Staff that As-Builts can be applied to the Contract Plans.</td>
</tr>
<tr>
<td>2</td>
<td>Contracting Engineer or District Staff</td>
<td>Change the state of the Contract Plans to “Perform As Built”, see Section 3.2.12</td>
</tr>
<tr>
<td>3</td>
<td>Contracting Engineer or District Staff</td>
<td>Apply As-Built revisions to the Contract Plans in accordance with Section 5.3</td>
</tr>
<tr>
<td>4</td>
<td>Contracting Engineer or District Staff</td>
<td>Change the state of the Contract Plans to “As Built Complete”, see Section 3.2.12</td>
</tr>
<tr>
<td>5</td>
<td>Contracting Engineer or District Staff</td>
<td>Notify all applicable personnel list in the Section 5.4.2 that the As-Builts have been completed for this project.</td>
</tr>
</tbody>
</table>

5.2 As-Built Markup of Contract Plans

All as-built information will be placed using a few basic Bluebeam commenting tools. These tools include text tools, line and arrow tools, and stamp tools (all other tools will still be available under the main toolbar). These tools will be in the right-hand panel under “CTDOT As Built Tools” tool box when the CTDOT As-Builts Profile is selected (see CTDOT Bluebeam Profile):

![As-Built Commenting Tools](image.jpg)

Figure 92 - As-Built Commenting Tools
5.3 Applying As-Built Comments to Contract Plans

5.3.1 Before Using Bluebeam for As-Builts

All CTDOT users are required to complete the steps in Appendix A prior to applying as-built revisions. By completing these steps as-built revisions will be standardized across all CTDOT users. These steps only need to be completed the first time using Bluebeam or when the user logs into a new computer.

- Perform the initial login steps for Bluebeam. Initial Log Into Bluebeam
- Download the CTDOT Bluebeam profile. Download CTDOT Bluebeam Profile
- The user must have a ProjectWise login/password. Contact Julie Annino if you do not have a Projectwise Username and Password.

5.3.2 Opening the Contract Plans from ProjectWise

The contract plans are located in the 100_Contract_Plans folder of the project in ProjectWise, as shown below:

![Figure 93 - Location of the Contract Plans in Projectwise](image-url)
1. Login into Projectwise, then browse to the 100_Contract_Plans folder of the project you are working on.

2. To open a document with Bluebeam right click on the document, and select “Open With” as shown below:

   ![Figure 94 - Open With Bluebeam](image)

   Right click on the plan subset to open and select "Open With"

3. Select the Bluebeam icon and check “Always use this program” and select OK. The document will now be checked out of Projectwise and open with Bluebeam:

   ![Figure 95 - Open with Bluebeam](image)

   Note: Since we checked “Always use this program”, the next time you open a pdf in ProjectWise all you need to do is double click on the file.
4. After the As-Builts are applied to the contract plans click save in Bluebeam and then select “Check In” when a projectwise dialog box pops up. If the document is not checked back into Projectwise the As-Builts will not be uploaded to Projectwise.

5.3.3 Applying Digital As-Built Stamps

5.3.3.1 Construction Started & Completed Dates

The construction started and complete date stamps must be applied to the PDF title sheet, located in the 01_General subset, as stated below:

1. Select the “ConstructionStartedandCompletedDates” stamp from the “CTDOT As Built Tools” tool box and place it at a conspicuous location on the title sheet:

![Figure 96 - Construction Started and Completed Date Stamp](image)

2. Enter Start and end and click OK as shown below:

![Figure 97 - Entering the Dates for the Stamp](image)
Below is an example of the placed stamp:

**Figure 98 - Placed Stamp**
5.3.3.2 This Sheet Not Corrected Stamp

This stamp must be placed on all PDF sheets that do not contain as-built revisions. Detail Estimate Sheets must never be revised; therefore, they always receive this stamp.

1. To place the “THIS SHEET NOT CORRECTED” stamp on an individual PDF sheet, select that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the sheet, by clicking once.

If the majority of the sheets do not contain as-built revisions it is easier to apply this note to every sheet included in plan set, including the as-built revised sheets, and then go back and remove it from the sheets that were corrected.

1. To place the “THIS SHEET NOT CORRECTED” stamp on the entire plan set, select that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the first sheet in the plan set:

Figure 99 - Placing the "This Sheet Not Corrected Stamp"
2. Right click on the stamp that was placed and select “Apply to All Pages”:

![Image of Right Click on Stamp]

Figure 100 - Placing the Stamp on All Pages

This will place the “THIS SHEET NOT CORRECTED” stamp on every plan sheet within the pdf set.

NOTE: You must go back and replace this note on the sheets that contain as-built revisions with the appropriate stamp.
5.3.3.3 This Sheet Corrected

This stamp must be applied to all PDF sheets that contain as-built revisions.

1. To place the “THIS SHEET CORRECTED” stamp on an individual PDF sheet, select that stamp from the CTDOT As-Built Tools tool box and place it in the lower right-hand corner of the sheet, by clicking once.

If the majority of the sheets contain as-built revisions it is easier to apply this note to every sheet included in plan set, including sheets that do not contain as-built revisions, and then go back and replace it, with the appropriate stamp, on the sheets that were not corrected.

1. To place the “THIS SHEET CORRECTED” stamp on the entire plan set, select that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the first sheet in the plan set:
   2. **NOTE:** You must go back and replace this note on the sheets that do not contain as-built revisions with the “THIS SHEET NOT CORRECTED” stamp.

5.3.4 Applying Digital As-Built Notes

To place an as-built revision, simply select any of the provided tools located within the as-built tool box shown below and apply it to the document that is being as-built.

![As-Built Tools](image-url)

**Figure 101 - As-Built Tools**
In the following example, the Line tool was used to cross out the existing text and the Text Box tool was used to add text:

![Figure 102 - As-Built Note Example](image)

Additional tools are available by selecting Markup:

![Figure 103 - Other Markup Tools](image)

These tools include:

- **A. Text** – commonly used tool for as-builts
- **B. Typewriter** – Do Not Use for As-Builts – cannot edit text
- **C. Note** - Do Not Use for As-Builts – will not print
- **D. Flag**
- **E. Pen**
- **F. Highlight**
- **G. Eraser** - Do Not Use for As-Builts – cannot edit graphics
- **H. Line**– commonly used tool for as-builts
- **I. Arrow**– commonly used tool for as-builts
- **J. Arc**
- **K. Polyline**
- **L. Callout**– commonly used tool for as-builts
- **M. Dimension**
5.3.4.1 Digital As-Built Stamps and Notes Using ADOBE

The following stamp files need to be downloaded to the user’s computer and placed in this folder:
C:\Documents and Settings\User\Application Data\Adobe\Acrobat\8.0\Stamps\. This could be either C:\ or D:\ Drive depending on your computer. With the “User” folder being the current user’s login Username. If Acrobat version 9 is being used, replace 8.0 with 9.0 in the previous sentence, if version 10 is used replace with 10.

**Stamp Files**
- As-Built stamps.pdf
- Construction started and completed dates.pdf

These stamps are to be placed following Section 5.3 above.

As-Built notes shall be placed on the plans in accordance with Section 5.3 using the Adobe commenting tools in the following format:

1. Text Font shall be Cambria 16, and the color Red.
2. All line work shall be line width 2 and the color Red.
5.3.5 Additional As-Built Information

Additional As-Built Information that cannot be applied to the contract plans can be uploaded to Projectwise for future use. This information shall be uploaded to Projectwise in accordance with the following:

- Combine the additional As-Built information into (1) PDF for each discipline subset. For example if the 03-Highway and the 04-Structures set had additional As-Built information, 2 separate PDFs would need to be uploaded to Projectwise.
- After the additional As-Built information is combined into their respective files they will need to be uploaded and attributed into Projectwise in accordance with the following:
  a. Log into Projectwise Explorer.
  b. Make sure the Interface “CTDOT_Doc_Code” is selected.
  c. Drag and drop the PDF into the 100 Contract Plans folder in Projectwise.
  d. Select the advanced wizard.
  e. Click next until you get to the attributes page shown below and assign the following attributes:
     - Discipline = CT
     - Main Category = CON
     - Sub-Category = ASB
     - Label = Subset No. and name, for example for the 03-Highway set type 03-Highways.
     - Description = Additional As-Built information for….  
  f. Then click next until the document uploads.
5.4 Notifications

5.4.1 Notifying Department Personnel

After the as-built information has been completed, the person responsible for the as-built revisions shall notify the appropriate Department personnel (via e-mail):

- Lead Designer
- Chief Inspector
- Central Surveys
- ROW
- Central Construction
- Bridge Maintenance (if a structure is on the project)
- Mathew Calkins and Julie Annino – AEC Applications [Email Mathew Calkins and Julie Annino](mailto:Email%20Mathew%20Calkins%20and%20Julie%20Annino)
Section 6  Contractor Submittals

This section details how various contractor submittals shall be formatted, submitted, and reviewed by CTDOT for projects that are not using a Document Control Software such as SharePoint or Primavera Contract Manager.

The contractor submittals that are detailed in this section are as follows:

- Working Drawings for Permanent Structures
- Working Drawings for Temporary Structures
- Shop Drawings
- Product Data
- Submittals
- RFIs
- RFCs

The following workflows take advantage of Bluebeam and CTDOT’s Projectwise site, which allow the Contractor and CTDOT to collaborate on the Contractor Submittals in a centralized location. Projectwise also allows the Contractor to access the Department’s comments quickly after the submittals are reviewed.

Contractor Requirements

The Contractor requirements for this procedure are as follows:

- Purchase a license of Bluebeam REVU or Extreme. This can be purchased from www.bluebeam.com or various resellers.
- All submittals that require a PE Stamp are required to be digitally signed using an ADOBE CDS or AATL Signature, see section 2 of this manual for more information.
- Upload all submittals into CTDOT’s Projectwise Site. Fill out the following form to have a CTDOT Projectwise username and password set up for your company: CTDOT Projectwise New User Form
- The Contractor’s instructions for this procedure can be found here: Contractor Submittal Instructions
6.1 Workflows

**SHOP DRAWING SUBMITTAL WORKFLOW**

**Submittal Preparation and Submission - Contractor**
- Browse out to the 120_ContractorSubmittals Folder of the project you are working on and open the Submittal Template.
- Once the template is opened, save it to your local computer.
- Add the drawings/documents to the file.
- Upload submittal into Projectwise and correctly attribute the file.
- Send an email notification to applicable personnel stating a shop drawing submittal is ready for their review.

**Designer’s Review - Designer**
- Change the state of the submittal to REVIEWING.
- Markup the plans as necessary stamp each drawing appropriately.
- Download and add the submittal response form to the submittal. Then add a response and digitally sign the response form.
- If all drawings are stamped:
  - **No Exceptions Noted or Exception as Noted**
  - Change the state of the submittal to CLOSED
  - Send an email notification to the Contractor stating the shop drawing submittal has been reviewed.
- If any drawings are stamped:
  - **Revise and Resubmit**
  - Change the state of the submittal to CLOSED
  - Send an email notification to the Contractor stating the shop drawing submittal has been reviewed and that a revised submittal needs to be submitted.

**Print Paper Copies for Construction - Contractor**
- Print the required paper copies of the submittal and mail to the required people.
**WORKING DRAWING FOR PERMANENT AND TEMPORARY STRUCTURES SUBMITTAL WORKFLOW**

**Submittal Preparation and Submission - Contractor**

- Browse out to the 120_Contractor Submittals Folder of the project you are working on and open the Submittal Template.
- Once the template is opened, save it to your local computer.
- Add the drawings/documents to the file.
- Upload submittal into Projectwise and correctly attribute the file.
- Send an email notification to applicable personnel stating a working drawing submittal is ready for their review.

**Construction and/or Designer’s Review – Construction, Designer**

**Construction**

- Change the state of the submittal to REVIEWING.
- Download and add the submittal response form to the submittal.
- Markup the plans as necessary and stamp each drawing appropriately.
- Add response to the response form and then digitally sign the form.
- If all the drawings/documents are Acceptable
  - Change the state of the submittal to CLOSED
  - Send an email notification to the Contractor stating the working drawing submittal has been reviewed and is has been found acceptable.
- If any of the drawings/documents are NOT Acceptable
  - Change the state of the submittal to CLOSED
  - Send an email notification to the Contractor stating the submittal has been reviewed and that a revised submittal needs to be submitted.

**Designer**

- Change the state of the submittal to REVIEWING.
- Markup the drawings/documents as necessary and stamp each drawing/document appropriately.
- Download and add the submittal response form to the submittal. Then add a response. If the submittal requires a second design unit response, forward a link to the submittal for their review.
- Send an email notification to the Construction stating their working drawing submittal review has been completed and our comments are detailed on the response form.

**Print Paper Copies for Construction - Contractor**

- Print the required paper copies of the submittal and mail to the required people.

**Connecticut Department of Transportation – Digital Project Development Manual**

Issued 04-2016  109  Version 3.13
**PRODUCT DATA SUBMITTAL WORKFLOW**

**Submittal Preparation and Submission - Contractor**
- Browse out to the 120_Contractor Submittals Folder of the project you are working on and open the Submittal Template.
- Once the template is opened, save it to your local computer.
- Add the drawings/documents to the file.
- Upload submittal into Projectwise and correctly attribute the file.
- Send an email notification to applicable personnel stating a Product Data submittal is ready for their review.

**Designer’s Review - Designer**
- Change the state of the submittal to **REVIEWING**.
- Markup the submittal as necessary stamp each document appropriately.
- Download and add the submittal response form to the submittal. Then add a response and digitally sign the response form.
- If the document is stamped: **No Exceptions Noted or Exception as Noted**
  - Change the state of the submittal to **CLOSED**
  - Send an email notification to the Contractor stating the product data submittal has been reviewed.
- If the document is stamped: **Revise and Resubmit**
  - Change the state of the submittal to **CLOSED**
  - Send an email notification to the Contractor stating the product data submittal has been reviewed and that a revised submittal needs to be submitted.

**Print Paper Copies for Construction - Contractor**
- Print the required paper copies of the submittal and mail to the required people.
RFI and RFC Submittal Workflow

**Submission - Contractor**
- Browse out to the 120_Contractor Submittals Folder of the project you are working on and open the RFI or RFC Template.
- Once the template is opened, save it to your local computer.
- Fill out the required information on the RFI or RFC form and add documents to the form as necessary.
- Upload the RFI or RFC into Projectwise and apply the correct attributes.
- Send an email notification to District Construction stating an RFI or RFC has been submitted.

**Construction and/or Designer's Review - Construction, Designer**

**Construction**
- Change the state of the submittal to REVIEWING.
- Answer/or add information the RFI or RFC and attach any documents as necessary
- Change the state of the submittal to CLOSED
- Send an email notification to the Contractor stating the RFI or RFC has been answered.

**Designers Review Required**
- NO
- YES

**Construction**
- Send an email notification to the designer stating an RFI or RFC has been submitted and requires their review

**Designers**
- Change the state of the submittal to REVIEWING.
- Answer the RFI or RFC and attach any documents as necessary
- Send an email notification to District Construction stating the RFI or RFC has been answered.
6.2 Contractor Submittal Review Process
(CTDOT/Consultant)

CTDOT/Consultant shall review the contractor submittals using Bluebeam as follows. Before starting a review make sure you have downloaded the CTDOT Bluebeam profile. This profile contains all the markup tools as well as the submittal stamp that needs to be applied to all contractor submittals.

**CTDOT Newington Employees** – The profile is located on the X:// Drive in the V8 Admin>Bluebeam Resources>Settings folder. Just double click on the file called CTDOT Bluebeam User.

**CTDOT District Construction Employees** – Save this file to your desktop and then double click on it: Bluebeam Profile

**Outside Consultants/Designers** – A custom stamp must be created that includes your company’s information. See Appendix D of this manual to download and edit the stamp for your firm.
6.2.1 Contractor Submittal Review

**CTDOT or Consultant Review**

The following shows how to review a contractor submittal. The figures show a shop drawing submittal but the procedures are the same for a Shop Drawing, Working Drawing, or Product Data submittals.

1. Log into Projectwise.
2. Browse out to your project and open the 120_Contractor Submittal folder of that project.
3. Then change the state of the submittal to be reviewed to REVIEWING. To do this right click on the submittal, select Change State, and then Next.

![Changing the State of the Submittal](image)

4. Then double click on the contractor submittal file to open and check out the file.
5. When the submittal opens, you should see the submittal cover letter followed by the shop drawings, working drawings, calculation and supporting documents, or Product Data Documents as shown below: The following shows a shop drawing submittal but the procedure is the same for a Working Drawing or Product Data submittal.

Figure 107 - Example of a Submittal

6. To review the drawings/document double click on one of the files to open it. A new tab will open as shown below. Markup the drawings/document with comments using the markup tools located in the tool chest shown below.

Figure 108 – Shop/Working Drawing Review Tools
Submittal Review Stamp

7. For CTDOT employees the submittal review stamp is located in the tool chest in Bluebeam and should be placed on an open area of the drawing. For Consultants Appendix D must be followed before their stamp is located in the tool chest.

8. To place the stamp, left click on the stamp in the tool chest and then place it.

![Figure 109 - Placing Submittal Stamp](image)

9. Next select the appropriate option from the java script window.

![Figure 110 - Submittal Review Stamp](image)
10. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging a corner as shown below:

![Resized Stamp](image)

**Figure 112 - Resized Stamp**

The stamp is now resized as shown below:
11. After the review is completed, close the file and click yes to save.

12. Repeat the review process for each drawing/document in the submittal.

Figure 113 - Saving the Shop Drawing
13. After all the drawings/documents in the contractor submittal has been review, download the Contractor Submittal Response form: Click for Form
14. Then add the response form to the submittal as shown below:

![Image of PDF Package with Add File and Open options highlighted]

**Figure 114 - Submittal Response Form**

15. Next open the form, fill out the general information part, and then fill in a response.

- **Shop Drawings, Product Data, or Other Submittal Types** - Only the top designer response will need to be filled out. Then the Designer can digitally sign the response form.

- **Working Drawings for Permanent Structures** – The Designer shall fill in the general information part and then the top designer response portion. If another design unit needs to review this submittal, notify that design unit and include a link to the document. After the Designer(s) has finished their review, they shall notify Construction. Then Construction shall open up the file, fill in a response in their area and then digitally sign the response form.

- **Working Drawings for Temporary Structures** – For submittals that do not require a design review, Construction shall fill out the general information part of the form, fill in a response, and then digitally sign the form. If the submittal requires a design review follow the same procedure as a Working Drawing for Permanent Structure.
16. After filling out the response form, save the file and close Bluebeam. Then check the document back into Projectwise by clicking on Check In in the Check In dialog box as shown below:

![Check In Dialog](image1)

**Figure 115 - Check In Dialog**

17. Then change the state of the submittal to CLOSED. The state shall be changed by the group that digitally signs the response form.

**Typical Workflows**

**Shop Drawings, Product Data, or Other Types of Submittals** - Shall have the state changed by the Engineer.

**Working Drawing** - Shall have the state changed by District Construction.

To change the state, follow the figures below:

![Changing the State of a Document](image2)

**Figure 116 – Changing the State of a Document**
18. For Shop Drawings, Product Data, or Other types of Submittals, the Designer shall send an email notification to the Contractor stating their review is complete. For Working Drawings, District Construction shall send an email notification to the Contractor.

Figure 117 - Changing the State

Click OK you do not need to enter a comment
Section 7  Digital Review and Commenting

This section details the digital review process using Bluebeam’s collaborative online review tool called “Studio”. The procedures outlined below describe how to: 1) Create a review session, 2) Invite people to a session, 3) Join a session, 4) Comment in a session, 5) Close the session, and 6) Respond to comments made in the session. Also, directions for locking the documents after the review process to create a read-only final record copy to be stored for future use are also provided.

The following video gives an overview of the Digital Review Process: Digital Review Video. Specific details are found in this document.

Connecticut Department Engineering Directive 2015-4-E, implemented this procedure.

7.1 Introduction

A digital review is when a document is reviewed in its native digital format or as a digital copy of the original paper document. Any required markups are placed directly on the document using a computer with software designed for managing digital reviews. The documents can also be printed from the review session and the paper copy marked up; however, those markups must get transferred back to the digital copy.

Advantages of a Digital Review Compared to Conventional Paper Review

2. Digital markups are searchable and sortable, by comment, author, etc.
3. Real time collaboration review process improves turnaround time and quality of the review.
4. Real time feedback allows easier handling of large amounts of data.
5. Reduces the time required to compile and resolve comments.
7. Reduces document printing.
8. Eliminates shipping cost.
9. Easily store a permanent digital record on the cloud.
10. Overall reduction in review time.

Types of Reviews:

This manual may be used as a guide to perform a digital document review on any digital document. Below is a list of examples of the types of documents that may be reviewed:

- Preliminary Design Plans
- Structure Type Studies
- Semi-Final Plans
- Final Plans for Review
- Specifications
- Engineering Reports

Review Process:

To help participants of a digital review more easily track the digital review process it has been split up into six Phases as listed below:

- Phase 1 – Preparation of the Digital Documents
- Phase 2 – Set Up Digital Review
- Phase 3 – Invite Attendees to Review
- Phase 4 – Digital Review
- Phase 5 – Ending the Digital Review
- Phase 6 – Resolve Comments
Each phase and its required steps will be discussed later in detail.

**Digital Comments:**

In this review process, all comments must be applied to the documents in the review session. Reviewers have the ability to print the digital review documents to paper and mark them up, however, when done, all must be transferred from paper to the digital documents, see Section 7.7.3. If a unit cannot print their own paper copies they should contact MaryAnn Cass by email MaryAnn.Cass@ct.gov. In the email include the project number and list documents that need to be printed, and include the address of where they are to be mailed. In the case of preliminary contract plan reviews, the original digital documents, with comments, will become the final record.

All comments associated with a design submission should be applied to the digital documents. Telephone of email comments must be applied to the correct digital document by the staff member who received them. Be sure to use engineering judgment to determine the most appropriate location for the comments in the document. General project comments can be placed on the first sheet of the document using the note markup tool in Bluebeam. This process is detailed in Section 7.7.3. If any outside entities (railroads or utilities) will not participate in the digital review, their comments with your responses should be attached to the final record copy in accordance with Section 7.7.3. It is not necessary to transpose these comments individually as all comments can be attached at one time.

**FOI Requests**

**Contract Document Digital Reviews** - After a digital review session has been completed and all the comments have been resolved, a read-only copy of the review documents with the comments and resolutions will be stored in the 310_Review Documents folder under the project.
7.2 Prerequisites

1. CTDOT has standardized its digital review process using the document format PDF, and the software Bluebeam. This software was chosen for the following reasons:
   a. Includes a collaborative live review feature (STUDIO) with real time feedback, enabling all reviewers to comment on the same document at the same time out on the cloud.
   b. A license for Bluebeam is more cost effective than competitive software like Adobe Acrobat. Thus it is much less expensive to purchase and maintain.
   c. Only the Organizer of the review is required to have a licensed copy of Bluebeam. All other attendees can participate in the digital review using Bluebeam’s free version, Bluebeam VU.
   d. Bluebeam is integrated with ProjectWise. This simplifies the delivery of the original review documents as well as saves the final reviewed copies and their comments.

2. The following table lists the software required to organize and/or participate in a CTDOT digital review. Note: It is recommended that the latest version of the software be used.

<table>
<thead>
<tr>
<th>Role</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organizer – Manages review</td>
<td>Bluebeam Extreme or Revu Standard and Projectwise Explorer</td>
</tr>
<tr>
<td>Author – Produces documents</td>
<td>Projectwise Explorer</td>
</tr>
<tr>
<td>Reviewer – Reviews documents</td>
<td>Bluebeam Extreme or Revu Standard or Bluebeam VU*</td>
</tr>
</tbody>
</table>

*Bluebeam VU is a free viewer that allows reviewers to participate in a digital review (NOT create/organize a review). When a staff or consultant is invited to a digital review and they do not have Bluebeam VU or a licensed copy of Bluebeam Revu Standard installed on their computer, a link to download Bluebeam VU will be included with the invitation. Note: An IT administrator may have to install this software on the computer.

3. All CTDOT digital review participants are required to complete the steps provided in Appendix A prior to organizing or joining a review session. Completing these steps will standardize the Bluebeam format across all CTDOT digital reviews.
7.3 Digital Review Workflow

All CTDOT digital review participants are required to complete the steps provided in Appendix A prior to organizing or joining a review session. Completing these steps will standardize the Bluebeam format across all CTDOT digital reviews.

**Roles**
- **Organizer** – The organizer sets up and coordinates the review session. For in-house projects this would be the project lead and for consultant jobs this will be the Consultant Liaison.
- **Author** – Group that produces a document(s) for the review.
- **Reviewer** – Group that participates in the review session to review documents.

<table>
<thead>
<tr>
<th>Step</th>
<th>Role</th>
<th>Task</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>Organizer</td>
<td>Coordinate the organization and preparation of the review documents. Request all Authors to upload their review documents into Projectwise.</td>
<td>Section 7.4</td>
</tr>
<tr>
<td>1.2</td>
<td>Author</td>
<td>Prepare and upload review documents into Projectwise. Notify the Organizer that this step has been completed.</td>
<td>Section 7.4</td>
</tr>
<tr>
<td>1.3</td>
<td>Organizer</td>
<td>Check that all review documents have been prepared and uploaded correctly into Projectwise.</td>
<td>Section 7.4</td>
</tr>
<tr>
<td>2.1</td>
<td>Organizer</td>
<td>Change the state of the review documents in Projectwise to “Review” and then start a Bluebeam review session.</td>
<td>Section 7.5</td>
</tr>
<tr>
<td>3.1</td>
<td>Organizer</td>
<td>Create a Digital Review memo, which includes a link to the digital review session, and send it to all Reviewers.</td>
<td>Section 7.6</td>
</tr>
<tr>
<td>4.1</td>
<td>Reviewer</td>
<td>Join the review session by clicking on the link provided in the review memo. Become familiar with the review session layout.</td>
<td>Section 7.7.1 and Section 7.7.2</td>
</tr>
<tr>
<td>4.2</td>
<td>Reviewer</td>
<td>Set Status to “Reviewing”</td>
<td>Section 7.7.3</td>
</tr>
<tr>
<td>4.3</td>
<td>Reviewer</td>
<td>Review the documents in the Bluebeam review session and place comments on documents as necessary. Documents can be printed, marked up, and then comments transferred the PDFs. If the documents cannot be printed out, send a request to engineering records.</td>
<td>Section 7.7.3</td>
</tr>
<tr>
<td>4.4</td>
<td>Reviewer</td>
<td>When finished reviewing, in Bluebeam, Set Status to “Finished”</td>
<td>Section 7.7.3</td>
</tr>
<tr>
<td>4.5</td>
<td>Reviewer</td>
<td>Send a Review Comment Memo to the Review Organizer</td>
<td>Section 7.7.3</td>
</tr>
</tbody>
</table>
### Phase 5 – Closing the Digital Review

<table>
<thead>
<tr>
<th>Section</th>
<th>Organizer</th>
<th>Task</th>
<th>Details</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1</td>
<td>Close the Bluebeam review session and check the documents back into Projectwise.</td>
<td></td>
<td></td>
<td>7.8</td>
</tr>
</tbody>
</table>

### Phase 6 – Resolve Comments

<table>
<thead>
<tr>
<th>Section</th>
<th>Organizer</th>
<th>Task</th>
<th>Details</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1</td>
<td>Notify the Authors that they can review the markups on their review documents in Projectwise. Provide them with a link to the folder in Projectwise.</td>
<td></td>
<td></td>
<td>7.9.1</td>
</tr>
<tr>
<td>6.2</td>
<td>Open the specific document(s) from Projectwise.</td>
<td></td>
<td></td>
<td>7.9.2</td>
</tr>
<tr>
<td>6.3</td>
<td>For each comment on your document, type a final resolution.</td>
<td></td>
<td></td>
<td>7.9.2</td>
</tr>
<tr>
<td>6.4</td>
<td>After all resolutions are applied to comments, Notify the Organizer that you applied your resolutions.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6.5</td>
<td>Change the state of the review documents to “Review Complete” to make all review documents read only after the resolutions have been applied.</td>
<td></td>
<td></td>
<td>7.10</td>
</tr>
<tr>
<td>6.6</td>
<td>Send out a Completion of Review Session Memo to all the personnel associated with the review session that the all comments have been resolved on the documents located in Projectwise.</td>
<td></td>
<td></td>
<td>7.10</td>
</tr>
</tbody>
</table>

### 7.4 Phase 1 – Digital Document Preparation

#### 7.4.1 Organization

Below are the guidelines by which the review documents should be organized:

**Preliminary Contract Document Reviews – PD, SF, FPFR, etc.**

1. **Plans** - Must be in discipline subsets. The review Organizer is responsible for assigning each Author a subset number in accordance with Section 1.10 or Section 1.11. Note: CTDOT Standard Subsets cannot be added to a review session because they are combined in a PDF Package (Portfolio).
2. **Specifications** – Each discipline shall combine all of their specifications into one (1) PDF document. Each discipline’s specifications will remain separate throughout the review session; they will not be combined with the other discipline’s specifications.
3. **Other Documents** – Shall be individual PDF documents.
4. All Authors must upload their documents into the 310_Review Document folder under the project in Projectwise.

**Other Reviews**

1. The only requirement for the organization of other types of reviews is that the documents must be in PDF format.

#### 7.4.2 Preparation and Format

Authors shall prepare their digital documents in accordance with the following guidelines:

**Preliminary Contract Document Reviews – PD, SF, FPFR, etc.**

1. Plans:
   a. Must be in PDF format
   b. Plans must be in discipline subsets
   c. Plans must be sized 34” x 22”
   d. Do not need watermarks, sheet numbers or to be digitally signed.
2. Specifications:
   a. Each discipline shall combine all of their specifications for review into one (1) PDF document.
b. Sized 8.5” x 11”
3. Other Documents:
   a. Must be in PDF Format

Other Reviews
1. Documents:
   a. Must be in PDF Format

7.4.3 Uploading Digital Documents
Authors shall upload their digital documents into Projectwise in accordance with the following:

For Preliminary Contract Document Reviews – PD, SF, FPFR, etc.

1. Launch Projectwise and log in.
2. Browse out to the project this review is for and open up the 310_Review_Documents folder and the specific review folder: If the three subfolders are not in the project contact Mathew.Calkins@ct.gov

Figure 119 - Projectwise Project
3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a time into Projectwise as shown below:

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface. Then you will be able to select the correct interface.

4. Select Advanced Wizard
5. Click next until the attributes screen appears as shown below. Enter the correct attributes from Table 2 below, and then click next until the document uploads.

![Figure 122 - Attributing a Document](image)

The Label attribute must start out with 30%, 60%, 90%, or 100% where applicable. This allows for the documents to be sorted together in Projectwise. Below are some examples:

<table>
<thead>
<tr>
<th>Document</th>
<th>Disc.</th>
<th>Main Category</th>
<th>Sub Category</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discipline Subsets</td>
<td>CT</td>
<td>CON</td>
<td>PRE</td>
<td>30% - 01-General, 30% - 03-Highways, etc. 60% - 01-General, 60% - 03-Highways, etc 90% - 01-General, 90% - 03-Highways, etc</td>
<td>01-General Semi Final Plans...</td>
</tr>
<tr>
<td>Specification</td>
<td>CT</td>
<td>CON</td>
<td>PRE</td>
<td>30% - HWY- Specs, 30% - SB-Specs 60% - HWY- Specs, 60% - SB-Specs</td>
<td>Highway Semi Final Specs,</td>
</tr>
<tr>
<td>PD Statement</td>
<td>CT</td>
<td>REPORT</td>
<td>Reports</td>
<td>30% - PD Statement</td>
<td>Preliminary Design Statement</td>
</tr>
<tr>
<td>Cost Estimate</td>
<td>CT</td>
<td>CALCS</td>
<td>Estimates</td>
<td>90% - Cost</td>
<td>PD Cost Estimate</td>
</tr>
<tr>
<td>Bike Assessment</td>
<td>CT</td>
<td>ANALYSIS</td>
<td>Analysis</td>
<td>30% - Bike Assessment</td>
<td>i.e. PD Bike Assessment</td>
</tr>
<tr>
<td>Calendar Day Est.</td>
<td>CT</td>
<td>CALCS</td>
<td>Estimates</td>
<td>90% - Calendar Day</td>
<td>i.e. SF Calendar Day Estimate</td>
</tr>
</tbody>
</table>

Table 2 - Projectwise Document Attributes
For Other Reviews

1. Launch Projectwise and log in.
2. Browse to the folder where the digital documents are to be stored.
3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a time into Projectwise as shown below:

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface. Then you will be able to select the correct Interface.

![Figure 123 - Uploading Documents into Projectwise](image)

4. Select Advanced Wizard

![Figure 124 - Advanced Wizard](image)
5. Click Next until the attribute screen appears shown below. Enter the correct attributes for the review documents and then click next until the document uploads. Make sure a good label and description are entered.

6. Notify the Organizer that the documents have been uploaded into Projectwise.
7.5 Phase 2 – Set Up Digital Review

The Organizer shall set up the review session in accordance with the following:

Note: The example below is for initiating a Semi-Final review but can be followed for other types of reviews.

1. Launch Projectwise Explorer from the shortcut on your desktop or the start menu.
2. Browse out to the project’s 310_Review_Documents folder. (For other reviews browse out to the folder in Projectwise where the documents are located. Note: The document does not need to be in Projectwise to use Bluebeam’s Studio feature.)
3. Select all the documents to be included in the Bluebeam review session.
4. Change the state of the documents to “Review” as shown below:

(1) Right click on the documents and select “Change State>Next”

Then click OK next on the box that pops up. The documents will now be in the Review state.

Notice State Column, the state is Review
5. Next right click on the selected documents and select Start Studio Session:

Right Click on the documents and select "Start Studio Session"

Figure 130 - Start Studio Session
6. Using the naming guidelines from the table below, type in the applicable review session name in the box entitled “Session Name”.

<table>
<thead>
<tr>
<th>Review</th>
<th>Review Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preliminary Design (30%)</td>
<td>Project #XXXX-XXXX PD Review</td>
</tr>
<tr>
<td>Structure Type Study</td>
<td>Project #XXXX-XXXX Structure Type Study Review</td>
</tr>
<tr>
<td>Semi-Final (60%)</td>
<td>Project #XXXX-XXXX SF Review</td>
</tr>
<tr>
<td>Final Plans for Review (90%)</td>
<td>Project #XXXX-XXXX FPFR Review</td>
</tr>
<tr>
<td>Other</td>
<td>Include Project number if necessary and give a good description of the review</td>
</tr>
</tbody>
</table>

Also, as shown in the figure below, make sure that all the options are checked. Note: Setting the Session Expires date is optional. If set, this date can always be changed after the session is created.

![Figure 131 – Initiating a Review Session](image)

(1) Type in the session name
(2) Uncheck
(3) Optional - Set if necessary
(4) Click OK
7. In the next dialog box click copy invitation as shown below. The invitation will be copied to the clipboard of the computer and then can be pasted into an email or memo.

Next paste the invitation into a blank Word Document or email. The following is an invitation that has been pasted into an email. Note how the session URL appears in blue. Then you can copy the URL from the blank document or email into a formal memo.
7.6 Phase 3 – Invitation to Review Session

The Organizer shall invite Reviewers to the review session in accordance with the following:

For Preliminary Contract Document Reviews – PD, SF, FPFR, etc.

The invitation to the digital review will be a PDF version of a review memorandum that includes the following:

1. A table of all documents that are in the review session.
2. Links to relevant documents that are not included in the review session but still need to be referenced. These documents shall be located in Projectwise and Projectwise links shall be included. (Not shown in the example below)
3. A link to this manual (Digital Project Development Manual)
4. A link to the Review session. To do this, paste the invitation that was copied when you created the review session.

The PDF of the review memorandum shall be emailed to all Reviewers; this should include the Principal, Supervisor and TE3 level of the reviewing unit where applicable. It is the Organizer’s responsibility to compile a complete distribution list so the review invitation gets sent to the applicable personnel. Below is an example of a memorandum for a preliminary design review:

![Sample Review Memo](image)

Figure 134 - Sample Review Memo

The Organizer shall also send out a reminder notification to all the reviewers two weeks prior to the end of the review session.

For Other Reviews

Invitations for less formal reviews may not require a memo. It is recommended that an email be sent which includes the links to this manual and the review session.
7.7 Phase 4 – Digital Review

7.7.1 Joining a Review Session

To join a review session, either click on the link provided in the review memorandum for a preliminary design review, or for less formal reviews, click on the link in the email. Below is an example of an email for a preliminary design review (semi-final). Remember the link to the review session is included in the memo that was emailed to all the reviewers.

1. Open the email from the Organizer and open the review memorandum.

Figure 135 - Review Memorandum
2. Click on the link to the Review Session.

Figure 136 - Link to the Review Session
3. Click Allow on the box that pops up in Internet Explorer. Ignore the text written in the webpage as shown below:

![Figure 137 - Accessing the Review Session](image)

To join a session click Allow

4. Bluebeam will now launch. If this is the first time in a review session, a Studio Account must be created. To do so click on Create Account and then enter in a State email address and a password. In the Name box type in the First Initial then Last name and unit. See below for an example.

![Figure 138 - Creating a Studio Account](image)

If you do not have an account click create account

![Figure 139 - Studio Session Account](image)

Type in email address
Type in Password
Type in User Name
Click OK
If this is not the first time in a review session, enter the studio login information as shown below: If you forgot your password click lost password and an email will be sent to you.

Enter your studio session email and password and click OK

Figure 140 - Review Session

5. If this is your first time into a review session you must import the CTDOT Bluebeam Profile, See Appendix A
7.7.2 Review Session Layout

Below is the typical layout in the review session. On the right tab, there are the tool chest for commenting, the attendees of the session, and the documents in the session. On the bottom, there are the list of comments.

![Review Session Layout](image)

**Figure 141 - Review Session Layout**

All comments that are made get saved instantly to the Bluebeam review session; these do not need to be manually saved. Each user can only delete their own comments and can leave and rejoin as many times as they want as long as the review session has not been closed. The review session will be closed by the Organizer in accordance with the date on the review memo.
7.7.3 Reviewing

This section shows the procedures for reviewing and commenting on documents in a digital review. Reviewers may print digital review documents to paper by going to File>Print and mark them up; however, they must transfer these comments onto the digital review documents in accordance with this section. If a unit cannot print their own paper copies they should contact MaryAnn Cass by email MaryAnn.Cass@ct.gov. In the email include the project number and list documents that need to be printed, and included the address of where they are to be mailed.

In the case of preliminary contract plan reviews, the original digital documents, with comments, will become the final record.

All comments associated with a design submission should be applied to the digital documents, including any email or phone call comments. These types of comments must be applied, by the staff member who received the email or phone call, to the correct digital document, use engineering judgment to determine the most appropriate location.

General Project wide comments can be placed on the first sheet of the document using the note markup tool in Bluebeam as shown below: Using the note tool you can copy and paste text from any source such as an email or a Word document. This allows larger project wide comments to be applied to the plans.

Figure 142 - Note Markup Tool
Note about Commenting in a Review Session and Supervisor Approvals

In most cases, the unit that reviews a document has an internal approval process whereby the supervisor finalizes the comments from staff members. The workflow described in this Chapter does not specify or dictate an approval process within each unit; rather, it outlines the review procedures once the review comments have been compiled from each unit. Therefore, it is important that only the reviewing unit’s final comments be added to the review session. Once the session ends, the comments made in a review session will be considered final.

The following shows a few options for a supervisor approval procedure, but the digital review process is flexible for any procedure a reviewing unit develops. The only restriction is the final comments must be placed on the digital documents located in the review session before the reviews session ends:

1. A lower level employee can join the session and comment on the documents in the review session. Then the supervisor can join the session and filter out their subordinates comments for their review. If there is an issue with a comment the supervisor will have to direct the lower level employee to fix that comment. If there are not any issues with the lower level employee’s comments then nothing has to be fixed. After this supervisor review, a lower level employee will join the session and fix the applicable comments. In section 7.1 of this manual there is a list of advantages to using this digital review process. With this option, all of these advantages are realized.

2. A lower level employee can join the review session and save a copy of the review documents to their computer. Then they can markup the documents offline and have their supervisor approve those comments. After the supervisor approves the comments, those comments can then be imported into the documents in the review session. In section 7.1 of this manual there are a number of advantages to this digital review process. With this option, advantages 3 and 4 are eliminated due to the comments made offline.

3. A lower level employee can join the session and print the documents in that review session. Then they can markup the prints and have their supervisor approve the comments. After the approval, a lower level employee can transfer the comments to the digital documents in the review session. In section 7.1 of this manual there is a list of advantages to this digital review process. With this option, advantages 3 and 4 are eliminated due to the comments made offline.

Notes about Outside Entities that will not Participate in a Digital Review

If an outside entity such as a railroad or utility company will not participate in a digital review it is still important to add their comments to the final record document in Projectwise. It is encouraged to have these entities participate in the digital review and AEC Applications is available to provide support and technical assistance in these efforts.

The following details how the comments from a non-participating entity and your responses to those comments shall be attached to the final record document in Projectwise:

1. Create a PDF document that includes the non-participating outside entity’s comments and your responses to those comments.
2. Then add the pages from that document to the end of the final record document in Projectwise in accordance with section 7.9.1.
Reviewer

1. First set your review status to *Reviewing* by clicking on the drop down shown below:
   Note: If you leave the session and return your status will stay as Reviewing.

   ![Set Status]

   *Figure 143 - Set Status to Reviewing*

2. Next select a document to review from the studio session tab. The document will open up and can be reviewed.

   ![Select a document to comment on]

   *Figure 144 - Selecting a Document to Comment On*
3. Select a commenting tool from the tool chest and mark up the plans. If you do not have the CTDOT Review Tools show below, follow Appendix A to have them imported in the Bluebeam Profile. Below are the commenting tools a CTDOT user will have available to them in Bluebeam.

![Bluebeam Commenting Tools](image)

**Figure 145 - Bluebeam Commenting Tools**

Custom tools can also be created. Contact DOT.AECApplications@ct.gov for custom tool development.
MUST READ BEFORE PLACING COMMENTS
The following shows best practice for applying text notes in a review session.

There are two basic commenting tools in Bluebeam: Text Tools and Non-Text Tools (line, arrow, cloud, rectangle, etc.). Each type can have a note attached to them. The text tools already have a note when you type text, but the non-text tools can also have a note attached to them. To attach a text note to a non-text tool place the comment and then double click on that markup. Then you can type in your note. The text note box must be closed after the comment is made by clicking on the X in the top right corner of the note. The example below shows a note being attached to the cloud tool the correct way:

![Figure 146 – Correct Way to Add Text to a Non Text Commenting Tool](image)

General Project wide comments can be placed on the first sheet of the document using the note markup tool located in the tool chest. Text can be copied and pasted into the note tool as necessary.
4. After you have completed your set your status to *Finished*.

Note: You can still enter the session if your status is set to Finished. You can also change your status back to *Reviewing* if necessary. This status is for the Organizer so they know which Reviewers have completed their reviews.

5. Create a review comment report of your comments. First filter out the comments so only your comments are displayed as shown below:

![Figure 147 - Set Review Status](image)

![Figure 148 - Filtering Comments](image)
6. Now that the comments are filtered by your name create a comment report as shown below:

Next type in a title for the comment report that includes Project No, What review it is plus the word “Comments”, and what document this comment report is for. See below for an example:

*Project ####-#### Semi Final Review Comments 03-Highways*

Make sure all the settings are set as shown below and click OK:

1. Make sure all these settings are selected
2. Click

*Figure 149 - Creating a Comment Report*

*Figure 150 - Comment Report*
7. The comment report will now be created and opened in Bluebeam, leave the comment report open in Bluebeam. We will be copying this report into the comment report memo.

8. Next save the following review comment memo to your computer: Review Comment Memo.

9. Open the memo and fill in the correct information.

10. Then copy all the pages from the comment report as shown below:

   ![Figure 151 - Copying the Comment Report Memo](image)

   (1) Click on the comment report document
   (2) Select the thumbnail view
   (3) Select all pages and then right click on them and select Copy Pages
11. Then paste the pages into the memo as shown below:

![Image showing steps to paste pages into a memo]

Figure 152 - Pasting the Comment Report Pages

12. Save the memo and process this memo as your unit requires.
7.8 Phase 5 – Closing the Digital Review

The Organizer will be responsible for closing the review. The review session will be closed per the date on the review memorandum.

1. Click Finish to close a Bluebeam Review Session as shown below:

![Click Finish](Figure 153 - Terminating a Session)
2. Make sure all the reviewers in the list below are selected (they will be by default) and the *Save (Overwrite Existing)* button is checked and click OK.

![Figure 154 - Terminating a Session](image)

3. Click *OK* in the figure below.

![Figure 155 - Overwriting Existing Documents](image)
4. Close Bluebeam Revu and check in each document to Projectwise. Note: A check in box will pop up for each document in the review session.

![Check In]

Figure 156 - Checking a Document Into Projectwise

5. Notify the Document Authors that the session has been closed so they can resolve the comments on their documents.
7.9 Phase 6 – Resolve Comments

This section shows how the comments from the review session will be resolved by the Document Authors. After the comments have been resolved in the PDF documents located in Projectwise the Document Author shall notify the Organizer that they have finished applying their resolutions to the documents.

Note: Comments cannot be resolved until the review session has been finished. The Review Organizer will notify the Document Authors when the session has been finished. If the document authors go into the documents located in Projectwise before the session is finished there will be no comments on the documents.

7.9.1 Resolving Comments

All comments on the review documents shall be resolved by the Document Author directly on the digital PDF review documents using Bluebeam. The following shows the steps for resolving comments.

1. Open your document(s) from Projectwise.
2. Next select a comment in the comment list and right click. The select Reply.

![Figure 157 - Comment Resolutions](image-url)
3. In the box that pops up, type in a final resolution in the following format:

Note: For plan sheets, include “Change Plans” or “No Change to Plans” where necessary.

Resolution – Type in resolution...No Change to Plans

The resolutions applied to the plans shall be the final resolution decided by the Document Author’s unit. There shall only be one resolution for each comment.

Below is an example of a resolution:

Figure 158 - Typing in a Resolution
Below is an example of how the resolutions will look in the comment list.

![Figure 159 - Resolutions](image)

4. Next attach a PDF document that includes any non-participating entities comments with your responses to the review document. This should be done by adding that PDF document to the end of the review document as shown below:

![Add the document by selecting Document > Pages > Insert Pages](image)

![Figure 160 - Attaching Comments](image)
5. Browse out to the PDF document you want to add and then select to insert after the last page:

![Insert Pages dialog box](image)

Select After and Last Page and then click OK

Figure 161 - Adding Comments

6. When all the resolutions have been applied, make sure to save the documents and check them back into Projectwise.

7. Notify the Review Organizer that you have completed your resolutions.
7.10 Locking the Review Documents after the Review

The Organizer shall change the state of the documents to make them document read-only after the resolutions have been applied to the review documents.

To make the documents read-only, change the state of the documents in Projectwise to “Review Completed” as shown below:

1. Select the document(s) and change the state of the documents to “Review Completed” as shown below:

![Figure 162 - Changing the State to Review](image)

(1) Right click on the documents and select "Change State>Next"

Notice State column, the documents are now in the Review Complete state.

![Figure 163 - Review Complete State](image)
2. Then right click on all the documents again and select Change State > Set Final Status. This will lock the documents.

3. Send out Completion of Review Memo to all the personnel associated with the review session indicating that the review session is over and all comments have been resolved on the documents in Projectwise. Create a comment report of all the comments from each review document and include that in the memo. Link to: Completion of Design Review Memo
A directive was issued to establish protocols and minimum requirements for design-phase scheduling. Link to Directive: 2015-8-E. The Project Management group within the AEC Application’s unit in cooperation with engineers from several engineering divisions, are facilitating the implementation, training, maintenance, and evolution of the Scheduling Directive.

An Engineering working group evaluated several scheduling software options to support the mission statement. Microsoft Project 2010 was selected because it offers the following features and advantages:

- Accommodates any number of milestones and tasks (i.e., easily scalable),
- Graphically displays series and parallel tasks,
- Provides baseline and tracking Gantt charts,
- Displays the critical path,
- Ability to link notes and documents, and
- Interfaces with Outlook, Excel, SharePoint and other Microsoft products.

Microsoft Project 2010 shall be used to develop design phase schedules meeting the following minimum requirements:

1. Includes all the activities identified by the Minimum Requirement Schedule Template; more detailed templates and project-specific schedules are encouraged,
2. Baseline schedule,
3. Task Indicator columns are used to link applicable instructional and reference documents,
4. Explanations for changes in task durations are added as task notes,
5. Tracking View/Gantt chart functions are used,
6. Task-level progress is tracked regularly,
7. Files are stored in the ProjectWise project container as indicated by the Digital Project Development Manual, and
8. Microsoft Project files are maintained and current, with projected schedules in accord with the obligation plan.

Base templates were developed by a committee that included Engineering Management and Subject Matter Experts (SMEs) from each engineering discipline. The Office of Engineering SMEs are as follows:

- Bridge Design – Kevin Blasi and David Gruttadauria
- Consultant Bridge Design – Derick Lessard and Marc Byrnes
- Highway Design – Scott Bushee, Jordan Pike, and Vitalij Staroverov
- Consultant Design State Roads – Nilesh Patel and Meredith Andrews
- Traffic Projects Design – Barry Schilling and Michael Chachakis
- Facilities Design – Eric Feldblum and Jesse Benson

The SMEs are responsible for developing and maintaining division specific project templates and corresponding task libraries in ProjectWise. They shall be the first point of contact regarding discipline specific template and guidance document inquiries and maintenance.

For questions, suggestions and issues pertaining to Microsoft Project and the Scheduling Directive, please contact Bruce Bourgoin (Bruce.Bourgoin@ct.gov) or Nick Langer (Nicholas.Langer@ct.gov).
The table below details the minimum tasks included in the template:

Table 3 - List of Minimum Tasks

<table>
<thead>
<tr>
<th>Task Name</th>
<th>Project XXXX-XXXX</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project Initiation</strong></td>
<td></td>
</tr>
<tr>
<td>• Prepare and Submit PPI</td>
<td></td>
</tr>
<tr>
<td>• Prepare and Approve RPM</td>
<td></td>
</tr>
<tr>
<td>• Secure Funding/Authorization</td>
<td></td>
</tr>
<tr>
<td><strong>Preliminary Design</strong></td>
<td></td>
</tr>
<tr>
<td>• Survey</td>
<td></td>
</tr>
<tr>
<td>• NEPA/CEPA</td>
<td></td>
</tr>
<tr>
<td>• Develop PD through Design Approval</td>
<td></td>
</tr>
<tr>
<td>• Design Approval</td>
<td></td>
</tr>
<tr>
<td><strong>Final Design</strong></td>
<td></td>
</tr>
<tr>
<td>• Prepare Semi-Final Design Submission</td>
<td></td>
</tr>
<tr>
<td>• Prepare Final Design Submission</td>
<td></td>
</tr>
<tr>
<td><strong>ROW Coordination</strong></td>
<td></td>
</tr>
<tr>
<td>• Prepare and Submit Final Accepted Property Maps</td>
<td></td>
</tr>
<tr>
<td>• Acquire Properties</td>
<td></td>
</tr>
<tr>
<td><strong>Permit Acquisition Process</strong></td>
<td></td>
</tr>
<tr>
<td>• Permit A</td>
<td></td>
</tr>
<tr>
<td>o Prepare and Submit Permits to Regulatory Authority</td>
<td></td>
</tr>
<tr>
<td>o Regulatory Authority Review and Issuance of Permit</td>
<td></td>
</tr>
<tr>
<td>• Permit B</td>
<td></td>
</tr>
<tr>
<td>o Prepare and Submit Permits to Regulatory Authority</td>
<td></td>
</tr>
<tr>
<td>o Regulatory Authority Review and Issuance of Permit</td>
<td></td>
</tr>
<tr>
<td>• Permit C</td>
<td></td>
</tr>
<tr>
<td>o Prepare and Submit Permits to Regulatory Authority</td>
<td></td>
</tr>
<tr>
<td>o Regulatory Authority Review and Issuance of Permit</td>
<td></td>
</tr>
<tr>
<td><strong>FDP</strong></td>
<td></td>
</tr>
<tr>
<td><strong>DCD</strong></td>
<td></td>
</tr>
<tr>
<td><strong>ADV</strong></td>
<td></td>
</tr>
</tbody>
</table>

The Minimum Requirement Schedule template is stored in ProjectWise and can be found here: [AEC Scheduling Documents (Minimum Req)](AEC_Scheduling_Documents_Minimum_Req)
8.1 Microsoft Project File Set Up

The following steps show how to set up a Microsoft Project file:

1. Open ProjectWise Explorer by going to Start> All Programs> Bentley> ProjectWise V8i (SELECT series 4), and click on ProjectWise Explorer as shown below:

![Figure 165 – Launching ProjectWise](image)

2. Then double Click on CTDOT and then sign into ProjectWise with your username and password. If this is your first time logging into ProjectWise, you will be asked to create a working directory, click Yes:

![Figure 166 – Logging Into ProjectWise](image)
3. Browse to Documents>04.00 Engineering Libraries>Scheduling Directive. Select the applicable division’s Scheduling Documents folder. The below example presents where the Minimum Requirement Schedule Template is located:

Figure 167 - Schedule Templates

4. Right click on the most applicable template and select Copy

Figure 168 - Copying a MS Project Schedule
5. The next step is dependent upon if a project is in the Project Initiation Phase or has progressed to Preliminary Design Phase. Project Initiation is typically complete when Funding and Authorization is received, and a ProjectWise project container is created. If a ProjectWise container has not been created, contact Julie Annino in AEC Applications.

**Projects in Project Initiation Phase**

a. If the project is in Project Initiation the MS Project schedule should be pasted to the respective discipline specific Initiation Phase Scheduling ProjectWise folder:

![Screen Shot](image1.png)

Figure 169 - Discipline Specific Initiation Phase Scheduling folders

**Projects in Preliminary Phase**

b. If the project is in preliminary design phase the schedule should be saved to the ProjectWise 140_Project Administration folder under the project.

![Screen Shot](image2.png)

Figure 170 - Project 140_Project Administration Folder
6. To paste the project file, right click on the folder and select Paste and then Yes.

7. Then click Advanced Wizard and click OK.
8. Then click next until you get to the attributes screen shown below, then assign the attributes as shown below:

*Discipline = Your discipline*

---

**Figure 171 - Save schedules to the 140 Project Administration Folder**

**Figure 172 - ProjectWise Attributes**
9. Then click next until the file uploads.
10. Next open the project file.
11. Then click on the **File** menu, select **Info**, select the **Project Information** dropdown and then **Advanced Properties** as shown below:

![Figure 173 - Setting Advanced Project Properties](image)

12. In the dialogue box that pops up, fill out the information as shown below:

![Figure 174 - Project Information](image)

1. Some information must be provided after Proj. Initiation, such as Proj. No. & PM Name
13. Next set the project start date by selecting the **File** menu > select **Info**, then select the date as shown below:

![Setting the Start Date](image1.jpg)

**Figure 175 - Setting the Start Date**

### 8.2 Basic MS Project Function

This section presents the following schedule basic terminology and functions:

- Scheduling Terminology
- Task Relationships (Predecessors and Successors)
- Adding, Renaming, Indenting and Deleting a Task
- Adding/Adjusting Durations
- Lead and Lag Times
- Adding Hyperlinks
- Combining Multiple Projects

#### 8.2.1 Scheduling Terminology

The most common scheduling view is the Gantt chart view, which illustrates a project schedule using task names, durations, start and finish dates on the left, and bar charts presenting these dates and durations to the right.

![Basic Terms](image2.jpg)

**Figure 176 - Basic Terms**

- **Task Indicator Column** - Present task Notes and Hyperlinks.
- **Milestone** - A major schedule date, such as an FDP.
8.2.2 Task Relationships (Predecessor and Successors)

**Parent Task** - Shown as a Grey Bar, signifies it is a Parent Task. Its duration is populated by the Child Tasks.

**Critical Path** - Shown in Red, signifies the task relationships that control major milestone dates.

**Non-Critical Task** - Shown in Blue, signifies sub-tasks that do not control major milestone dates.

**Predecessor** is a task which has a start or finish date that affects the start or finish of another task.

**Successor** is a task which has a start or finish date that is affected by another task.

There are different ways of defining task relationships, these are:

- **Finish-to-Start**: This is the default dependency in Microsoft Project in which the successor cannot begin until the predecessor is complete. A Finish-to Start task relation is denoted by FS, or simply, as the predecessor’s Task ID. A Task ID is found on the column to the far left.

  ![Finish to Start relation](Figure177.png)

- **Start-to-Start**: The successor cannot begin until the predecessor begins. The successor task can start at any time after predecessor begins. Start-to-Start relationship is designated by SS.

  ![Finish to Finish relation](Figure178.png)

- **Finish-to-Finish**: the successor cannot be completed until the predecessor is completed. The successor can be completed at any time after the predecessor is completed. Finish-to-Finish task relation is denoted by FF.

  ![Start to Finish relation](Figure179.png)
• **Start-to-Finish**: the successor cannot be completed until the predecessor begins. The successor can be completed at any time after the predecessor has started. The Start-to-Finish task relation is denoted by SF.

![Figure 180 - Start to Finish relation](image)

The schedule should have a Predecessors column where task relationships can be defined. To define a task relation, enter the Task ID and the Task Relationship in the associated task’s Predecessor Cell. For example, in the Figure below the PPI is a predecessor and the RPM is a successor task. The PPI must Finish before the RPM can Start. This relationship is denoted in the RPM Process row’s Predecessors cell, as the number 2. The number 2 represents the Predecessor’s Task ID. The absence of a task relationship abbreviation means that the relation is a Finish-to-Start or FS. A FS is the standard task relationship and therefore the abbreviation is not presented, unless it is accompanied by a Lead or Lag time, as discussed in a later section.

![Figure 181 - Linking tasks](image)

If the **Predecessors** column is not shown in the template, double click in the “**Add New Column**” cell and start typing “predecessor,” and from the short list click on **Predecessors** to add it to the current columns. If Add New Column is not shown right click on any column label and select **Insert Column** and then start typing in Predecessors, as presented below:
8.2.3 Adding, Renaming, Indenting and Deleting a Task

Adding a Task
To add a task, right click on the task which will follow the new task and select **Insert Task**. For example, to add a new task between NEPA/CEPA and Survey, right click NEPA/CEPA and select **Insert Task**, as shown below:
Renaming a Task
Tasks can be renamed by double clicking on the task to be edited. In the pop up window under General tab you can edit the task name. (Do Not Rename the Base Template Tasks in Bold)

![Figure 185 - Renaming a task](image)

Outdenting & Indenting
Outdenting and Indenting provides schedule customization. Outdenting moves a task to the left of the task column and indenting moves a task to the right. Indenting a task makes it a ‘child’ of the preceding, outdented ‘Parent’ task. Parent task durations are populated by their accumulative child task durations, therefore, parent task durations should not be manually entered. To set your task as a child or “sub-task”, select the row you would like to modify and click the Indent Button in the main toolbar area shown:

![Figure 186 - Outdent and indent](image)
Deleting a Task

A user may delete, enter zero, or enter any small duration for a task if it is irrelevant. By entering zero for the duration the MS Project will view the task as a milestone, if a report is generated the report will present all zero duration tasks as milestones. This may confuse report reviewers. A small duration may push back critical milestone dates. It is therefore recommended that project managers manually delete and revise predecessor and successor relations, as described below. To delete a task right click on it and select delete task. **(Do Not Delete the Base Template Tasks in Bold)**

When a schedule is started the user should remove tasks that do not relate and estimate all other pertinent task durations. **It is critical to note if the task being deleted is a predecessor.** You can determine this by following the lines stemming from a task in the Gantt chart. If a task is erroneous and must be deleted, but is also a predecessor for other tasks that should not be deleted, the successor task must be corrected. Failing to update a new predecessor will likely disrupt task connectivity.

For example, if a project does not require a Preliminary Hydraulic Analysis, the step should be deleted. However, the Hydraulics Analysis is a predecessor for the ABC Analysis; therefore the ABC Analysis’ predecessor task should be updated. In this case the Utility Coordination will be the new predecessor. See the task relationship and Gantt chart prior to task deletion:

![Figure 187 - Deleting a task](image)

![Figure 188 – Before task deletion table](image)
See Task relationship and Gantt chart after task deletion:

After the Hydraulic Analysis has been deleted and the new predecessor has been assigned, MS Project automatically reconfigures the schedule to show the new critical path. The critical path is shown in red and highlights the task relationships that determine a project's finish date.
8.2.4 Adding and Adjusting Durations

All tasks require duration estimates that may vary as projects progress. To set a duration click the Duration Cell to the right of the task and enter the task’s estimated period and the applicable unit, as presented below:

- Mons: for months
- Wks: for weeks
- Days: for days
- Hrs: for hours
- Mins: for minutes

If the duration unit is already entered, then the duration value may directly entered, without including the unit. **Do not modify durations for parent tasks.** Parent tasks are signified by having a gray bar in the Gantt chart area and a maximize/minimize arrow. Parent task durations are automatically calculated by their subtask durations.

If a parent duration is manually entered, select the parent task and re-select Auto Schedule. This will recalculate the appropriate parent duration, based on its child tasks. See below:
### 8.2.5 Lead and Lag Times

In defining a task relation, a task may have to be delayed or started early.

- The **Lead** time will tend to push your duration and a **plus** sign is used.
- The **Lag** time will tend to shorten your duration and a **minus** sign is used.

To add a Lead or Lag time: type in the task relation type, then the predecessor task number, a plus or minus, and the amount of delay or early start.

For example, Task 18: DCD, is 6 weeks after task 17: FDP, this can be described as 17FS+6wks

![Figure 194 - Task relation](image)

This can also be set by right clicking on a task and selecting Information. Then go to the **Predecessors** tab as shown below, and enter the predecessor ID or Task Name, the relationship type and then a positive duration for a lead time or a negative duration for a lag time in the Lag column.

![Figure 195 - Task relation in Project Information](image)
8.2.6 Adding Notes and Hyperlinks to a Task

Adding Task Notes

As stated in the Directive: “Explanations for changes in task durations are added as task notes.” Notes are reserved to clearly indicate when a specific Project Task duration is adjusted from the baseline. The note should be placed in the respective task’s indicator column. The note should state:

- The date of the entry,
- The person writing the note,
- Justification for the task duration adjustment and
- **Recommended:** Recipient Notification.

**The Recipient Notification list is left up to the Project Managers discretion.** The purpose is to outline a step where project team members who may be interested or are directly impacted by a duration change, are notified. Once a note is drafted and the duration is adjusted, it is recommended that a notification email be sent to the relevant recipients and that the correspondence is saved to the subject project’s 140_Project Administration folder in ProjectWise. The recipients may typically include:

- AEC’s Project Management Unit – Bruce.Bourgoin@ct.gov or Nicholas.Langer@ct.gov
- Finance, such as the Office of Capitol Planning.
- Design Engineers within the Project Manager’s division.
- The group involved with the duration change or the group affected by the change, if applicable. For example, if the 6 month estimated duration for a project survey needs to be pushed back, the respective survey supervisor who is involved with the task should be included as a recipient in the notification email.

The purpose of the recipient list is to improve communication between units and to harvest project data. Meaning, AEC will collect a repository of duration change notes in order to continuously reevaluate and improve schedule templates.

To add a note right click on a task and select **Notes...** as shown below:

*Figure 196 - Adding Notes*

Then type/insert your notes in the popup window.
The other option to access the notes window is to double click on the task and in the Task Information window and click on the Notes tab.

**Adding Hyperlinks to a Task**

As stated in the Directive: “Task Indicator columns are used to link applicable instructional and reference documents.” For all templates, hyperlinks shall be used to link a task to a division specific Schedule Task Library folder located in the Scheduling Directive PW folder. Contact your SME or AEC Applications for ProjectWise folder and template document management.

For example, a Permit Task should provide a link to a corresponding ProjectWise folder that contains the permit’s regulatory document, suggested points of contact or experts, pre-written memorandums, etc... These documents must be added, actively maintained and updated. Division SME’s and AEC shall be the active maintainers of the division library modifications. When a document is incorrect or has been superseded it is critical that users report this to a unit’s SME or to AEC so documents can be updated and maintained. It is suggested that users go through their SMEs to hyperlink documents, but the procedure is explained below.

To add a Hyperlink, right click on the task that you want to add a link to and select Hyperlink

![Figure 197 - Adding Hyperlink](image)

Then in the following window, insert web address

![Figure 198 - Add link/browse to a file](image)

To remove a link right click on the link (Task)> Hyperlink> Edit hyperlink > Remove link
8.2.7 Combining Multiple Projects

It is critical that project managers can combine project schedules to better manage several schedules from the same file. MS Project provides this ability through the Subproject combine function. As outlined in Section 8, schedules must be stored in the project container: 140_Project Administration folder. However, to use the combine function, MS Project schedules must be exported from the ProjectWise folder to a local server drive, such as the X-Drive. Schedules located in a local network can then be combined using the subproject tool. Exporting is only recommended when a user wants to use the combine tool.

The following steps show how to combine Microsoft Project files:

1. Browse to the ProjectWise Project container’s 140_Project Administration folder. **Right click** the Project Schedule and select **Export**, as shown below:

![Figure 200 - Schedule Export](image)

To access a hyperlink hold the ctrl key and left click the hyperlink icon located in the Indicator column.

8.2.7 Combining Multiple Projects

It is critical that project managers can combine project schedules to better manage several schedules from the same file. MS Project provides this ability through the Subproject combine function. As outlined in Section 8, schedules must be stored in the project container: 140_Project Administration folder. However, to use the combine function, MS Project schedules must be exported from the ProjectWise folder to a local server drive, such as the X-Drive. Schedules located in a local network can then be combined using the subproject tool. Exporting is only recommended when a user wants to use the combine tool.

The following steps show how to combine Microsoft Project files:

1. Browse to the ProjectWise Project container’s 140_Project Administration folder. **Right click** the Project Schedule and select **Export**, as shown below:

![Figure 200 - Schedule Export](image)

To access a hyperlink hold the ctrl key and left click the hyperlink icon located in the Indicator column.
2. Highlight Export and Click Next as shown below:

![Figure 201 - Export Option](image)

3. Browse to the network folder where you will keep the schedule file image. This network file will likely be in the division specific X-Drive>all_data-folder.

**NOTE: DO NOT DELETE THE EXPORTED FILE**

The floppy disk means that the file has been exported so the schedule is now read only. A user can still access the Project file by double clicking it and opening the file as Read Only.

![Figure 202 - Exported File](image)

4. Create a new “Master” MS Project file that will be used as the container for the combined Subprojects. This Master Schedule file can be stored in the local network drive (such as the X-Drive) or on ProjectWise. Browse to the local network schedule (the one stored in the X-Drive) and click Insert as shown below:
The schedule has been inserted into the Master Schedule, where it can be actively updated and maintained. Initially, sub-tasks will be hidden, but they can be shown by clicking the project’s outline symbol.

A user can view the most updated schedule via the ProjectWise file by right clicking the schedule file and selecting **Update Server Copy** as shown below:
5. This step updates the ProjectWise schedule from the local network image file that is maintained by the user’s Master schedule. This allows any person to view the most-up-to-date project schedule directly from ProjectWise.

6. To **import** a project schedule back into ProjectWise the user must right click on the ProjectWise schedule and click **import**. As shown below:

7. If you look back to the local server where the project image file had been saved, you will notice that it is no longer there, this is because the file has been imported back into ProjectWise. Now the file can once again be managed directly from ProjectWise. If a user wishes to maintain their schedule continuously from their master schedule, they should avoid importing the schedule. **Once a file is imported** the user must re-export and re-add the schedule to their master schedule.
8.3 Tracking the Project

8.3.1 Baselining the Project

Each project file must have a baseline set at the start of Preliminary Design. The baseline is essentially a stamp of the schedule at the start of the Preliminary Design phase. The purpose of the baseline is to gage how much a schedule varies from the initial baseline. Projects shall not be re-baselined unless there is a major scope change. Re-baselining requires Engineering Administrator approval.

1. To set the baseline, under the Project tab select set baseline and select Set Baseline from the dropdown as shown below

![Figure 207 - Set Baseline Dropdown](image)

2. In the dialog box that pops up, keep the default values and click OK.

![Figure 208 - Setting a baseline](image)

Re-Baselining

If Re-baselining is needed and is approved by the Engineering Administrator, the baseline will be set in accordance with the following:

1. Go to Projects > Set Baseline > Set Baseline.
2. Then select Set Interim plan, select Baseline from the copy drop down button, then select Baseline 10 for the Into dropdown list.
3. Next, go to Project > Set Baseline > set Baseline.
4. Then in the dialog box that pops up just click OK to save a new Baseline.

5. When a pop up window asks you if you want to overwrite click yes

6. After the project has been re-baselined add a note to the top left Identifier cell located in the Project No. row. The note should include the details outlined in the Adding Notes and Hyperlinks to a Task section. The recipient list should include all parties affected by the base-line adjustment.
After the project has been re-baselined change the view to a Tracking Gantt view.

1. In the left dark grey bar shown below, right click and select Tracking Gantt.

Notice the Gantt shows two bars stacked over each other. The grey bar is the baseline and the one on top is the actual duration. If there is a slip in a task schedule it will be shown as an offset.
2. Next to change the table of tasks to the tracking mode, click on the left upper corner cell to select the entire schedule, then right click and select tracking.

The table of tasks will now be in the tracking mode,

3. Then click save.

8.3.2 Recording Task Progress
The project manager will be required to record the project progress by keeping an up to date record of the % complete for each task in the project. This shall be recorded in 25% increments.

The following shows how to record the progress of a task:
1. Click on a task.
2. Then in the task menu select the appropriate % complete as shown below:
Important Note: When the task is completed, do not select 100% complete. You will need to type in the actual finish date for that task. If 100% complete is selected, Microsoft Project will calculate the actual finish date instead of recording the physical date the task was completed.

In the tracking Gantt, the task will show the percent complete of the task as shown below:

Also when a task is not started and/or finished on time, it will show as a slipping bar as in the following figure.
Figure 218 - Tracking View

Slipped from the baseline
8.4 Generating Reports and Summaries

Microsoft Project provides different forms of reports and visual summaries. MS Project has three reporting options:

1. Standard Reports
2. Custom Reports
3. Visual Reports

**Standard Reports**

Standard Reports are reports predefined by Microsoft on: Overview, Current, Costs, assignments and workload.

Under **Overview** the following is reported:

- Project Summary
- Top-Level Tasks
- Critical Tasks
- Milestones
- Working days

Under **Current** the following is reported:

- Un started Tasks
- Tasks Starting Soon
- Tasks In-Progress
- Completed Tasks
- Should have Started Tasks
- Slipping Tasks

Under **Cost** the following is reported:

- Cash Flow
- Budget
- Overbudget Tasks
- Overbudget Resources
- Earned Value

Under **Assignments** the following is reported:

- Who does what
- Who does what when
- To-do List
- Overallocated Resources

Under **Workload** the following is reported:

- Task usage
- Resource Usage
To access these report options go to **Project > Reports**

![Report options](image1)

**Custom Reports**

A custom report has the ability to customize the report based on templates in the following categories:

- Task
- Resource
- Monthly Calendar
- Crosstab

To access custom report tool, go to **Project > Reports >** and double click on **Custom**

![Custom Reports](image2)
Then the report to be edited is first selected from the list of available custom report. Next, click the **Edit** button. The dialog will show the current report’s setting and all the available report settings.

Other than the **Definitions** tab you may utilize **details** and **sort** tabs for further customization.

**Visual Reports**

Unlike the standard/customized reports which are text based, visual reports present the report graphically. Visual reports are pre-formatted excel pivot-tables and pivot-charts as well as Visio pivot-diagrams.

To access go to **Projects** tab > **Visual Reports**
Section 9  CTDOT Project Location – Under Development

This section details the required information/documents that need to be submitted to CTDOT to locate all of our projects on a GIS (Geographic Information System).

The lead designer shall be responsible for providing the information/documents detailed in the following tables when filling out or updating the Project Asset Form located on the Projectwise Project Information Webpage at the following link:

Projectwise Composite Data

This information/document needs to be submitted or updated at the following project milestones:

- RPM
- Design Approval
- Final Design

The following tables detail what needs to be provided on the Project Asset Form for various project types. If your project type is not listed, contact AEC applications for guidance: Mathew.calkins@ct.gov or John.Rinaldi@ct.gov

<table>
<thead>
<tr>
<th>Project Milestone - RPM</th>
<th>Project Type</th>
<th>Required Information/Documents</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highway</td>
<td>Paving</td>
<td>Routes and Mileage</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td></td>
<td>Guide Rail, Barrier, Safety Improvements</td>
<td>Routes and Mileage</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td></td>
<td>All other highway projects</td>
<td>Google Earth KML</td>
<td></td>
</tr>
<tr>
<td>Bridge</td>
<td>Bridge Preservation projects</td>
<td>Route and Mileage</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td></td>
<td>Bridge Maintenance projects</td>
<td>Route and Mileage</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td></td>
<td>Bridge Replacement or Superstructure Replacement</td>
<td>Google Earth KML</td>
<td>Section 8.1.3</td>
</tr>
<tr>
<td></td>
<td>Retaining Wall Projects</td>
<td>Google Earth KML</td>
<td>Section 8.1.3</td>
</tr>
<tr>
<td></td>
<td>Sign Support Projects</td>
<td>List of sign supports in the project</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Traffic</td>
<td>Traffic Signals</td>
<td>List of traffic signals in the project</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td></td>
<td>Signing</td>
<td>Route and Mileage</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td></td>
<td>Pavement Markings</td>
<td>Route and Mileage</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td></td>
<td>Rumble Strip</td>
<td>Route and Mileage</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Facilities</td>
<td>New Facility or Rehab of Existing Facility</td>
<td>Google Earth KML</td>
<td>Section 8.1.3</td>
</tr>
<tr>
<td></td>
<td>Rail Project</td>
<td>Google Earth KML</td>
<td>Section 8.1.3</td>
</tr>
<tr>
<td>Rails</td>
<td>Rail Project</td>
<td>Google Earth KML</td>
<td>Section 8.1.3</td>
</tr>
<tr>
<td>District Wide Projects</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Project Milestone – Design Approval

<table>
<thead>
<tr>
<th>Project Type</th>
<th>Required Information/Document</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highway</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Guide Rail, Barrier, Safety Improvements</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>All other highway projects</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Bridge</td>
<td>Updated list of bridges in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Bridge Preservation projects</td>
<td>Updated list of bridges in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Bridge Maintenance projects</td>
<td>Updated list of bridges in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Bridge Replacement or Superstructure Replacement</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Retaining Wall Projects</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Sign Support Projects</td>
<td>Updated list of sign supports in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Traffic</td>
<td>Updated list of traffic signals in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Signing</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Pavement Markings</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Rumble Strip</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Facilities</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Rail Project</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Rails</td>
<td>Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>District Wide Projects</td>
<td></td>
<td></td>
</tr>
<tr>
<td>State Wide Projects</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Milestone – Final Design and Construction</td>
<td>Required Information/Document</td>
<td>Instructions</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Highway</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paving</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Guide Rail, Barrier, Safety Improvements</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>All other highway projects</td>
<td>Updated Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td><strong>Bridge</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bridge Preservation projects</td>
<td>Updated list of bridges in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Bridge Maintenance projects</td>
<td>Updated list of bridges in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Bridge Replacement or Superstructure Replacement</td>
<td>Updated Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Retaining Wall Projects</td>
<td>Updated Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Sign Support Projects</td>
<td>Updated list of sign supports in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td><strong>Traffic</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Traffic Signals</td>
<td>Updated list of traffic signals in the project if necessary</td>
<td>Section 8.1.2</td>
</tr>
<tr>
<td>Signing</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Pavement Markings</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td>Rumble Strip</td>
<td>Updated Routes and Mileage if necessary</td>
<td>Section 8.1.1</td>
</tr>
<tr>
<td><strong>Facilities</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Facility or Rehab of Existing Facility</td>
<td>Updated Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td>Rail Project</td>
<td>Updated Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
<tr>
<td><strong>Rails</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rail Project</td>
<td>Updated Microstation Project Polygon File</td>
<td>Section 8.2.1</td>
</tr>
</tbody>
</table>

| District Wide Projects                          |                              |             |
| State Wide Projects                             |                              |             |
9.1 Project Location - RPM

9.1.1 Route and Mileage

The lead designer shall provide all routes and mileages for project in accordance with the following:

1. Go to the Projectwise Project Information Webpage: Projectwise Composite Data
2. Click on the Project Asset Form.

![ProjectWise Composite Data: Main Menu](image)

**Figure 223 - Project Asset Form**

3. Select the project from the drop down or if it is a new project click “Add Project”.

![Project Asset Form](image)

**Figure 224 - Selecting Project**

4. To get the route and mileage for a project you will need to go to the ALIM system found here: ALIM System
5. Next add the route and mileages to the Project Asset Form.
9.1.2 List of Assets for the Project

1. Go to the Projectwise Project Information Webpage: Projectwise Composite Data
2. Click on the Project Asset Form.

![ProjectWise Composite Data: Main Menu](image)

**Figure 225 - Project Asset Form**

3. Select the project from the drop down or if it is a new project click “Add Project”.

![Project Asset Form](image)

**Figure 226 - Selecting Project**

4. On the form add all of the assets in this project.
9.1.3 Project Polygon Creation and Submission

The following shows how to create and submit a project polygon KML file for project location. The project polygon is created in Google Earth and attached to the Project Asset Form located on the Projectwise Project Information webpage.

1. Open Google Earth.
2. Zoom into the location of the project or use the search tool to locate the area of the project.
3. Next select the polygon tool to place a polygon around your project.

   ![Figure 228 - Searching in Google Earth](image)

   ![Figure 229 - Polygon Tool](image)

4. Next Type the project number in the name field and a description in the description field as shown below:
5. Next adjust the style and color of the polygon to the settings shown below, do not click OK after you update the settings:

**Figure 231 - Polygon Style**

- **Set Color to orange and width to 3.0 and area to Outlined**

**Figure 230 - Polygon Settings**

- **Type in Project # and Project Description**

- DO NOT click OK until after the polygon(s) are drawn
6. Next draw the polygon for the project. This polygon should encompasses the whole project and include all the roads that this project will affect. Then click OK.

![Figure 232 - Drawing the Polygon](image)

If you are dissatisfied with the polygon, you can delete it by right clicking on the polygon located in the places area, which is in the left hand side of the screen, of Google Earth. Then redraw the polygon by going back to step 3.

![Figure 233 - Deleting a Polygon](image)
7. If the project has multiple sites, go back to step 3 and create another polygon(s). After you create all your polygons they will be listed in the places area in Google Earth.

8. After all the sites are made they need to be added to the temporary places area in Google Earth so a combined KML file can be saved. To add them to the temporary places simply drag and drop all the sites into that area as shown below:

Figure 234 - All Sites for Project
9. Next to save a KML file with all the polygons in it right click on Temporary Places and select Save Place As:
10. Next type in the project number for the file name and select KML for the file format. Then select the folder on your computer where you want to save the file too and click Save.

![Image](image_url)

**Figure 237 - Saving the KML File**

11. Go to the Projectwise Project Information Webpage: Projectwise Project Information

12. Click on the Project Asset Form.

![Image](image_url)

**Figure 238 - Project Asset Form**

13. Select the project from the drop down or if it is a new project click “Add Project”.

Issued 04-2016 202 Version 3.13
Figure 239 - Selecting Project

Select Project or if it is a new project click Add Project
14. Next attach the KML file to the Project Asset Form by clicking on Browse and then select the file:

![Figure 240 - Attaching the KML File](image-url)
15. After you have selected the file click on attach file:

![Diagram of project asset management system with a highlighted 'Attach File' button]

**Figure 241 - Attaching the KML File**
9.2 Project Location - Design Approval through Construction

The following shows how to create and upload a refined project polygon file at and after the Design Approval milestone of a project. The file shall be created by the lead designer in accordance with this section and uploaded into the 140_GIS folder of the applicable project in ProjectWise. For projects that were previously located using the assets or route and mileage this section does not apply. If changes are made to projects found using assets or route and mileage update that project information in accordance with Section 8.1.

9.2.1 Project Polygon

The lead designer is responsible for creating the project polygon dgn and kml files using Microstation. The following section details what needs to be included in the polygon and how to make the project polygon file for different project types.

If your project type is not detailed below, contact AEC Applications. Mathew.calkins@ct.gov or John.Rinaldi@ct.gov for guidance.

If a project has more than one site, all the polygons for that project must be included in one project polygon file. All the polygons for each intersection shall be in one file.

**Highway Projects that Touch Pavement**

The Project Polygon file shall encompass the entire project extents per site and include all slope lines, drainage rights of way, temporary work areas, portions of local affected roads, all affected assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or temporary work area extends beyond that. Below is an example of what to include:

![Figure 242 – Project Extents](image)
The image below is an example of what a typical project polygon will look like after it is drawn in Microstation.

**Figure 243 – Project Polygon example**

**Highway Projects that DO NOT Touch Pavement**
This type of project could involve, but not limited to the following:
- Guard rail replacement
- Barrier replacement
- Noise barriers
- Retaining walls

The Project Polygon file shall encompass the entire project extents per site and include all slope lines, temporary work areas, portions of local affected roads, all affected assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or temporary work area extends beyond that. If there is only a ROW line on one side of the project, draw the polygon relatively close to the edge of the work area. Below is an example of a noise barrier project and shows what to include:

**Figure 244 - Highway Project without Full Depth Reconstruction**
Full Bridge Replacement or Superstructure Replacement that Touch the Roadway
The Project Polygon file shall encompass the entire project extents per site and include all slope lines, drainage rights of way, temporary work areas, portions of local affected roads, all affected assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or temporary work area extends beyond that. Below is an example of what to include:

Figure 245 - Bridge Polygon Example

Full Bridge or Culvert Replacement or Rehabilitation that Do Not Touch the Roadway
**Facilities Project**

The Project Polygon file shall be drawn on the ROW line or limits of construction for the parcel the facility is located on. Any slope limits or work being done outside of this ROW line shall be included in the polygon. Below is an example of what to include:

![Figure 246 - Facilities Project E](image)

**Limits of Construction**

example
9.2.2 Project Polygon File(s) Creation

The following steps explain how to create and submit the Project Polygon file. One polygon file shall be created for each project. If the project consists of multiple “sites,” the file shall include multiple polygons.

1. Note the datum and units (e.g. NAD 83 Survey Feet) of the Highway Design file to be referenced. This can usually be found within the ground survey file title block. If there is no survey for the project use the 2D Poly 83 FT seed file shown in the next step.

2. **In House CTDOT Users:** Create a new MicroStation design file using the 2D_Poly_83FT seed file located in the W: Drive. See folder address below:

   W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\

   Note: If your project is NAD 27 FT still use the 83FT seed.

![Figure 247 – CTDOT CAD resource folders](image)

**Consultant Users:** Download the seed files using this link: [2D_Poly_83FT Seed File](link)

3. Reference the Highway Design file into the newly created file using true scale off and 1:1
Verify that the tentative coordinates of this file match the referenced design (using stationing, grids, etc.). If your project is in NAD 83FT the coordinates should match, if they do not check that the scale of the reference is 1:1. If your project is NAD 27 FT we will move the reference file so the coordinates are correct. To move the reference file do the following:

a. Select Reference File.

b. Select Move Reference:

c. Next when it prompts you to “Enter point to move from”, in the Key-In Box key in $XY=0,0$ and click Enter.
d. Then when it prompts you to “Move Reference>Enter Point to move to”, in the Key-In Box key in DL=400124.9,500038.9.

Key-In
DL=400124.9,500038.9
Then Hit Enter

Figure 251 - Move to Key In
Connecticut Department of Transportation – Digital Project Development Manual

Now the tentative coordinates of this file should match the referenced design (using stationing, grids, etc.).

5. Set the MicroStation active level to “TOOL_Prelim_Proj_Polygon” for the Project Polygon (Note: if this level is not yet available, use “SV_PARCEL_DATA”)
6. Then place a closed polygon(s) using the shape tool or the smart line tool.
7. After the polygon has been placed, turn off all reference displays and fit the polygon to the view.
8. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml file to Google Earth.
   Do this by choosing: File> Export> Google Earth.
9. Google Earth should then automatically open and zoom to the Project Polygon(s) vicinity.

9.2.3 Project Polygon File(s) Submission
The Project Polygon files shall then be uploaded into ProjectWise in accordance with the following:
1. Log into ProjectWise
2. Browse to your project’s 140_GIS folder in ProjectWise Explorer
3. Select the Interface, “CTDOT_Doc_Code.” If the interface box is not shown, select: View>Toolbars and select interface
4. Drag and drop the file into the 140_GIS folder using the Advanced Wizard

![Figure 252 – ProjectWise project polygon folder example](image)

5. Continue to click Next in the Advance Wizard until you get to the Attributes screen and assign the attributes shown in Table 5 of Appendix E
6. Click Next until the file uploads.
7. When upload is complete, the Lead Designer shall send an email to the following people including links to the documents in Projectwise. To do this, click on the document and then highlight and copy the address located in the Address Bar. Then paste it in the email:
   - John.Rinaldi@ct.gov (AEC)
   - Mathew.calkins@ct.gov (AEC)
   - Henok.Abdissa@ct.gov (AEC)

To submit a revision for the Project Polygon files, use the same steps above but add “Revised” to the label attribute.
Section 10 Rights of Way (ROW) Files

This section details the submission of the following Rights of Way (ROW) Files:

- Property Maps Files (.dgn and PDF)
- Parcel Polygon Files (.dgn and KML)

These files shall be submitted at the Project Milestone – Design Approval and updated as necessary as the project moves through design and construction.

10.1 Submission of the Property Maps Files

The .dgn and PDF files for a Property Map shall be uploaded to CTDOT’s Projectwise site in accordance with the following:

1. Log into Projectwise.
2. Browse out to your project and upload the Property Map DGN and PDF into the 05_Property_Maps folder and 310_Review folder respectively as shown below:

3. Select the Interface, “CTDOT_Doc_Code.” If the interface box is not shown, select: View>Toolbars and select interface.
4. Using the Advanced Wizard, drag and drop the following files into the 140_GIS Folder
5. For each file, continue to click Next in the Advance Wizard until you get to the Attributes screen and assign the attributes shown in Table 5 of Appendix E
6. Click Next until the file uploads.
7. When the files are uploaded, the creator of the Property Map shall send an email to the following people including links to the documents in Projectwise. To do this, click on the document and then highlight and copy the address located in the Address Bar. Then paste it in the email:

- ROW Supervising Coordinator - Robert.Ike@ct.gov
- ROW Excess Property Inventory/GIS Unit (EPIU) - John.Durling@ct.gov, Shandi.Wong@ct.gov
- Bureau Records Center (BRC) - Bryan.Deprey@ct.gov, Janet.West@ct.gov
- Appropriate Project Coordinator - Steven.Degen@ct.gov, Michael.Marzi@ct.gov, Douglas.Hummel@ct.gov, Derrick.Ireland@ct.gov

To submit a revision to the property maps, use the same steps above but add “Revised” to the label attribute.
10.2 Parcel Polygon File(s)

The Parcel Polygon files shall be created by the creator of the property map and represents the area to be acquired by the State. It should be accurately based on existing property lines and proposed Rights of Way lines. These files shall be submitted at the Project Milestone – Design Approval and updated as necessary as the project moves through design and construction.

10.2.1 Parcel Polygon File(s) Creation

The following steps explain how to create and submit the Parcel Polygon CAD file(s). One file shall be created for each parcel - only permanent land and easement acquisition areas.

When submitting a Parcel Polygon file(s), a PDF of the Property Map and the CAD file of the Property Map shall also be submitted into ProjectWise in accordance with this manual, see section 9.

1. Figure out which datum and units (e.g. NAD 83 Survey Feet) the existing Property Map is in. This is usually found within the referenced ground survey file title block
2. **IN House CTDOT Staff** – Then create a new MicroStation design file using the correct seed for the datum in the project located in the W: Drive. See folder address below: W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial

![Figure 254 – Property Map parcel area example](image)

![Figure 255 - Seed File](image)
Consultant Staff: Download the seed files using this link: Geospatial Seeds

3. Reference the Property Map file into the newly created file using true scale off and 1:1

![Image](connecticutdepartmentoftransportation-digitalprojectdevelopmentmanual.png)

Figure 256 - Reference File

4. Verify that the tentative coordinates of the new file match the Property Map (using stationing, grids, etc.)

5. Set the MicroStation active level to “SV_PARCEL_DATA” for Parcel Polygon(s).

6. Then place a closed polygon using the shape tool or the smart line tool.

7. CTDOT has a customized a MicroStation task, “CT Property Maps,” to aid in the creation of property maps. The task contains “Shape for GIS” tools which can be used for polygon creation:

![Image](connecticutdepartmentoftransportation-digitalprojectdevelopmentmanual.png)

Figure 257 – Custom MicroStation tasks

8. After the polygon has been placed, turn off all reference displays and fit the polygon to the view.

9. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml file to Google Earth by choosing: File> Export> Google Earth.

10. Google Earth should then automatically open and zoom to the Project Polygon vicinity.
10.2.2 Parcel Polygon File Submission

The Parcel Polygon file(s) shall be uploaded into ProjectWise in accordance with the following. [Note that if the parcel geometry remains unchanged with subsequent Property Map revisions, it is not necessary to recreate and resubmit the Parcel Polygon and KML once initially submitted]

1. Log into ProjectWise
2. Using ProjectWise Explorer, browse to the 140_GIS folder of your project.

3. Select the Interface, “CTDOT_Doc_Code.” If the interface box is not shown, select: View>Toolbars and select interface.
4. Using the Advanced Wizard, drag and drop the following files into the 140_GIS Folder
5. For each file, continue to click Next in the Advance Wizard until you get to the Attributes screen and assign the attributes shown in Table 5 of Appendix E
6. Click Next until the file uploads.
9. When the files are uploaded, the creator of the Property Map shall send an email to the following people including links to the documents in ProjectWise. To do this, click on the document and then highlight and copy the address located in the Address Bar. Then paste it in the email:

- ROW Excess Property Inventory/GIS Unit (EPIU) - John.Durling@ct.gov, Shandi.Wong@ct.gov

To submit a revision for the Parcel Polygon files, use the same steps above but add “Revised” to the label attribute.
Appendix A - Initial Bluebeam Settings

Initial Log into Bluebeam

These steps only need to be completed the first time using Bluebeam or when the user logs into a new computer.

1. Open Bluebeam by selecting the desktop icon:

If you do not have a desktop icon, select Start>Bluebeam Software. Right click on Bluebeam Revu, select Send To>Desktop (create shortcut). This will place the Bluebeam icon on your desktop:

Figure 259 - Creating Desktop Shortcut
2. Then Open Bluebeam by double clicking on the shortcut.

3. Click on the settings icon in the top right hand corner and click Preferences as shown below. If you cannot find the settings icon in the top right, go to the Edit menu and select Preferences.

Figure 260 - Bluebeam Preferences

4. Click on File Access and make sure the box is checked as shown below: If ProjectWise is not listed click on Add.

Figure 261 - Projectwise Integration
5. Then click Load and enter in your Projectwise Username and password.

Figure 262 - Integrating Projectwise

After you click Log in the status should read **Logged In** as shown below:

Figure 263 - Projectwise Integration
6. In the General section in the User area type in your name (First Initial and Last Name), title, and your office name. An example for me would be M. Calkins TE 2 AEC Applications. An example for a district construction user would be J. Smith TE 3 D2 Construction.

![Figure 264 - General Preferences](image)

(1) Click

(2) Type in User Name

(3) Make sure these are unchecked

7. Update the markups options to match the following:

![Figure 265 - Markup Preferences](image)

Make sure these options are selected
8. Update the markups tab options to match the following:

![Figure 266 - Markup Preferences](image)

9. Click on the Signature tab and set the algorithm to SHA-1.

![Figure 267 - Signature Setting](image)
10. Click on the Web Tab section and make sure the box for Open PDF hyperlinks in Web Tabs is unchecked. This will open any hyperlink that is in a PDF document using Internet Explorer instead of Bluebeam. This is the last preference you will need to update so you can click Ok at the bottom right now.

Figure 268 - Webtab Preferences
Downloading the CTDOT Bluebeam Profile

1. Download this file and save it to your desktop: CTDOT Bluebeam Profile
2. Double click on the profile in the zipped folder on your desktop.

Figure 269 - Importing the Bluebeam Tools
Appendix B - Usability of PDF Documents

Usability of PDF Documents
This section contains information about viewing digital contract documents.

Structure of Digital Plans

**Final Design Plans, Addendums, and Design Initiated Change Orders**

The contract plans are split up into discipline subsets, which are multiple sheet PDF documents digitally signed by the Designer. Addendums and Change Orders are also submitted as discipline subset, with only the changed sheets. For example, an Addendum that affects the 03-Bridge Subset will require the submission of a 03-Bridge_A1 subset.

Digital Plans are located in the 100_Contract_Plans folder in Projectwise. Below is an example of a project’s discipline subsets in Projectwise:

![Figure 270 - Discipline Subsets in Projectwise](image)

**As-Built’s**
As-built’s will be placed directly on the PDF Subsets using Bluebeam.

**Functionality of PDF Digital Plans**
The PDF digital plans have the following functions when the digital contract plans are created in accordance with this manual:
- Turn levels on and off
- Search for all text on the documents.
- PDF plans are measurable
Digital Plan Levels

The plans have the ability to have their levels turned off and on. This can allow for easier viewing of the contract sheets. See below for turning levels on and off:

Figure 271 - Turning Levels On and Off
Searching Digital Plans

The plans can be searched for any text located on them. This can be useful if searching for a certain pay item.

See below for searching the PDF Plans for text.

Figure 272 - Searching for Text in PDF Plans
Measuring on the Digital Plans

The plans have the ability to be measured in PDF. This is helpful because a paper set does not need to be created for on desk measuring.

See below for measuring in PDF.

Figure 273 - Measuring Tool
Digital Specification

The FDP specification package will be one PDF document and located in the 110_Contract_Specifications folder. This package includes all specifications, Notice to Contractors, Wage information, etc.

The Addendum specifications prepared in the same way as the FDP specification package and will also be located in the 110_Contract Specifications folder.

The Design Initiated Change Order specifications will be contained in one PDF document located in the 110_Contract Specifications folder when they are released to the Contractor.

Some useful features on the digital specification package are:
- Search for any text in the document, see Searching Digital Plans
- Bookmarks for each section in the specification package

TABLE OF CONTENTS

Note: This Table of Contents contract with the sole herein; and no claims of Contents shall not be
Document Compare Tools

Bluebeam has the two tools for comparing documents: (1) Compare Documents and (2) Overlay Pages. Compare Documents will compare two documents and create a third document that clouds all the changes. Overlay pages will create a third document where the pages of document A will become one color and the pages of document B will become another color. When the pages are overlaid you will be able to see the changes from the difference in these two colors. Both of these tools can be used for single and multipage PDF documents. The following shows how to perform a document compare and how to use the overlay page tool.

**Document Compare**

1. Open the Revised document first and then open the original document that you want to compare from Projectwise or your computer.

2. Next go to Document>Comparison>Compare Documents as shown below:

3. In the window that pops up you will notice the two documents that were just opened. Click OK to run the document compare as shown below:

![Figure 275 - Compare Documents](image-url)
Overlay Pages

1. Open the Revised document first and then open the original document that you want to compare from Projectwise or your computer.

2. Next go to Document>Comparison>Overlay pages as shown below:

3. In the window that pops up you will need to select which pages of each document you want to overlay. To do this double click on a file, then in the window that pops up type the pages you want to overlay. The example below shows pages 1-28. Once you select the pages you want to overlay click OK.
To set which pages to overlay double click on a file.

Type in which pages to overlay then click OK.

Figure 278 - Overlay Pages

Figure 279 - Overlay Pages
Appendix C - Using the Set File

Opening the Set File
Double click on the set file from Projectwise and open as shown below: This may take a while please be patient. Note: The first time opening a set file will take longer than any subsequent times.

Viewing the Plans Sheets within a Set File
All the plans sheets will be combined and shown on the left hand side of the screen in a thumbnail view. To view a sheet, simply click on that sheet and it will open up.
Marking Up a Set File

1. Open up the set file by following Section 1.4.1. You will notice on the left hand side of the screen will be thumbnails of all the sheets in the set file.

Figure 282 - Sheets in the Set File
2. To mark up a sheet scroll down to the sheet that needs to be marked up and click on it. You will notice that sheet opens up on the right:

Figure 283 - Marking Up a Sheet
3. Next to markup the document we must unlock it (Check Out of Projectwise). To do this, right click on the lock and select Check Out.

4. Notice the lock changes to a Check and you will be able to markup the document.
5. To mark up the plans use the tools located in the tool chest shown below:

Figure 286 - Marking up the Plan Sheets
6. When finished, click Save and then right click on the Check and select “Check In”.

Click on save after you have finished marking up the plans

Then right click on the check and select Check In

Figure 287 - Saving Markups and Checking Into Projectwise
Searching a Set File

The Set feature in Bluebeam allows you to search across the entire set file. The following shows how to search a set file:

1. Click on the Search Set file icon and then type in what you want to search for as shown below:

![Figure 288 - Searching the Set File](image)

Click on the search set file icon
Type in what you want to search for
Select "Current Set"
Creating a Consolidated PDF of the Files in the Set File

Bluebeam allows you to create a consolidated pdf of all the files in a set file. The following shows how to create a consolidated pdf:

1. Select the Publish Icon and select Combine:

![Figure 289 - Consolidating Files](image)

   Publish Icon then select Combine

2. Next keep the default settings and click OK on the dialog box shown below:

![Figure 290 - Consolidating Files](image)

   Keep default settings and click OK
3. Bluebeam will then create a consolidated file of all the PDF in the set file.
Printing the Entire Set File

Bluebeam allows you to print the entire Set file, only the latest revisions, or previous revisions. Printing the entire set will print all the sheets in the set file. Printing the latest revisions will print the most up to date sheets and not print the previous revisions. Printing the previous revisions will only print the sheets that were changed by a revision.

The following shows how print a set file:

1. Select the print set file icon and select the desired option:

   ![Figure 292 - Printing a Set File]

   *Select the arrow on the print icon and select the desired option*
Consultant Designers can import the Bluebeam User Profile using the following link. This profile imports all the commenting tools in the correct format. Download the profile from this link: CTDOT Bluebeam User Profile. Just double click on the file located in the zip file and the profile will be imported.

After the profile is imported the following must be done.

1. Delete the Submittal Review stamp that is in the tool chest as shown below:

   ![Figure 293 - Deleting the Stamp](image)

   In the tool chest select the Submittal stamp and click the delete icon

2. Next Consultant Designers will need to save the following stamp to their computer and edit it to add their company name and address. The following will show how to do that:

3. Save this stamp file to your computer in a folder somewhere called Bluebeam Stamps. Note: The stamp file will be a PDF. Form 816 - Consultant Submittal Review Stamp or January 2015 Supplemental Form 816 Stamp – Consultant Submittal Review Stamp Supplementals

4. Open the stamp file using Bluebeam.
5. Update the Company Name and Address as shown below:

![Figure 294 - Updating Stamp for Company Name and Address](image)

After the company name and address is updated it should look like this:

![Figure 295 - Updated Stamp](image)

6. After the stamp is updated click save.
7. Next go to Markup>Stamp> and Select Change Stamp Folder.

8. Browse out to where the submittal review stamp has been saved and click OK:

9. Now when you click on Markup>Stamp it will be in the list.
10. Next go into the tool chest and open the “Recent tools” as shown below:

![Figure 298 - Bluebeam Recent Tools](image)

11. Now place the stamp on any PDF document by selecting it in Markup>Stamp as shown below:

![Figure 299 - Placing a Stamp in Bluebeam](image)
12. Select Conforms when the javascript window pops up and click OK:

![Submittal Review](image)

**Figure 300 - Bluebeam Stamp**

13. After the stamp has been placed you will see the stamp in the recent tools. Drag it from the recent tools into the CTDOT Shop/Working Drawing Review Tools as shown below:

![Adding the Custom Stamp to the Tool Chest](image)

In the tool chest drag the recently placed stamp and drop it into this tool bar

**Figure 301 - Adding the Custom Stamp to the Tool Chest**
14. Then Save Profile so the stamp will always be in the Tool Chest.

Go to View, then click on the arrow and then save profile

Figure 302 - Saving Bluebeam Profile
### Appendix E – Projectwise Attributes Table

#### Table 4 - Projectwise Attribute Assignments – Contract Plans and Contract Specifications

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Description</th>
<th>Asset Tags</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contract Plans – Upload to the 100_Contract_Plans Folder</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document</td>
<td>Discipline</td>
<td>Main Category</td>
</tr>
<tr>
<td>Contract Plans</td>
<td>CT</td>
<td>CON</td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
</tr>
<tr>
<td><strong>Set File</strong></td>
<td>CT</td>
<td>CON</td>
</tr>
<tr>
<td><strong>Contract Specifications – Upload to the 240_Contract_Development Folder except for CSP specs, upload these to the 110_Contract_Specifications folder</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document</td>
<td>Discipline</td>
<td>Main Category</td>
</tr>
<tr>
<td>Contract Specifications</td>
<td>CT</td>
<td>CON</td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
</tr>
<tr>
<td></td>
<td>CT</td>
<td>CON</td>
</tr>
</tbody>
</table>
### Table 5 - Projectwise Attribute Assignments - Supplemental Contract Documents

<table>
<thead>
<tr>
<th>Document</th>
<th>Discipline</th>
<th>Main Category</th>
<th>Sub Category</th>
<th>Label</th>
<th>Description</th>
<th>Asset Tags</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Supplemental Contract Documents</strong> – 240_Contract Development Folder</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proposal Estimate</td>
<td>CT</td>
<td>CALCS</td>
<td>Estimates</td>
<td>Proposal</td>
<td>Proposal Est. Checklist</td>
<td></td>
</tr>
<tr>
<td>Proposal Estimate Checklist</td>
<td>CT</td>
<td>MISC</td>
<td>Final</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Federal Estimate</td>
<td>CT</td>
<td>CALCS</td>
<td>Estimates</td>
<td>Federal</td>
<td>Federal Estimate</td>
<td></td>
</tr>
<tr>
<td>Calendar Day Estimate</td>
<td>CT</td>
<td>CALCS</td>
<td>Estimates</td>
<td>Calendar Day</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Final Design Report</td>
<td>CT</td>
<td>REPORT</td>
<td>Final</td>
<td>Final Design</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Categorical Exclusion</td>
<td>CT</td>
<td>MISC</td>
<td>Final</td>
<td>Categorical Exclusion</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design Approval Letter</td>
<td>CT</td>
<td>APPROVAL</td>
<td>Final</td>
<td>Design Approval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Environmental Permits</td>
<td>CT</td>
<td>PERMIT</td>
<td>Permits</td>
<td></td>
<td>Inland Wetland, SHPO, Flood Management, Environment Review, Natural-Water Resources, Tribal, Endangered Species, Fisheries</td>
<td>N/A</td>
</tr>
<tr>
<td>DBE/SBE Approval with percentages</td>
<td>CT</td>
<td>APPROVAL</td>
<td>Final</td>
<td>DBE/SBE Approval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Commitment List</td>
<td>CT</td>
<td>MISC</td>
<td>Final</td>
<td>Commitment List</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agreements</td>
<td>CT</td>
<td>AGREEMENT</td>
<td>Final</td>
<td>Name of the Agreement</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proprietary Item Approval</td>
<td>CT</td>
<td>APPROVAL</td>
<td>Final</td>
<td>Proprietary Item</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standalone Transportation Management Plan Document, taken from the final design report</td>
<td>CT</td>
<td>MISC</td>
<td>Final</td>
<td>Trans. Man. Plan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item List for Contractor Submittals</td>
<td>CT</td>
<td>MISC</td>
<td>Final</td>
<td>CNS Item List</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 6 - Projectwise Attribute Assignments – Engineering Reports, GIS Documents, and ROW Documents

<table>
<thead>
<tr>
<th>Document</th>
<th>Discipline</th>
<th>Main Category</th>
<th>Sub Category</th>
<th>Label</th>
<th>Document Date</th>
<th>Description</th>
<th>Asset Tags</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Engineering Reports</strong> – Upload to 130_Engineering Reports Folder</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hydraulic Report</td>
<td>CT</td>
<td>REPORT</td>
<td>Final</td>
<td>Hydraulic</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hydraulic Report Data</td>
<td>CT</td>
<td>REPORT</td>
<td>Final</td>
<td>Hydraulic Data</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scour Report</td>
<td>CT</td>
<td>REPORT</td>
<td>Final</td>
<td>Scour</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scour Report Data</td>
<td>CT</td>
<td>REPORT</td>
<td>Final</td>
<td>Scour Data</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Floodway Report</td>
<td>CT</td>
<td>REPORT</td>
<td>Final</td>
<td>Floodway</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Floodway Report Data</td>
<td>CT</td>
<td>REPORT</td>
<td>Final</td>
<td>Floodway Data</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Final Drainage Report</td>
<td>CT</td>
<td>REPORT</td>
<td>Final</td>
<td>Final Drainage</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Final Drainage Report Data</td>
<td>CT</td>
<td>REPORT</td>
<td>Final</td>
<td>Final Drainage Data</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Geotechnical Report</td>
<td>CT</td>
<td>REPORT</td>
<td>Final</td>
<td>Geotechnical</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task 110</td>
<td>CT</td>
<td>REPORT</td>
<td>Final</td>
<td>Task 110</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task 220</td>
<td>CT</td>
<td>REPORT</td>
<td>Final</td>
<td>Task 220</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Underground Storage Tank System Closure Reports</td>
<td>CT</td>
<td>REPORT</td>
<td>Final</td>
<td>Underground Storage Tank System Closure Reports</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rehabilitation Reports</td>
<td>CT</td>
<td>REPORT</td>
<td>Final</td>
<td>RSR</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load Rating</td>
<td>CT</td>
<td>REPORT</td>
<td>Final</td>
<td>Load Rating</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>GIS Documents</strong> – Upload to the 150_GIS folder</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Polygon File (.dgn)</td>
<td>CT</td>
<td>CAD</td>
<td>Misc</td>
<td>Boundary</td>
<td></td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>Project Polygon File (.KMZ)</td>
<td>CT</td>
<td>CAD</td>
<td>Misc</td>
<td>Boundary</td>
<td></td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>ROW Parcel Microstation File (.dgn)</td>
<td>CT</td>
<td>CAD</td>
<td>Misc</td>
<td>Parcel Serial (Town#) i.e. Parcel 004 (157)</td>
<td></td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>ROW Parcel Microstation File (.KMZ)</td>
<td>CT</td>
<td>CAD</td>
<td>Misc</td>
<td>Parcel Serial (Town#) i.e. Parcel 004 (157)</td>
<td></td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td><strong>ROW Documents</strong> – Property Map (.dgn) to 500_Pre-Design&gt;05_Property_Maps Folder, Property Map (.pdf) to the 310_Review_Documents folder</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Property Map (.dgn)</td>
<td>CT</td>
<td>CAD</td>
<td>MAP</td>
<td>Parcel Serial (Town#) i.e. Parcel 004 (157)</td>
<td></td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>Property Map (.pdf)</td>
<td>CT</td>
<td>CAD</td>
<td>MAP</td>
<td>Parcel Serial (Town#) i.e. Parcel 004 (157)</td>
<td></td>
<td></td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Table 7 - Projectwise Attribute Assignments – Contractor Submittals

<table>
<thead>
<tr>
<th>Document</th>
<th>Discipline</th>
<th>Main Category</th>
<th>Sub Category</th>
<th>Label</th>
<th>Document Date</th>
<th>Description</th>
<th>Asset Tags</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contractor Submittals</strong> – 120_Contractor_Submittals</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Working Drawings for Permanent Structures</td>
<td>CTR</td>
<td>CONTRACTOR</td>
<td>Working Drawings</td>
<td>###-Item Number-##</td>
<td></td>
<td></td>
<td>Assign Applicable asset tags</td>
</tr>
<tr>
<td>Working Drawings for Temporary Structures</td>
<td>CTR</td>
<td>CONTRACTOR</td>
<td>Working Drawings</td>
<td>###-Item Number-##</td>
<td></td>
<td></td>
<td>Assign Applicable asset tags</td>
</tr>
<tr>
<td>Shop Drawings</td>
<td>CTR</td>
<td>CONTRACTOR</td>
<td>Shop Drawings</td>
<td>###-Item Number-##</td>
<td></td>
<td></td>
<td>Assign Applicable asset tags</td>
</tr>
<tr>
<td>Product Data</td>
<td>CTR</td>
<td>CONTRACTOR</td>
<td>Product Data</td>
<td>###-Item Number-##</td>
<td></td>
<td></td>
<td>Assign Applicable asset tags</td>
</tr>
<tr>
<td>Submittals</td>
<td>CTR</td>
<td>CONTRACTOR</td>
<td>Submittals</td>
<td>###-Item Number-##</td>
<td></td>
<td></td>
<td>Assign Applicable asset tags</td>
</tr>
<tr>
<td>RFI</td>
<td>CTR</td>
<td>CONTRACTOR</td>
<td>RFI</td>
<td>RFI - #</td>
<td></td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>RFC</td>
<td>CTR</td>
<td>CONTRACTOR</td>
<td>RFC</td>
<td>RFC - #</td>
<td></td>
<td></td>
<td>N/A</td>
</tr>
</tbody>
</table>
Table 8 - Projectwise Attribute Assignments – Discipline General Attributes

The following table shows attributes that are available for each discipline. The table shows SB for Structure Bridge, but the attributes are available to all the disciplines.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Document</th>
<th>Discipline</th>
<th>Main Category</th>
<th>Sub Category</th>
<th>Label</th>
<th>Description</th>
<th>Asset Tags</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Documents – 140 Project Administration Folder for Final Versions of Documents and 330 Design Data Folders for Draft Versions of Documents</strong></td>
<td>Assignments</td>
<td>SB</td>
<td>AGREEMENTS</td>
<td>Draft or Final</td>
<td>Agreement No. or Name</td>
<td>Date</td>
<td>Assign Applicable asset tags</td>
</tr>
<tr>
<td>Analysis</td>
<td>SB</td>
<td>ANALYSIS</td>
<td>Draft or Final</td>
<td>Title of Analysis</td>
<td></td>
<td></td>
<td>Assign Applicable asset tags</td>
</tr>
<tr>
<td>Approvals</td>
<td>SB</td>
<td>APPROVAL</td>
<td>Draft or Final</td>
<td>Title of Approval</td>
<td></td>
<td></td>
<td>Assign Applicable asset tags</td>
</tr>
<tr>
<td>Design Models</td>
<td>SB</td>
<td>CAD</td>
<td>Design</td>
<td>Title of Design, i.e. Master Design</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Sheet Models</td>
<td>SB</td>
<td>CAD</td>
<td>Sheet</td>
<td>Drawing No. i.e. PLN-1 or S-1</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Misc. DGN Files</td>
<td>SB</td>
<td>CAD</td>
<td>Misc</td>
<td>Title of file</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Resource Files</td>
<td>SB</td>
<td>CAD</td>
<td>Resource</td>
<td>Title of file</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Maps</td>
<td>SB</td>
<td>CAD</td>
<td>MAP</td>
<td>Title of Map</td>
<td>Date</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Draft Dgn Files</td>
<td>SB</td>
<td>CAD</td>
<td>DRAFT</td>
<td>Title of file</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Asset related Microstation file</td>
<td>SB</td>
<td>CAD</td>
<td>ASSET</td>
<td>Title of file</td>
<td>N/A</td>
<td>Assign Applicable asset tags</td>
<td></td>
</tr>
<tr>
<td>Estimate Calculations</td>
<td>SB</td>
<td>CALCS</td>
<td>Estimates</td>
<td>Title of Estimate Calc</td>
<td>Date</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Quantity Calculations</td>
<td>SB</td>
<td>CALCS</td>
<td>Quantity</td>
<td>Title of Quantity Calc.</td>
<td>Date</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Design Calculations</td>
<td>SB</td>
<td>CALCS</td>
<td>Design</td>
<td>Title of Design Calc.</td>
<td>Date</td>
<td>Assign Applicable asset tags</td>
<td></td>
</tr>
<tr>
<td>Invoices</td>
<td>SB</td>
<td>INVOICE</td>
<td>Invoices</td>
<td>Title of Invoice</td>
<td>Date of Invoice</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Letters</td>
<td>SB</td>
<td>LETTERS</td>
<td>Draft or Final</td>
<td>Title of Letter</td>
<td>Date of Letter</td>
<td>Assign Applicable asset tags</td>
<td></td>
</tr>
<tr>
<td>Photos</td>
<td>SB</td>
<td>MEDIA</td>
<td>Photos</td>
<td>Date or Title of Photos</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Videos</td>
<td>SB</td>
<td>MEDIA</td>
<td>Videos</td>
<td>Date or Title of Videos</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Presentations</td>
<td>SB</td>
<td>MEDIA</td>
<td>Presentations</td>
<td>Title of presentation</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Meeting Related Documents</td>
<td>SB</td>
<td>MEETING</td>
<td>Draft or Final</td>
<td>Title of Meeting document</td>
<td>Date of Meeting</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Memos</td>
<td>SB</td>
<td>MEMO</td>
<td>Draft or Final</td>
<td>Title of Memo</td>
<td>Date of Memo</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Miscellaneous Documents</td>
<td>SB</td>
<td>MISC</td>
<td>Draft or Final</td>
<td>Title of Document</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Permit Related Documents</td>
<td>SB</td>
<td>PERMIT</td>
<td>Permits</td>
<td>Title of Permit Document</td>
<td>Date</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Reports</td>
<td>SB</td>
<td>REPORT</td>
<td>Draft or Final</td>
<td>Title of Report</td>
<td>Date of Report</td>
<td>Assign Applicable asset tags</td>
<td></td>
</tr>
<tr>
<td>Requests</td>
<td>SB</td>
<td>REQUEST</td>
<td>Draft or Final</td>
<td>Title of Request</td>
<td>Date of Request</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Schedules</td>
<td>SB</td>
<td>SCHEDULES</td>
<td>Draft or Final</td>
<td>Title of Schedule</td>
<td>Date</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Scopes</td>
<td>SB</td>
<td>SCOPE</td>
<td>Draft or Final</td>
<td>Title of Scope</td>
<td>Date of Scope</td>
<td>Assign Applicable asset tags</td>
<td></td>
</tr>
<tr>
<td>Specs</td>
<td>SB</td>
<td>SPECS</td>
<td>Draft or Final</td>
<td></td>
<td></td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Ground Files</td>
<td>SB</td>
<td>SURVEY</td>
<td>Ground</td>
<td>Ground File</td>
<td>Date</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>GPS Documents</td>
<td>SB</td>
<td>SURVEY</td>
<td>GPS</td>
<td>Title of Document</td>
<td>Date</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>DEM Documents</td>
<td>SB</td>
<td>SURVEY</td>
<td>DEM</td>
<td>Title of Document</td>
<td>Date</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Survey Control Documents</td>
<td>SB</td>
<td>SURVEY</td>
<td>Control</td>
<td>Title of Document</td>
<td>Date</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>